**Legal notices**

The information contained herein is subject to change without notice.

The only warranties for HP Products and services are set forth in the express warranty statement accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

**Trademarks**

Adobe®, Acrobat®, Adobe Photoshop® and Adobe® PostScript® 3™ are trademarks of Adobe Systems Incorporated.

ENERGY STAR and the ENERGY STAR mark are registered U.S. trademarks.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

PANTONE® is Pantone, Inc.’s check-standard trademark for color.

Hi-Speed USB certified

IPv6-ready
# Table of contents

1 Introduction ...................................................................................................................... 1
   Safety precautions ............................................................................................................. 2
   Product models .................................................................................................................. 2
   HP Start-up Kit .................................................................................................................. 2
   Using this guide ............................................................................................................... 3
   Main features .................................................................................................................... 5
   Main components .............................................................................................................. 6
   The front panel .................................................................................................................. 9
   Printer software ................................................................................................................. 10
   Web Services ..................................................................................................................... 11
   Turn the product on and off .............................................................................................. 12
   Internal prints .................................................................................................................... 13

2 Installing the software .................................................................................................... 15
   Choose which connection method to use ........................................................................... 16
   Connect the product to your network ............................................................................... 16
   Connect a computer to the product by network (Windows) .............................................. 18
   Connect a computer to the product by USB cable (Windows) ......................................... 18
   Uninstall the printer software (Windows) ........................................................................ 20
   Connect a computer to the product by network (Mac OS) ............................................... 20
   Connect a computer to the product by USB cable (Mac OS) ........................................... 24
   Uninstall the printer software (Mac OS) .......................................................................... 25

3 Setting up the product .................................................................................................... 27
   Introduction ....................................................................................................................... 28
   Set up your Web-connected product ................................................................................ 28
   Web Services manual configuration .............................................................................. 29
   Create a scan-to-network folder ..................................................................................... 30
   Paper suitability options ............................................................................................... 37
   Turn nesting on and off .................................................................................................. 38
   Turn alerts on and off ..................................................................................................... 39
   Control access to the product ........................................................................................ 39
   Require account ID .......................................................................................................... 40
   Set Windows driver preferences .................................................................................... 41
# Personalizing the product

- Change the language of the front-panel display
- Access the HP Utility
- Access the Embedded Web Server
- Change the language of the HP Utility
- Change the language of the Embedded Web Server
- Change the sleep mode setting
- Turn the buzzer on and off
- Change the front-panel display brightness
- Change the units of measurement
- Configure network settings
- Change the printer’s graphic language setting
- Manage ePrinter security
- Change your printer’s email address

# Printer paper handling

- General advice
- Load a roll onto the spindle
- Load a roll into the printer
- Unload a roll
- Load a single sheet
- Unload a single sheet
- View information about the paper
- Paper presets
- Printing paper info
- Move the paper
- Maintain paper
- Change the drying time
- Turn the automatic cutter on and off
- Feed and cut the paper

# Working with two rolls

- The uses of a multiroll printer
- How the printer allocates jobs to paper rolls

# Printing

- Introduction
- Print from a USB flash drive
- Print from a computer using the Embedded Web Server or HP Utility
- Print from a computer using a printer driver
- Advanced print settings
Check usage statistics for a job .............................................................................................. 142
Request accounting data by email .......................................................................................... 142

15 Handling ink cartridges and printheads ........................................................................ 144
   About the ink cartridges ........................................................................................................ 145
   Check the ink cartridges status ............................................................................................... 145
   Remove an ink cartridge ....................................................................................................... 145
   Insert an ink cartridge ........................................................................................................... 147
   About the printheads .......................................................................................................... .. 148
   Check the printhead status .................................................................................................... 148
   Remove a printhead ............................................................................................................ . 148
   Insert a printhead ................................................................................................................. 152

16 Maintaining the product ............................................................................................. 155
   Check product status .......................................................................................................... .. 156
   Clean the exterior of the product ............................................................................................ 156
   Maintain the ink cartridges ................................................................................................... . 156
   Clean the scanner’s glass plate .............................................................................................. 156
   Replace the scanner’s glass plate ........................................................................................... 158
   Calibrate the scanner ......................................................................................................... .. 160
   Move or store the product ..................................................................................................... 161
   Update the firmware ........................................................................................................... .. 162
   Update the software ........................................................................................................... .. 163
   Product maintenance kits ...................................................................................................... . 164
   Secure Disk Erase ............................................................................................................. ... 164

17 Accessories ................................................................................................................. 165
   How to order supplies and accessories ................................................................................... 166
   Introduction to the accessories ............................................................................................... 171

18 Troubleshooting printer paper issues .......................................................................... 172
   The paper cannot be loaded successfully ............................................................................. 173
   The paper type is not in the driver ......................................................................................... 175
   The printer printed on the wrong paper type ............................................................................ 176
   An “on hold for paper” message ............................................................................................ 176
   Paper jam in the printer .......................................................................................................... 178
   A strip stays on the output tray and generates jams ................................................................. 181
   The printer displays out of paper when paper is available ......................................................... 181
   Prints do not fall neatly into the basket .................................................................................. 181
   The sheet stays in the printer when the print has been completed .............................................. 182
   The paper is cut when the print has been completed .............................................................. 182
   The cutter does not cut well ................................................................................................... 182
   The roll is loose on the spindle ............................................................................................... 182
Recalibrate the paper advance ................................................................. 182

19 Troubleshooting ink cartridge and printhead issues ................................. 185
   Cannot insert an ink cartridge ................................................................. 186
   Ink cartridge status messages ................................................................. 186
   Cannot insert a printhead ................................................................. 185
   The front-panel display recommends reseating or replacing a printhead ....................................................................... 186
   Clean the printheads ................................................................. 187
   Clean the printhead drop detector ......................................................... 187
   Align the printheads ................................................................. 190
   Printhead status messages ................................................................. 192

20 Troubleshooting other printer issues .......................................................... 193
   The printer does not print ................................................................. 193
   The printer seems slow ................................................................. 194
   Unavailable driver features when printing from QuarkXpress .......... 194

21 Troubleshooting scanner issues ................................................................. 195
   Cannot access the network folder ......................................................... 195
   Scanning to file is slow ................................................................. 195
   Paper jam in the scanner ................................................................. 196

22 Troubleshooting print-quality and scan-quality issues ............................ 197

23 Troubleshooting general product issues ..................................................... 198
   The product will not start ................................................................. 199
   Communication failures between computer and product .......... 199
   Cannot access the HP Utility ................................................................. 200
   Cannot access the Embedded Web Server .............................................. 200
   Cannot connect to the Internet ................................................................. 200
   Web Services issues ................................................................. 201
   Automatic file system check ................................................................. 201
   Alerts ................................................................. 202

24 Front-panel error messages ................................................................. 203
   The system error log ................................................................. 205

25 HP Customer Care ........................................................................... 206
   Introduction ................................................................. 207
   HP Professional Services ................................................................. 207
   HP Instant Support ................................................................. 208
   HP Proactive Support ................................................................. 208
   Customer Self Repair ................................................................. 209
Contact HP Support .............................................................................................................. 209

26 Product specifications ........................................................................................................ 211
  Functional specifications ........................................................................................................ 212
  Physical specifications .......................................................................................................... 213
  Memory specifications .......................................................................................................... 213
  Power specifications ............................................................................................................. 214
  Ecological specifications ...................................................................................................... 214
  Environmental specifications .................................................................................................. 214
  Acoustic specifications .......................................................................................................... 214

Glossary ............................................................................................................................... 215

Index .................................................................................................................................... 218
1 Introduction

- Safety precautions
- Product models
- HP Start-up Kit
- Using this guide
- Main features
- Main components
- The front panel
- Printer software
- Web Services
- Turn the product on and off
- Internal prints
Safety precautions

The following precautions ensure the proper use of the product and prevent the product from being damaged. Follow these precautions at all times.

- Use the power supply voltage specified on the label. Avoid overloading the product’s electrical outlet with multiple devices.
- Ensure the product is well-grounded. Failure to ground the product may result in electrical shock, fire and susceptibility to electromagnetic interference.
- Do not disassemble or repair the product yourself. Contact your local HP Service Representative for service, see Contact HP Support on page 209.
- Use only the electrical cord supplied by HP with the product. Do not damage, cut or repair the power cord. A damaged power cord has risk of fire and electric shock. Replace a damaged power cord with an HP-approved power cord.
- Do not allow metal or liquids (except those used in HP Cleaning Kits) to touch the internal parts of the product. Doing so may cause fire, electric shock or other serious hazards.
- Turn off the product and unplug the power cable from the power outlet in any of the following cases:
  - When placing your hands inside the product
  - If there is smoke or an unusual smell coming from the product
  - If the product is making an unusual noise not heard during normal operation
  - A piece of metal or a liquid (not part of cleaning and maintenance routines) touches internal parts of the product
  - During a thunderstorm
  - During a power failure

Product models

This guide covers the following product models, normally referring to them by their short names for brevity.

<table>
<thead>
<tr>
<th>Full name</th>
<th>Short name</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Designjet T2300 eMFP</td>
<td>T2300</td>
<td>CN727A</td>
</tr>
<tr>
<td>HP Designjet T2300 PostScript® eMFP</td>
<td>T2300 PS</td>
<td>CN728A &amp; CN728B</td>
</tr>
</tbody>
</table>

HP Start-up Kit

The HP Start-up Kit is the DVD that comes with your product; it contains the product’s software and documentation.
Using this guide

This guide can be downloaded from the HP Knowledge Center (see Knowledge Center on page 207).

Introduction

This chapter provides a brief introduction to the product and its documentation for new users.

Use and maintenance

These chapters help you carry out normal product procedures and include the following topics.

- Installing the software on page 15
- Setting up the product on page 27
- Personalizing the product on page 42
- Printer paper handling on page 48
- Working with two rolls on page 61
- Printing on page 63
- Scanning on page 80
- Copying on page 83
- Web-connected printing and scanning on page 85
- Job queue management on page 96
- Color management on page 104
- Practical printing examples on page 117
- Retrieving usage information on page 140
- Handling ink cartridges and printheads on page 144
- Maintaining the product on page 155

Troubleshooting

These chapters help you solve problems that may occur while printing and include the following topics.

- Troubleshooting printer paper issues on page 172
- Troubleshooting ink cartridge and printhead issues on page 185
- Troubleshooting other printer issues on page 193
- Troubleshooting scanner issues on page 195
- Troubleshooting print-quality and scan-quality issues on page 197
- Troubleshooting general product issues on page 198
- Front-panel error messages on page 203
Accessories, support and specifications

These chapters, Accessories on page 165, HP Customer Care on page 206 and Product specifications on page 211, contain reference information, including customer care, the product specifications and part numbers for paper types, ink supplies and accessories.

Glossary

The Glossary on page 215 contains definitions of printing and HP terms used in this documentation.

Index

In addition to the table of contents, there is an alphabetical index to help you to find topics quickly.

Warnings and Cautions

The following symbols are used in this manual to ensure the proper use of the product and to prevent the product from being damaged. Follow the instructions marked with these symbols.

⚠️ WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury or death.

⚠️ CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or damage to the product.
Main features

Your product is a color inkjet printer designed for printing high-quality images on paper up to 1118 mm (44 in) wide, with an integrated color scanner capable of scanning images up to 914 mm (36 in) wide and 2378 mm (93.62 in) long. Some major features of the product are shown below:

- Print resolution of up to 2400 × 1200 optimized dpi, from a 1200 × 1200 dpi input, using the Best print-quality option, the Maximum Detail option and photo paper
- Scan resolution of up to 600 dpi, in RGB color with 24 bits per pixel, or grayscale with 8 bits per pixel, or black and white with 1 bit per pixel
- The product can be controlled from its front panel or from a remote computer using the Embedded Web Server or the HP Utility
- Touch-sensitive front panel in color, with an intuitive graphical user interface
- Job previews in the front panel and on remote computers
- Includes Web-connected features such as automatic firmware upgrades, HP Designjet ePrint & Share, and HP ePrint
- Driverless printing: files in common graphical formats can be printed directly without needing a printer driver
- Walk-up printing: insert a USB flash drive or connect a laptop computer containing your files
- Walk-up scanning: scan to a USB flash drive, a network folder, or an email address
- Paper flexibility and automatic easy load, see Printer paper handling on page 48
- The printer handles cut-sheet and roll paper; the scanner handles cut-sheet paper
- Six-ink system
- Accurate and consistent color reproduction with automatic color calibration
- Color emulations, see Printer emulation on page 108
- Economode for printing economically
- Two rolls loaded at once provide fast and easy switching between different rolls, or long runs of unattended printing
- Job management, see Job queue management on page 96
- High productivity features such as job previewing and nesting
- Ink and paper usage information available
- Printer and scanner calibration if required
- Access to the online HP Knowledge Center (see Knowledge Center on page 207)
Main components

The following front and rear views of the product illustrate the main components.

Front view

1. Blue lever
2. Ink cartridge
3. Scanner
4. Printhead
5. Printhead carriage
6. Front panel
7. Paper alignment lines
8. Front scanner deflectors
9. Output tray
10. Basket
11. Ink cartridge slots
1. Scanner
2. Roll cover
3. Communication ports
4. Power switch
5. Power socket
6. Foot extension
7. Spindle
8. Spindle stop
9. Paper roll
10. Quick Reference Guide holder
Communication ports

1. Hi-Speed USB device port, to connect a computer
2. Gigabit Ethernet port, to connect to a network
3. Diagnostic LEDs, to be used by service engineers
4. Hi-Speed USB host port, intended for connecting an accessory

There is another Hi-Speed USB host port on the other side of the printer, beside the front panel, intended for connecting a USB flash drive.
The front panel

The front panel is located on the front right of the product. It gives you complete control of your product: from the front panel, you can copy, scan or print, view information about the product, change product settings, perform calibrations and tests, and so on. The front panel also displays alerts (warning and error messages) when needed.

1. A Hi-Speed USB host port, intended for connecting a USB flash drive. This can provide files to be printed, or receive scanned files from the scanner. When a USB flash drive is inserted, a USB icon is displayed on the front panel’s home screen.

2. The front panel itself: a touch-sensitive screen with a graphical user interface.

3. The Power key, with which you can turn the product on or off. The key is illuminated when the product is on. It flashes when the product is in transition between on and off.

The front panel has a large central area to display dynamic information and icons. On the left and right sides you can see up to five fixed icons at different times. Normally they are not all displayed at the same time.

Left and right fixed icons

- Press to return to the home screen.
- Press to go to the previous item.
- Press to go to the next item.
• Press to go back to the previous screen. This does not discard any changes made in the current screen.

• Press to cancel the current process.

**Home screen dynamic icons**

The following items are displayed only on the home screen.

• Press to view information about product status, change product settings, or initiate actions such as loading paper or replacing ink supplies. A smaller warning icon appears if there are actions that need to be performed.

• To the right of the above button is a message showing the product status or the most important current alert. Press this message to see a list of all current alerts.

• Press to eject the paper from the scanner. If there is no paper in the scanner, this button is not displayed.

• Press to print a file. See Printing on page 63.

• Press to scan a sheet of paper and store the image in a file, either in a network folder or in a USB flash drive. See Scanning on page 80.

• Press to copy a sheet of paper (scan and print). See Copying on page 83.

• Press to view information about the USB flash drive(s). This icon appears only when one or more USB flash drives are inserted.

• Press to view and manage the print and scan job queues. A smaller warning icon appears if there are jobs on hold. See Job queue management on page 96.

• Press to access available applications. See http://www.hp.com/go/designjetprinters.

If the product is left idle for some time, it goes into sleep mode and switches off the front-panel display. To change the time that elapses before sleep mode, press, then Setup > Front panel options > Sleep mode wait time. You can choose various times between 30 and 240 seconds.

The product wakes from sleep mode and switches on the front-panel display whenever there is some external interaction with it.

Information about specific uses of the front panel can be found throughout this guide.

**Printer software**

The following software is provided with your product:

• The HP-GL/2 and HP RTL driver for Windows

• The PCL3GUI raster driver for Mac OS (T2300)

• The PostScript drivers for Windows and Mac OS (T2300 PS)
• **HP Designjet Preview**

• The Embedded Web Server and (alternatively) the HP Utility allow you to:
  ◦ Manage the product from a remote computer
  ◦ View the status of the ink cartridges, the printheads and the paper
  ◦ Access the HP Knowledge Center, see Knowledge Center on page 207
  ◦ Update the product’s firmware, see Update the firmware on page 162
  ◦ Perform calibrations and troubleshooting
  ◦ Manage the job queue, see Job queue management on page 96
  ◦ View job accounting information, see Retrieving usage information on page 140
  ◦ Change various product settings

See **Access the Embedded Web Server** on page 43 and **Access the HP Utility** on page 43.

| NOTE: | New versions of all software can be expected to appear from time to time. In some cases, when you receive your product there may already be later versions available on HP’s website of some of the software provided with it. |

## Web Services

Your product can be connected to the Internet and the Web, providing various benefits:

• Automatic firmware updates (see **Update the firmware** on page 162)

• Print on HP ePrinters from almost anywhere

• Print on HP ePrinters from almost any device, including smartphones and tablet computers

• Scan directly to an email address

To take advantage of these benefits, your product must be connected to the Internet.

For the latest information, see [http://www.hp.com/go/designjeteprinters](http://www.hp.com/go/designjeteprinters).

## HP Designjet ePrint & Share

With HP Designjet ePrint & Share you can print from a conference room, job site, or even home. This free Web service makes it easy to access and print large-format documents using your tablet, smartphone, laptop, or product’s touchscreen.

### Print from virtually anywhere

Use your tablet, smartphone, laptop, or product’s touchscreen to print where and when you need.

- Plot to print seamlessly from AutoCAD® WS.
- Send files to print by email to your HP Designjet ePrinter.

### Scan to anywhere

Use your product’s touchscreen to scan directly to any email address.
Save your files online in the cloud

Every time you print or scan using HP Designjet ePrint & Share, a copy of your file is saved in your HP Designjet ePrint & Share account, so finding files for reprints becomes a breeze.

- Access files saved to the cloud using your online print history.
- Keep your projects safeguarded with trusted HP security features.

Collaborate with ease

Whether your files are stored in your HP Designjet ePrint & Share account or an FTP site, HP Designjet ePrint & Share makes it easy to view, share, and print files.

- Share files using an automatically generated hyperlink.
- Access all your FTP sites in one place.

Turn the product on and off

**TIP:** The product can be left powered on with minimal use of electricity. Leaving it on improves response time and overall system reliability. When the product has not been used for a certain period of time (the default time is determined by Energy Star), it saves electricity by going into sleep mode. However, any interaction with the front panel, or starting a new job, returns it to active mode, and it can resume working immediately. To change the sleep mode time, see [Change the sleep mode setting on page 44](#).

**NOTE:** In sleep mode, the printer performs maintenance service to the printheads from time to time. This avoids long preparation times after long idle periods. Therefore, it is strongly recommended to leave the product powered on or in sleep mode to avoid wasting ink and time.

The product has three levels of power consumption.

- Plugged in: the power cord is plugged into the back of the product
- Switched on: the switch at the back of the product is in the on position
- Powered on: the **Power** key on the front panel is illuminated

If you wish to turn the product on or off or reset the product, the normal and recommended method is to use the **Power** key on the front panel.

However, if you plan to store the product indefinitely or the **Power** key does not seem to work, you are recommended to power it off using the **Power** key, and then also switch off the power switch at the rear.
To turn it back on, use the power switch at the rear.

When the product is powered back on, it takes about three minutes to initialize and check and prepare the printheads. Preparing the printheads takes about one minute and 15 seconds. However, if the product has been off for six weeks or more, preparing the printheads could take up to 45 minutes.

**Internal prints**

The internal prints give various kinds of information about your product. They can be requested from the front panel.

Before requesting any internal print, check that the printer and the paper are ready for printing.

- The loaded paper should be at least A3 landscape—420 mm (16.53in) wide—otherwise the print may be clipped.
- The front panel should be displaying the **Ready** message.

To print any internal print, press 🖒, then 🖒, then scroll down to **Internal prints** and press it, then select the internal print you want. The following internal prints are available.

- **Demo prints**
  - Print drawing demo
  - Print rendering demo
  - Print GIS map

- **User information prints**
  - Print configuration (all the current product settings)
  - Print usage report: statistics on the usage of the printer and the scanner (the accuracy of these estimates is not guaranteed)
  - Print PS font list: prints a list of the available PostScript fonts (T2300 PS only)
  - Print scanner image quality plot

- **Service information prints** (mainly used by service engineers)
  - Print usage information
  - Print event logs
- Print calibrations status
- Print connectivity config. (may be useful for network administrators)
- Print all pages
2 Installing the software

- Choose which connection method to use
- Connect the product to your network
- Connect a computer to the product by network (Windows)
- Connect a computer to the product by USB cable (Windows)
- Uninstall the printer software (Windows)
- Connect a computer to the product by network (Mac OS)
- Connect a computer to the product by USB cable (Mac OS)
- Uninstall the printer software (Mac OS)
Choose which connection method to use

The following methods can be used to connect your product.

<table>
<thead>
<tr>
<th>Connection type</th>
<th>Speed</th>
<th>Cable length</th>
<th>Other factors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gigabit Ethernet</td>
<td>Very fast; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches)</td>
</tr>
<tr>
<td>Jetdirect print server (optional accessory)</td>
<td>Moderate; varies according to network traffic</td>
<td>Long: 100 m (328 ft)</td>
<td>Requires extra equipment (switches) Provides additional features See <a href="http://www.hp.com/go/jetdirect">http://www.hp.com/go/jetdirect</a> for more details</td>
</tr>
<tr>
<td>Hi-Speed USB</td>
<td>Very fast</td>
<td>Short: 5 m (16 ft)</td>
<td>A certified Hi-Speed USB cable is necessary for reliable communication.</td>
</tr>
</tbody>
</table>

**NOTE:** The speed of any network connection depends on all components used in the network, which can include network interface cards, routers, switches and cables. If any one of these components cannot operate at high speed, you will have a low-speed connection. The speed of your network connection can also be affected by the total amount of traffic from other devices on the network.

Connect the product to your network

The product is able to configure itself automatically for most networks, in a similar way to any computer in the same network. The first time you connect it to a network, this process may take a few minutes.

Once the product has a working network configuration, you can check its network address from the front panel: press , then .

Network configuration

For more details about the current network configuration, go to the front panel and press , then , then Setup > Connectivity > Gigabit Ethernet > Modify configuration; or, for Jetdirect, Setup > Connectivity > Jetdirect EIO > Modify configuration. From here it is possible, though not normally necessary, to change the settings manually; this can also be done remotely using the Embedded Web Server or the HP Utility.

**TIP:** You may find it helpful to print out the full product network configuration on paper. This can be done from the front panel: press , then , then Internal prints > Service information prints > Print connectivity config. If you do not print out the full network configuration, consider making a note of the product’s IP address and network name.

If you accidentally misconfigure the product’s network settings, you can restore the network settings to their factory values from the front panel: press , then , then Setup > Connectivity > Gigabit Ethernet > Restore factory settings; or, for Jetdirect, Setup > Connectivity > Jetdirect EIO > Restore factory settings. Then you must restart the product. This automatically provides a working network configuration for most networks. The product’s other settings remain unchanged.
**Using IPv6**

Your product supports almost all network connectivity features using IPv6, just as it does using IPv4. To make full use of IPv6, you may need to connect your product to an IPv6 network in which there are IPv6 routers and servers.

In most IPv6 networks, the product will configure itself automatically as follows, and no user configuration is necessary:

1. The product assigns itself a link-local IPv6 address (which starts with “fe80::”).
2. The product assigns itself stateless IPv6 addresses as indicated to it by any IPv6 routers on the network.
3. If no stateless IPv6 addresses can be assigned, the product will try to obtain IPv6 addresses using DHCPv6. It will also do so if the routers instruct it to do so.

The stateless and DHCPv6 IPv6 addresses can be used to access the product, and in most IPv6 networks this will be appropriate.

The link-local IPv6 address works only in the local subnet. Although it is possible to access the product using this address, it is not recommended.

It is possible to assign a manual IPv6 address to the product, using the front panel or the Embedded Web Server. It is also possible to disable IPv6 completely in the product. However, it is not possible to disable IPv4 in the product, and therefore it is not possible to configure the product as IPv6-only.

**NOTE:** In typical IPv6 use, your product will have multiple IPv6 addresses, although it has only one IPv4 address.

**TIP:** You will generally find it easier to use IPv4 unless you have a specific need to use IPv6.

Microsoft Windows Vista, Microsoft Windows Server 2008, and the new HP Printing and Imaging devices will have IPv6 enabled by default. For further information on IPv6, see [http://h20000.www2.hp.com/bc/docs/support/SupportManual/c00840100/c00840100.pdf](http://h20000.www2.hp.com/bc/docs/support/SupportManual/c00840100/c00840100.pdf). This document discusses how name resolution plays a fundamental role in Dual-Stack transition methods. Using the name resolution algorithm in Windows Vista, the document goes through various network environments and studies how the introduction of routable IPv6 addresses will affect network applications. It also discusses DHCPv6, SLAAC and the impact to DNS, and makes some recommendations.

**Using IPSec**

Your product supports IPSec.

However, successful IPSec configuration requires advanced network expertise, and is beyond the scope of this document. For IPSec to work, the product’s IPSec configuration must exactly match that of the other devices in your network. Any discrepancy will prevent communication with your product until the configuration is corrected or IPSec is disabled. For more information on IPsec configuration, download the file [IPsec_Admin_Guide.pdf](http://www.hp.com/go/T2300/manuals) from [http://www.hp.com/go/T2300/manuals](http://www.hp.com/go/T2300/manuals).
Connect a computer to the product by network (Windows)

Before you begin, check your equipment:

- The product should be set up and on.
- The Ethernet switch or router should be on and functioning correctly.
- All computers on the network should be on and connected to the network.
- The product should be connected to the network (see Connect the product to your network on page 16).

Now you can proceed to install the printer software and connect to your product:

1. Make a note of the product’s IP address from the front panel (see Access the Embedded Web Server on page 43).
2. Insert the HP Start-up Kit DVD into your computer. If the DVD does not start automatically, run the setup.exe program in the root folder of the DVD.
3. Press the Software Installation button.
4. Press the Express Network Install button, and choose your product from the list of networked printers that appears, identifying it by its IP address if necessary. The printer drivers and other HP software, such as the HP Utility, HP Designjet Preview, and connections to HP Designjet ePrint & Share are installed.

HP Designjet ePrint & Share allows you to create a copy of your document any time you print, securely in the cloud, in your private online print history. This means that you can reprint your documents from anywhere. To use HP Designjet ePrint & Share, you must create a password-protected account to protect your documents.

If your computer fails to find any printers on the network, the Printer Not Found window is displayed, which helps you to try to find your product. If you have a firewall in operation; you may have to disable it temporarily in order to find the product. You also have the options of searching for the product by its hostname, IP address or MAC address.

In some cases, when the product is not in the same sub-net as the computer, specifying the product’s IP address may be the only successful option.

Connect a computer to the product by USB cable (Windows)

You can connect your product directly to a computer without going through a network, by using the product’s built-in Hi-Speed USB device port.

TIP: A USB connection may be faster than a network connection, but the cable is limited in length and it is more difficult to share the product.

NOTE: The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor’s Forum (http://www.usb.org/) should be used with this product.
The following instructions apply if you intend to print from software applications using a printer driver. If you intend to print only with the Embedded Web Server, you do not need to install the printer software on your computer; see Printing on page 63.

1. **Do not connect the computer to the product yet.** You must first install the printer software on the computer, as follows.

2. Insert the HP Start-up Kit DVD into your DVD drive. If the DVD does not start automatically, run the `setup.exe` program in the root folder of the DVD.

3. Press the **Software Installation** button.

4. Press the **Custom Install** button.

5. In some cases, you may see a message warning you that the installer would need to communicate through the firewall in order to search the network for printers. As you have no need to do this, you can check the box **Continue installation without searching the network**.

6. If you see a list of networked printers, select **Help me find my printer (including network, USB or parallel connected printers)**.

7. Select **USB Cable**.

   **NOTE:** You can connect your product and complete the installation later if you prefer. To do so, check the box marked **I want to connect my printer after completing the setup wizard**.

8. When prompted to do so, connect your computer to the product with a certified USB cable. Ensure that the product is turned on.

9. The printer drivers and the HP Utility are installed.

   **TIP:** If you would like to share the product with other people connected to your network, press the **Printer Properties** button in the Ready to Install window, set **Printer Name** to the name under which the product will be shared, then set **Shared** to **Yes**.

**Printer sharing considerations**

- The HP Utility must be installed on a computer before it can be used from that computer.

- Any other users sharing your directly connected product will be able to send print jobs, but will not be able to receive information from the product—which affects alerts, status reports, paper management, administration and troubleshooting.

- Any other users sharing your directly connected product will be unable to use the printer’s own print preview facility, although the application’s print preview will still be available. See Preview a print on page 71.

   **TIP:** The best way to share the product over a network is to connect the product not to any computer, but to the network. See Connect a computer to the product by network (Windows) on page 18.
Uninstall the printer software (Windows)

1. Insert the HP Start-up Kit DVD into your DVD drive. If the DVD does not start automatically, run the setup.exe program in the root folder of the DVD.

2. Press the Software Installation button.

3. Press the Modify Installation button, and follow the instructions on your screen to uninstall the printer software.

Connect a computer to the product by network (Mac OS)

You can connect your product to a network under Mac OS X by using the following methods:

- Bonjour
- TCP/IP

*NOTE:* The product does not support AppleTalk.

Before you begin, check your equipment:

- The product should be set up and on.
- The Ethernet switch or router should be on and functioning correctly.
- All computers on the network should be on and connected to the network.
- The product should be connected to the network (see Connect the product to your network on page 16).

Now you can proceed to install the printer software and connect to your product.

Bonjour connection

1. Go to the front panel and press , then , then . Note the mDNS service name of your product.

2. Insert the HP Start-up Kit DVD into your DVD drive.
3. Open the DVD icon on your desktop.

4. Open the **Mac OS X HP Designjet Installer**.

5. Follow the instructions on your screen.

6. The printer software is installed, including the printer driver and other HP software, such as the HP Utility, HP Designjet Preview, and connections to HP Designjet ePrint & Share.

   HP Designjet ePrint & Share allows you to create a copy of your document any time you print, securely in the cloud, in your private online print history. This means that you can reprint your documents from anywhere. To use HP Designjet ePrint & Share, you must create a password-protected account to protect your documents.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your product. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your product’s mDNS service name (which you noted in step 1) in the Printer Name column.
If you find the right name, scroll sideways if necessary to see the Connection Type column, and check that it shows Bonjour. Then highlight that line. Otherwise, continue searching further down the list.

If you cannot find your product’s name with a Bonjour connection type, check the box My printer is not in the list. Click Continue.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click Quit to exit, or Create New Queue if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive. If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.

TCP/IP connection

1. Go to the front panel and make a note of the product’s URL (see Access the Embedded Web Server on page 43).

2. Insert the HP Start-up Kit DVD into your DVD drive.

3. Open the DVD icon on your desktop.
4. Open the **Mac OS X HP Designjet Installer**.

5. Follow the instructions on your screen.

6. The printer software is installed, including the printer driver and other HP software, such as the HP Utility, HP Designjet Preview, and connections to HP Designjet ePrint & Share.

   HP Designjet ePrint & Share allows you to create a copy of your document any time you print, securely in the cloud, in your private online print history. This means that you can reprint your documents from anywhere. To use HP Designjet ePrint & Share, you must create a password-protected account to protect your documents.

7. When the software has been installed, the HP Printer Setup Assistant starts automatically, to set up a connection to your product. Follow the instructions on your screen.

8. When you reach the Select Printer screen, look for your product’s URL (which you noted in step 1) in the Printer Name column.

   - If you find the right name, scroll sideways if necessary to see the Connection Type column, and check that it shows **IP Printing**. Then highlight that line. Otherwise, continue searching further down the list.

   - If you cannot find your product’s name with an **IP Printing** connection type, check the box **My printer is not in the list**.

   Click **Continue**.

9. Continue following the instructions on the screen. When you reach the Printer Queue Created screen, click **Quit** to exit, or **Create New Queue** if you want to connect another printer to the network.

10. When the HP Printer Setup Assistant has finished, you can remove the DVD from the DVD drive.

If the printer driver is already installed, the HP Printer Setup Assistant can be run at any time from the DVD.
Connect a computer to the product by USB cable (Mac OS)

You can connect your product directly to a computer without going through a network, by using the product's built-in Hi-Speed USB device port.

The following instructions apply if you intend to print from software applications using a printer driver. If you intend to print only with the Embedded Web Server, you do not need to install the printer software, and you can ignore these instructions: see Printing on page 63.

1. Make sure the product is either turned off, or disconnected from the computer.
2. Insert the HP Start-up Kit DVD into your DVD drive.
3. Open the DVD icon on your desktop.
4. Open the Mac OS X HP Designjet Installer.
5. Follow the instructions on your screen.
6. The printer software is installed, including the printer driver and the HP Utility.
7. Make sure that the product is turned on and connected to the computer with a certified USB cable.

**NOTE:** The use of non-certified USB cables can lead to connectivity problems. Only cables certified by the USB Implementor's Forum ([http://www.usb.org/](http://www.usb.org/)) should be used with this product.

8. Shortly afterwards, a print queue is created automatically for your printer.

**Sharing the product**

If your computer is connected to a network, you can make your directly connected product available to other computers on the same network.

1. Double-click the System Preferences icon on the Dock menu bar on your desktop.

2. Under Mac OS X 10.4, enable printer sharing by going to **Sharing > Services > Printer Sharing**.

   Under later versions of Mac OS X, go to **Sharing**, select **Printer Sharing**, and then check the printer(s) that you want to share.

3. Your product now automatically appears in the list of shared printers displayed by any other computer running Mac OS and connected to your local network.

Please bear in mind the following considerations.

- Any other users wishing to share your product must install the printer software on their own computers.

- Anyone sharing your directly connected product will be able to send print jobs, but will not be able to receive information from the product—which affects alerts, status reports, paper management, administration and troubleshooting.

- The PCL3GUI (raster) driver can drive a shared printer between different versions of Mac OS, but the PostScript driver does not support printer sharing between Mac OS X 10.4 and Mac OS X 10.5 or 10.6. It does support printer sharing between Mac OS X 10.5 and 10.6.

- You may find that sharing your directly connected product with other users will slow down your computer unacceptably.

**TIP:** The best way to share the product over a network is to connect the product not to any computer, but to the network. See [Connect a computer to the product by network (Mac OS)](page 20) on page 20.

**Uninstall the printer software (Mac OS)**

1. Insert the *HP Start-up Kit* DVD into your DVD drive.
2. Open the DVD icon on your desktop.

3. Open the **Mac OS X HP Designjet Uninstaller**, and follow the instructions on your screen to uninstall the printer software.

To delete the print queue:

- **Under Mac OS X 10.4** there are two alternative ways of deleting the print queue:
  - From the system preferences, select the **Printing** pane of the **Print & Fax** dialog. Select the name of the product and click the − button.
  - From the Print Setup utility, select the name of the product and click the **Delete** icon.
- **Under Mac OS X 10.5 or 10.6**: from the system preferences, select the **Print & Fax** dialog. Select the name of the product and click the − button.
3 Setting up the product

- Introduction
- Set up your Web-connected product
- Web Services manual configuration
- Create a scan-to-network folder
- Paper suitability options
- Turn nesting on and off
- Turn alerts on and off
- Control access to the product
- Require account ID
- Set Windows driver preferences
Introduction

This chapter describes various product settings that the product administrator may wish to control as soon as a new product is assembled and ready for use.

Set up your Web-connected product

Your product can connect to the Internet to benefit from various Web Services (see also Web Services on page 11):

- Automatic firmware updates
- Use HP Designjet ePrint & Share from the front panel
- Use HP ePrint to print by email

To set up your product for Web Services, please follow these steps, explained in more detail below:

1. Make sure that your product is correctly connected to the Internet.
2. Run the Connectivity Wizard: At the front panel, press then Connectivity > Connectivity wizard.
   
   If you cannot find the Connectivity Wizard in the menu, please update your firmware and then try again.

   If the Wizard downloads new firmware, the product may need to restart.

   **TIP:** When the Wizard displays your printer code and email address, you are recommended to make a note of them.

3. Create an HP Designjet ePrint & Share account when prompted, or later, at http://www.hp.com/go/eprintandshare. HP Designjet ePrint & Share saves copies of all your print jobs in the cloud so that you can reprint and share them from almost anywhere, even from smartphones and tablet computers.

4. Activate your account by clicking the activation link that you will receive by email.

   **TIP:** If you don’t see the message, remember to check your junk email folder.

5. This is an optional step: If you are the printer administrator, log in at the HP ePrint Center (http://www.hp.com/go/eprintcenter) to customize your printer’s email address or manage eprinter security for remote printing.

Congratulations, you now have completed Web Services setup. HP ePrint and HP Designjet ePrint & Share are ready to use.

For the latest information, support, and terms of use of the HP ePrint Center and HP Designjet ePrint & Share, see their respective websites, http://www.hp.com/go/eprintcenter and http://www.hp.com/go/eprintandshare.
Web Services manual configuration

The Connectivity Wizard (see Set up your Web-connected product on page 28) is normally sufficient for Web Services configuration, but there are also facilities for manual configuration if you wish to use them.

Configure the product’s Internet connection

You can configure the product’s Internet connection from the Embedded Web Server or from the front panel.

**NOTE:** If an administrator password has been set, it will be required to change these settings. Thus, the administrator can prevent the product from being connected to the Internet, if desired.

- **In the Embedded Web Server:** select Setup > Internet connection.
- **Using the front panel:** press \( \text{ } \), then \( \text{ } \), then Connectivity > Internet connectivity.

The following settings are available:

- **Enable Internet connection:** The default value is Yes.
- **Proxy > Enable proxy:** Enable or disable a proxy server.
- **Proxy > Address:** Enter the proxy address, empty by default.
- **Proxy > Primary port:** Enter the proxy port number, zero by default.
- **Proxy > Restore factory settings:** Return to the initial default settings.

If you have trouble with your Internet connection, see Cannot connect to the Internet on page 200.

Configure firmware updates

You can choose from the Embedded Web Server or from the front panel whether and how to download firmware updates.

**NOTE:** If an administrator password has been set, it will be required to change these settings.

- **In the Embedded Web Server:** select Setup > Firmware update.
- **Using the front panel:** press \( \text{ } \), then \( \text{ } \), then Updates > Firmware update.

The following settings are available:

- **Check:** If you select Automatically (the default setting), the product will check automatically every week (or after the product has been restarted seven times, whichever happens first) whether new firmware is available. If you select Manually, the product will not check automatically; you can check manually whenever you like.
- **Download:** If you select Automatically (the default setting), the product will automatically download new firmware whenever it becomes available. If you select Manually, you will be asked to approve each download.

**NOTE:** Downloading the firmware does not mean that you have installed it in your product. To install the new firmware, you must confirm the installation manually.
● **Firmware update information**: Information about the firmware currently installed

● **Firmware update history**: A list of firmware versions that have been installed in the product. It is usually possible to reinstall the version immediately before the version that is currently installed, if you have some problem with the current version.

### Set remote printing preferences

At the front panel, press 📰, then ⬇️, then **Setup > Printing preferences** to define the default properties of jobs sent to your printer from remote locations.

- **Printer margins**: Choose between **Clip from contents** and **Add to content**.
- **Color**: Choose between **Color** and **Grayscale** printing.
- **Print quality**: Choose between **Best**, **Normal**, and **Fast**.
- **Roll**: Choose between **Roll 1**, **Roll 2**, and **Save paper**, which automatically chooses the narrowest roll on which the print will fit.
- **Jobs**: Choose between **On hold** and **Direct print**. By default, jobs from the cloud are **On hold**. If you choose **Direct print**, the front panel will not ask for permission before printing.

### Set HP Designjet ePrint & Share preferences

At the front panel, press 📰, then ⬇️, then **Setup > Printing preferences** to define the default properties of the jobs sent to your printer from HP Designjet ePrint & Share.

- **Size**: Choose between resizing the print to a percentage of its original size, or to fit a particular paper size. The default is 100% of its original size.
- **Color**: Choose between **Color** and **Grayscale** printing.
- **Print quality**: Choose between **Best**, **Normal**, and **Fast**.
- **Roll**: Choose between **Roll 1**, **Roll 2**, and **Save paper**, which automatically chooses the narrowest roll on which the print will fit.
- **Rotation**: Choose between any multiple of 90°, or **Automatic**, which rotates the print automatically if doing so will save paper.

### Create a scan-to-network folder

A scanned image may be saved in a USB flash drive or in a network folder. The USB flash drive option requires no preparation, but the network folder option will not work until it has been set up in the following way.

**NOTE:** The product accesses shared folders (as a client) using NTLMv1-based authentication. If, for security reasons, you prefer not to expose user credentials using NTLMv1, you should avoid using a scan-to-network folder.

1. Create a folder on a computer that the scanner can access through the network.
2. Create a user account on the same computer for the product.
3. Change the sharing options of the folder so that it is shared with the ‘scanner user’, and assign full control of the folder to that user.

4. Create a share name for the folder.

**NOTE:** It is important to complete the above steps before starting the remaining steps below.

5. In the product's Embedded Web Server, select the **Setup** tab and then **Scan to network**. See Access the Embedded Web Server on page 43.

Alternatively, in the HP Utility, select the **Settings** tab and then **Scan to network**. See Access the HP Utility on page 43.

6. On the Scan to Network page, click **Add folder details**, and fill in the various fields.

   - **Server name** should contain the network name of the remote computer.
   - **Folder name** should contain the share name of the folder.
   - **User name** should contain the name of the ‘scanner user’.
   - **User password** should contain the password of the ‘scanner user’.
   - **Domain name** should contain the name of the domain in which the user name exists. If the ‘scanner user’ does not belong to any domain, leave this field empty.

   The server and folder names are used to connect to the shared folder by building a network folder path as follows: `\server name\folder name`

7. Click **Apply** to save the configuration.

8. The product automatically checks that it can access the network folder. If not, see Cannot access the network folder on page 195.

**Example: Create a scan-to-network folder under Windows**

1. Create a new user account for the ‘scanner user’ on the remote computer. You can use an existing user account for this purpose, but it is not recommended.

2. Create a new folder on the remote computer (unless you want to use an existing folder).

3. Right-click the folder and select **Properties**.
4. In the **Sharing** tab, click the **Advanced Sharing** button.

5. Check the **Share this folder** box.

6. You need to ensure that the ‘scanner user’ has full read/write control over the shared folder. To do this, click **Permissions** and grant **Full Control** to the user (or to any suitable group that includes that user).
7. If there is a **Security** tab in the Properties window for your folder, then you must also grant the same user **Full Control** over the folder in the **Security** tab. Only some file systems such as NTFS require this.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the product to send scans to the folder.

8. In the product’s Embedded Web Server, select the **Setup** tab and then **Scan to network**.
9. On the Scan to Network page, click **Add folder details**.

**NOTE:** If the product has already been configured for scanning to the network and you now want to use a different shared folder, click **Modify**.

Enter the name or IP address of the remote computer, the name of the shared folder, and the user name and password of the ‘scanner user’ that you have already created on the remote computer.

Leave the user domain field empty unless the user is a member of a Windows domain. If the user is only a local user of the remote computer, leave the field empty.

You can use the name (instead of the IP address) in the server name field only if the shared folder is on a Windows computer in the same local network. This must be a simple name (up to 16 characters long) without a domain suffix (i.e. without any dots in the name). Fully qualified DNS domain names are not supported.

If the product and the network folder are in different networks, or if the remote computer is not running Windows, then you must use the IPv4 address instead of the name of the remote computer. On IPv6 networks the IPv6 address is also supported.

10. When you click **Apply**, the product will try to confirm that it can access the shared folder correctly. If all is well, you can now send scanned images to the shared folder. If not, see **Cannot access the network folder** on page 195.

You can check at any later time that the shared folder remains accessible by clicking **Verify** in the Embedded Web Server. A correctly configured shared folder can become inaccessible if the user’s password is changed, or if the shared folder is moved or deleted.
Example: Create a scan-to-network folder under Mac OS

1. Create a new user account for the ‘scanner user’ on the remote computer. You can use an existing user account for this purpose, but it is not recommended.

2. Create or choose a folder on the remote computer. By default, Mac OS users have a “Public Folder” that can easily be used for this purpose.

3. Open the **System Preferences** application and select the **Sharing** icon.

4. Make sure the ‘scanner user’ has **Read & Write** access to the folder.

5. Click **Options**.

6. Check the **Share files and folder using SMB** box, and make sure that the ‘scanner user’ is checked in the On column.
7. Click **Done**. You will now see file sharing enabled and Windows sharing on.

The 'scanner user' can now access the folder and write files to it. Next, you must configure the product to send scans to the folder.

8. In the product's Embedded Web Server, select the **Setup** tab and then **Scan to network**.

9. On the Scan to Network page, click **Add folder details**.

   **NOTE:** If the product has already been configured for scanning to the network and you now want to use a different shared folder, click **Modify**.

   Enter the IP address of the remote computer, the name of the shared folder, and the user name and password of the 'scanner user' that you have already created on the remote computer.

   **NOTE:** You cannot use the remote computer’s host name as the server name, as this is supported only for computers running Windows. You must use the IPv4 or IPv6 address.

   Leave the user domain field empty.

10. When you click **Apply**, the product will try to confirm that it can access the shared folder correctly. If all is well, you can now send scanned images to the shared folder. If not, see [Cannot access the network folder on page 195](#).

    You can check at any later time that the shared folder remains accessible by clicking **Verify** in the Embedded Web Server. A correctly configured shared folder can become inaccessible if the user’s password is changed, or if the shared folder is moved or deleted.
Paper suitability options

Paper mismatch action

If the paper currently loaded in the printer is not suitable for a particular job, the printer can either put the job on hold until some suitable paper is loaded, or it can ignore the problem and print the job on the unsuitable paper. There are several ways in which the loaded paper may be considered unsuitable:

- The paper type is not as specified for the job
- The paper source (roll 1, roll 2 or sheet) is not as specified for the job
- The paper size is smaller than specified for the job

You can set the printer’s behavior in such cases from the front panel.

- Press \( \text{[Menu]} \), then \( \text{[Setup]} \), then \( \text{[Job management options]} \) > \( \text{[Paper mismatch action]} \) > \( \text{[Print anyway]} \) if you want such jobs to print on whatever paper is loaded. This is the default option when printing from a software application or from the Embedded Web Server; but it does not work when printing from a USB flash drive, nor when copying.

- Press \( \text{[Menu]} \), then \( \text{[Setup]} \), then \( \text{[Job management options]} \) > \( \text{[Paper mismatch action]} \) > \( \text{[Put job on hold]} \) if you want such jobs to be put on hold. The printer will send an alert whenever a job is put on hold.

When a job is put on hold for paper, it is kept in the printer queue until some suitable paper is loaded (in which case, all jobs waiting for that paper type can be printed). Meanwhile, other jobs with different requirements can continue printing.

Roll switching options

If two rolls are loaded, both of which are suitable for the job, the roll will be chosen according to your preferences. These can be set from the front panel: press \( \text{[Menu]} \), then \( \text{[Setup]} \), then \( \text{[Printing preferences]} \) > \( \text{[Paper options]} \) > \( \text{[Roll switching options]} \).

\( \text{NOTE:} \) These options are ignored when printing from USB flash drive and when copying.

There are three available options:

- **Minimize paper waste.** If this option is chosen, the printer will choose the narrowest roll that meets all the criteria, to avoid wasting paper due to trimming. This is the default option.

- **Minimize roll changes.** If this option is chosen, the printer will choose the roll that is currently active, to avoid wasting time with a roll switch.

- **Use roll with less paper.** If this option is chosen, the printer will choose the roll that has the least paper.

\( \text{NOTE:} \) This option is effective only if you have enabled \textit{Printing paper info} (see \textit{Printing paper info on page 58}). Otherwise, it has the same effect as \textit{Minimize paper waste}. 
**Turn nesting on and off**

Nesting means automatically printing images or document pages side by side on the paper when feasible, rather than one after the other. This is done to avoid wasting paper. See Nest jobs to save roll paper on page 75.

To turn nesting on or off, you must first make sure that the job queue is enabled (see Turn off the job queue on page 103 or Turn off the job queue on page 99) and the start of printing is set to After Processing (see Select when to print a job in the queue on page 101 or Select when to print a job in the queue on page 97). Then:

- **In the HP Utility for Windows:** select Settings > Job Management > Nest.
- **In the HP Utility for Mac OS:** select Configuration > Printer Settings > Configure Printer Settings > Job Management > Nest.
- **In the Embedded Web Server:** select Setup > Printer settings > Job management > Nest.
- **Using the front panel:** press \[\#\] then \[\#\] then Setup > Job management > Nest options > Enable nesting.

In each case, you will see the following options:

- **In order:** pages are nested in the order in which they are sent to the printer. The nested pages are printed as soon as one of three conditions is met:
  - The next page will not fit on the same row as the other pages already nested.
  - No page has been sent to the printer during the specified wait time.
  - The next page is incompatible with the pages already nested (see Nest jobs to save roll paper on page 75).

- **Optimized order:** pages are not necessarily nested in the order in which they are sent to the printer. When it receives an incompatible page, the printer holds it and waits for compatible pages to complete the nest. The nested pages are printed as soon as one of three conditions is met:
  - The next page will not fit on the same row as the other pages already nested.
  - No page has been sent to the printer during the specified wait time.
  - The incompatible-page queue is full. The printer can queue up to six incompatible pages while nesting compatible pages. If it receives a seventh incompatible page, the nest is printed as it is.

- **Off:** nesting is disabled. This is the default option.

**NOTE:** The product's internal prints are always nested, even if nesting is disabled.

The nesting wait time can be set at the front panel: press \[\#\] then \[\#\] then Setup > Job management > Nest options > Select wait time.

**TIP:** Optimized order uses the minimum amount of paper; however, it may take longer to print because the printer waits for compatible pages to arrive.
Turn alerts on and off

Alerts warn you when there is a problem that you can correct by taking action, or when one of your jobs changes its status. The alerts are displayed by the front panel, by the HP Utility, by the printer driver and by the Embedded Web Server.

You can tell the product which kinds of alerts you would like to see (if any). To access the alert settings:

- Select Alert Settings in the Device List page of the HP Utility.
- Select Alert Settings in any alert page displayed by the HP Utility for Windows.
- Right-click the system tray icon of the HP Utility for Windows, and select Alert Settings.

You can change the settings in the following ways:

- Turn all alerts on or off.
- Turn job status alerts on or off.
- Turn on or off alerts for problems that prevent the product from working.
- Turn on or off alerts for problems that do not prevent the product from working.
- Turn on alerts in all circumstances, or only when you are trying to use the product.

Control access to the product

Front-panel security settings

From the front panel, you can press \[^{4}\], then \[^{3}\], then Setup > Security, to control some of the features of the product.

- **USB drive**: Enable or disable the use of a USB flash drive.
- **Firmware upgrade from USB**: Enable or disable firmware updates from a USB flash drive.
- **Direct print using HP Designjet ePrint & Share**: Enable or disable using HP Designjet ePrint & Share with a computer connected directly to the product.
- **Enable Internet connection**: Enable or disable the Internet connection.

  **NOTE:** If you disable it, you also disable automatic firmware upgrades, the HP Designjet ePrint & Share connection, and remote printing.

- **Printer access control**: Enable, disable, or change the administrator password.

If an administrator password has been set, it must be given in order to perform the following operations:

- Change the security settings (including the administrator password itself)
- Change the configuration of the Internet connection
- Change the Automatic Firmware Update configuration
- Enable or disable automatic downloading and/or installation of automatic firmware updates
• Restore an earlier firmware version
• External hard disk options
• Reset factory defaults

**NOTE:** The administrator password can contain only characters that appear on the front panel’s on-screen keyboard. If you set a new password with the Embedded Web Server, it will reject characters that do not appear in that limited character set.

### Embedded Web Server security settings

From the Embedded Web Server, you can select the **Security** tab to control access to the product in various ways:

- Specify separate administrator and guest passwords to control access to the Embedded Web Server
- Enable or disable Ethernet and USB connections to the product
- Enable or disable various groups of front panel operations
- Use the same security settings that are available in the front panel (see above)

**NOTE:** An administrator password may be required.

**NOTE:** For more information, see the Embedded Web Server’s online help.

### Disable your HP ePrint Center connection

You can disable the connection to the HP ePrint Center if required for security. At the front panel, press 

![Symbol] then 

![Symbol] then **Connectivity > HP ePrint Center > HP ePrint Center settings > HP ePrint Center connectivity** and select **Disable**.

**Disable** just puts the remote printing function on hold. If you want to resume using it, you just need to re-enable it in the same menu. No more setup steps are required at the HP ePrint Center website or in HP Designjet ePrint & Share.

If you want to disable remote printing permanently, select **Disable permanently**, which erases your product from your HP ePrint Center account. To use remote printing again, you will need to set it up again from scratch (see **Set up your Web-connected product on page 28**).

**NOTE:** You can prevent non-administrators from changing these options by setting an administrator password in the Embedded Web Server (**Setup > Security**).

### Require account ID

If you want to keep records of product usage by different user accounts, you can set your product to require an account ID for each job.

- **In the HP Utility for Windows:** select **Settings > Accounting > Require account ID**.
- **In the HP Utility for Mac OS:** select **Configuration > Printer Settings > Configure Printer Settings > Accounting > Require account ID**.
If this setting is turned on, the account ID field will be mandatory and jobs with no account ID will be kept "on hold for accounting".

The account ID can be set in the printer driver when sending the job. If the job is set "on hold for accounting" by the printer, you can introduce the account ID in the HP Utility by going to the Job Center > Job Queue and clicking the job that is on hold. A window with a text box will be displayed and you can enter the account ID into it.

**Set Windows driver preferences**

You can change some default settings in your printer driver according to your own preferences, for instance to set color emulation or paper-saving options. To do this, press the Start button on your computer's screen, then select Printers and Faxes. In the Printers and Faxes window, right-click your product's icon, and select Printing Preferences. Any settings you change in the Printing Preferences window will be saved as default values.
4 Personalizing the product

- Change the language of the front-panel display
- Access the HP Utility
- Access the Embedded Web Server
- Change the language of the HP Utility
- Change the language of the Embedded Web Server
- Change the sleep mode setting
- Turn the buzzer on and off
- Change the front-panel display brightness
- Change the units of measurement
- Configure network settings
- Change the printer’s graphic language setting
- Manage ePrinter security
- Change your printer’s email address
Change the language of the front-panel display

There are two possible ways to change the language of the front-panel menus and messages.

- If you can understand the current front-panel display language, press \[ \text{ } \], then \[ \text{ } \], then Setup > Front panel options > Select language.
- If you cannot understand the current front-panel display language, start with the product powered off. Press the Power key to turn it on. When you see icons appear on the front panel, press \[ \text{ } \] and then \[ \text{ } \]. The front panel acknowledges this sequence by turning the icons on and off rapidly.

Whichever method you used, the language selection menu should now appear on the front-panel display. Press your preferred language.

Access the HP Utility

The HP Utility enables you to manage your product from a computer with a USB, TCP/IP or Jetdirect connection.

- **Under Windows**, start the HP Utility from your desktop shortcut or from Start > All Programs > Hewlett-Packard > HP Utility > HP Utility. This launches the HP Utility, showing the printers installed on your computer.
- **Under Mac OS**, launch the HP Utility from your dock shortcut or by selecting STARTUP_DISK > Library > Printers > hp > Utilities > HP Utility. This launches the HP Utility, showing the printers installed on your computer.

When you select your product in the left pane, everything that appears in the right pane is specific to that product.

If you have followed these instructions but failed to get through to the HP Utility, see **Cannot access the HP Utility on page 200.**

Access the Embedded Web Server

The Embedded Web Server enables you to manage your product remotely using an ordinary Web browser running on any computer.

To access the Embedded Web Server directly, you must have a TCP/IP connection to your product. However, you can access the Embedded Web Server indirectly through the HP Utility, if you connect to your product with a USB connection.

The following browsers are known to be compatible with the Embedded Web Server:

- Internet Explorer 6 for Windows XP, and later
- Safari 2 for Mac OS X 10.5, and later
- Firefox 2.0 and later
- Google Chrome 1.0 and later

The Adobe Flash plugin version 7 or later is recommended for viewing job previews.
To access the Embedded Web Server on any computer, open your Web browser and give the IP address of your product.

You can see your product’s IP address on the front panel by pressing \( \text{Home} \) and then \( \text{Setup} \).

If you have followed these instructions but failed to get through to the Embedded Web Server, see *Cannot access the Embedded Web Server on page 200.*

## Change the language of the HP Utility

The HP Utility can work in the following languages: English, Portuguese, Spanish, Catalan (Windows only), French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese.

- **Under Windows**, select *Tools > Set Language* and select a language from the list.
- **Under Mac OS**, the language is changed as for any other application. In *System Preferences*, select *International* and re-launch the application.

## Change the language of the Embedded Web Server

The Embedded Web Server can work in the following languages: English, Portuguese, Spanish, Catalan, French, Italian, German, Russian, Simplified Chinese, Traditional Chinese, Korean and Japanese. It uses whichever language you have specified in your Web browser’s options. If you have specified a language that it cannot support, it works in English.

To change the language, you must change your Web browser’s language setting. For example, in Internet Explorer version 6, go to the *Tools* menu and select *Internet Options, Languages*. Then ensure that the language you want is at the top of the list in the dialog box.

## Change the sleep mode setting

If the product is left switched on but unused for a certain period of time, it goes automatically into sleep mode to save power. To change the time the product waits before it goes into sleep mode, go to the front panel and press \( \text{Home} \), then \( \text{Setup} \), then *Setup > Front panel options > Sleep mode wait time*. Select the wait time you want and then press *OK*; you can set the time from 1 to 240 minutes. The default time is 30 minutes.

## Turn the buzzer on and off

To turn the product’s buzzer on or off, go to the front panel and press \( \text{Home} \) then \( \text{Setup} \) then *Setup > Front panel options > Enable buzzer*, and select on or off. By default, the buzzer is set to on.

## Change the front-panel display brightness

To change the brightness of the front-panel display, press \( \text{Home} \) then \( \text{Setup} \) then *Setup > Front panel options > Select display brightness*, and select a value you want. Press *OK* to set the value. The default brightness is set to 50.
Change the units of measurement

To change the units of measurement in the front-panel display, press \( \text{[Setup]} \), then \( \text{[Setup]} \), then \( \text{[Setup]} \) > \( \text{[Front panel options]} \) > \( \text{[Select units]} \), and select \( \text{[English]} \) or \( \text{[Metric]} \). By default the units are set to metric.

Configure network settings

You can view and configure the network settings from the Embedded Web Server, the HP Utility or the front panel.

To do so with the Embedded Web Server, select the \( \text{[Setup]} \) tab, then \( \text{[Networking]} \).

With the HP Utility under Windows, select the \( \text{[Settings]} \) tab, then \( \text{[Network Settings]} \). Under Mac OS, select \( \text{[Configuration]} \) > \( \text{[Network Settings]} \).

The following settings are available.

- **IP Configuration method**: specify the way to set an IP address, selecting \( \text{[BOOTP]} \), \( \text{[DHCP]} \), \( \text{[Auto IP]} \) or \( \text{[Manual]} \).
- **Host name**: specify the IP name of the product. The name may contain up to 32 ASCII characters.
- **IP address**: specify the IP address of the product. Duplicate IP addresses on a TCP/IP network will cause communication to fail.

⚠️ **TIP**: Make sure that the combination of IP address, subnet mask and default gateway is valid. If these three fields are inconsistent, you may not be able to connect to the product at all until you fix the problem from the front panel.

⚠️ **TIP**: If you change the current IP address and click \( \text{[Apply]} \), the browser loses the current connection to the product because it is pointing to the old address. To reconnect, browse to the new IP address.

- **Subnet mask**: specify a subnet mask, which determines which bits specify the network and which bits uniquely specify the node within the network.
- **Default gateway**: specify the IP address of a router or computer that is used to connect to other networks or sub-networks. If none exist, use the IP address of the computer or the IP address of the product.
- **Domain name**: specify the name of the DNS domain in which the product resides (for example, support.hp.com).

⚠️ **NOTE**: The domain name does not include the host name: it is not the fully qualified domain name, such as printer1.support.hp.com.

- **Idle timeout**: specify the number of seconds that an idle connection is allowed to remain open; 30 is the default value. If set to zero, the timeout is disabled and TCP/IP connections remain open until closed by the other node (such as a workstation) on the network.
- **Default IP**: specify the IP address to use when the product is unable to obtain an IP address from the network when powered on or when reconfigured to use BOOTP or DHCP.
- **Send DHCP requests**: specify whether DHCP requests are transmitted when a legacy default IP address or a default Auto IP is assigned.
To configure the same network settings from the front panel, press 

then 

then Setup > Connectivity > Gigabit Ethernet > Modify configuration.

You have various other options available from the Setup > Connectivity > Advanced menu.

- **I/O timeout**: specify the number of seconds that an idle connection is allowed to remain open, 270 is the default value, if set to zero, the timeout is disabled

- **Allow SNMP**: specify whether SNMP is permitted

- **Embedded Web Server > Allow EWS**: specify whether the Embedded Web Server is enabled

- **Web Services > HP Utility software**: view the HP Utility software settings

- **Web Services > Color and paper management**: view the color and paper management settings

### Change the printer’s graphic language setting

You can change the printer’s graphic language setting from the HP Utility with the following steps.

1. **Under Windows**, select the Settings tab then Printer settings > Printing preferences.


2. Select one of the following options.

- Select **Automatic** to let the printer determine which type of file it is receiving. This is the default setting; it works for most software applications. You should not normally need to change it.

- Select **HP-GL/2** only if you are sending a file of that type directly to the printer, without going through a printer driver.

- Select **PDF** only if you are sending a file of that type directly to the printer, without going through a printer driver (T2300 PS only).

- Select **PostScript** only if you are sending a file of that type directly to the printer, without going through a printer driver (T2300 PS only).

- Select **TIFF** only if you are sending a file of that type directly to the printer, without going through a printer driver (T2300 PS only).

- Select **JPEG** only if you are sending a file of that type directly to the printer, without going through a printer driver (T2300 PS only).

You can change the graphic language setting from the front panel. Press 

then 

then Setup > Printing preferences > Graphics language. Select the desired option.

**NOTE:** If the graphic language is set from the HP Utility, it overrides the front panel setting.
Manage ePrinter security

When you have set up Web Services, the printer is in unlock mode. In unlock mode, anyone who knows your printer’s email address can print to your printer by just sending a file to it. Although HP provides a spam filtering service, you should be careful about giving out your printer’s email address, as everything sent to that address may be printed on your printer.

If you are the printer administrator, you can manage ePrinter security or change your printer status to lock mode by visiting the HP ePrint Center at [http://www.hp.com/go/eprintcenter](http://www.hp.com/go/eprintcenter). You can also customize your printer’s e-mail address and manage print jobs from there. At your first visit, you will need to create an account in the HP ePrint Center.

Change your printer’s email address

You can change your printer’s email address at the HP ePrint Center.
5 Printer paper handling

- General advice
- Load a roll onto the spindle
- Load a roll into the printer
- Unload a roll
- Load a single sheet
- Unload a single sheet
- View information about the paper
- Paper presets
- Printing paper info
- Move the paper
- Maintain paper
- Change the drying time
- Turn the automatic cutter on and off
- Feed and cut the paper
CAUTION: Before starting a paper loading process, ensure you have enough room around the product, both in front and behind.

CAUTION: Make sure the product wheels are locked (the brake lever is pressed down) to prevent the product from moving.

CAUTION: All paper must be 280 mm (11 in) or longer. A4 and letter paper cannot be loaded in landscape orientation.

TIP: For photo paper wear cotton gloves to avoid transferring oils onto the paper.

CAUTION: Keep the basket closed throughout the loading process.
Load a roll onto the spindle

1. Open the roll cover.

2. Remove the black end of the spindle from the printer, then the blue end.

   **CAUTION:** Be sure to remove the black end first. Removing the blue end first could damage the black end.

   **WARNING!** Do not insert your fingers into the spindle supports during the removal process.

3. The spindle has a stop at each end to keep the roll in position. The blue stop can be removed to mount a new roll; it slides along the spindle to hold rolls of different widths. Remove the blue paper stop from the end of the spindle.

4. If the roll is long; rest the spindle horizontally on a table and load the roll on the table.

   **TIP:** You may need two people to handle a large roll.
5. Slide the new roll onto the spindle. Make sure the paper type is oriented as shown. If it is not, remove the roll, turn it 180 degrees and slide it back on to the spindle. There are labels on the spindle showing the correct orientation.

**NOTE:** From the back of the product, the blue stopper is inserted into the right-side holder.

![Diagram showing correct orientation](image)

Ensure both ends of the roll are as close to the spindle stops as possible.

6. Put the blue paper stop on to the open end of the spindle, and push it towards the end of the roll.

![Diagram showing blue paper stop](image)

7. Ensure the blue paper stop is pushed in as far as it goes; until both ends are against the stoppers.

If you are a regular user of different paper types, you can change rolls more quickly if you preload rolls of different paper types on different spindles. Extra spindles are available for purchase, see Accessories on page 165.

### Load a roll into the printer

To start this procedure, you must have a roll loaded on the spindle. See Load a roll onto the spindle on page 50.

**TIP:** Do not try to open both roll covers at once; this may cause problems. Always close one cover before opening the other.
NOTE: You can, if you like, start loading the paper without using the front panel. However, in this case the printer will not keep track of the length of the roll, and will print no barcode on the roll when it is next unloaded. So you are recommended to follow all the steps below, unless you have turned off the Printing paper info option. See Printing paper info on page 58.

1. From the front panel, press \[ \text{ } \] then the roll icon, then Load.

   Alternatively, press \[ \text{ } \] then Paper > Paper load > Load roll 1 or Load roll 2.

   If the roll you have selected is already loaded, you have to wait while it is automatically unloaded.

   You should stand behind the product when loading the lower roll (roll 2). You may stand behind or in front of the product when loading the upper roll (roll 1).

   CAUTION: If your height is less than 1.6 m (5 ft 3 in), loading a roll while standing in front of the product may cause back pain or other physical problems.

   If you start to load roll 1 while roll 2 is already loaded, roll 2 is withdrawn to the standby position, so that it can be printed on again without reloading whenever required.

2. If the roll cover is closed, the front panel asks you to open it.

   NOTE: If at any time you open a roll cover while that roll is in the standby position, the roll will be automatically unloaded, and you will have to reload it the next time you want to print on it.

3. Rest the spindle’s black end on the left side roll holder. Do not put the end completely into the roll holder.

4. Rest the blue end of the spindle on the right side roll holder.
5. With both hands, push the spindle into both roll holders at the same time.

6. If the edge of the roll is not straight or torn (sometimes due to tape used to hold end of the roll), pull the paper slightly and cut a straight edge.

7. Insert the edge of the paper into the printer.

**WARNING!** Do not push your fingers inside the printer’s paper path.

**TIP:** When loading the upper roll, avoid inserting roll paper into the cut-sheet slot. If you do so, the printer beeps and the front panel asks you to remove the paper.
8. Roll the paper into the printer until you feel resistance and the paper flexes slightly. When the printer detects the paper, it feeds it in automatically.

\[\text{TIP: If you close the roll cover too soon, the paper load will be cancelled. Wait until the front panel asks you to close it.}\]

9. If the leading edge of the paper has a barcode, the printer reads and then cuts off the barcode; you should remove and discard the cut strip of paper.

10. If the leading edge of the paper has no barcode, the front panel asks you to select the paper category and type.

\[\text{TIP: If you have loaded a paper type whose name does not appear in the paper list, see The paper type is not in the driver on page 175.}\]

11. If the **Printing paper info** option is enabled, the front panel may ask you to specify the length of the roll. See **Printing paper info on page 58.**

12. The printer checks the alignment and measures the width, then the front panel asks you to close the roll cover.

If the roll is not correctly aligned, follow the instructions on the front-panel display.

\[\text{NOTE: If you have an unexpected issue at any stage of the paper loading process, see The paper cannot be loaded successfully on page 173.}\]

## Unload a roll

Before unloading a roll, check whether there is paper on the roll or if the roll is out of paper, and follow the appropriate procedure as described below.

### Quick procedure with paper on the roll

If there is paper on the roll, just open the roll cover, and the roll is unloaded automatically.

\[\text{NOTE: When the roll is unloaded in this way, no barcode is printed on it, so the printer will not know the length of the roll when it is next loaded. See Printing paper info on page 58.}\]

\[\text{NOTE: If you open the cover of roll 1 while a sheet is loaded, the sheet is also unloaded.}\]
Front panel procedure with paper on the roll

If there is paper on the roll, you can unload it from the front panel.

1. Press \( \text{ } \), then the roll icon, then \( \textbf{Unload} \).

   Alternatively, press \( \text{ } \), then \( \text{ } \), then \( \textbf{Paper} > \textbf{Paper unload} > \textbf{Unload roll 1} \) or \( \textbf{Unload roll 2} \).

2. You may need to open the roll cover.

Roll out of paper procedure

If the end of the paper is no longer attached to the core, use the following procedure.

1. If you have already started the unload process, press \( \text{ } \) on the front panel to cancel that procedure.

2. Lift the blue lever on the left. If the front panel displays a warning about the lever, ignore it.

3. Pull out the paper from the printer. Pull from wherever the paper is accessible; the back of the product is recommended. You may need to open the roll cover.

4. Lower the blue lever.

Load a single sheet

1. Ensure that the cover of roll 1 is closed. If it is opened while a sheet is loaded, the sheet will be immediately unloaded.

2. At the front panel, press \( \text{ } \) then the roll 1 icon, then \( \textbf{Load} > \textbf{Load sheet} \).

   Alternatively, press \( \text{ } \), then \( \text{ } \), then \( \textbf{Paper} > \textbf{Paper load} > \textbf{Load sheet} \).

3. If a roll is already loaded, you have to wait while it is automatically withdrawn to the standby position. From there, it can be printed on again without reloading as soon as the sheet paper has been unloaded.

   \( \text{NOTE:} \) If at any time you open a roll cover while that roll is in the standby position, the roll will be automatically unloaded, and you will have to reload it the next time you want to print on it.

4. Select your paper category and type.

   \( \text{TIP:} \) If you have loaded a paper type whose name does not appear in the paper list, see \( \text{The paper type is not in the driver on page 175} \).

5. When prompted by the front panel, insert the sheet into the cut-sheet slot on the right side of the printer.
Load your sheet aligned with the load line and insert until the paper will not continue; with thicker sheets, you feel resistance.

**WARNING!** Do not push your fingers inside the printer’s paper path.

6. Press **OK** on the front panel to feed the paper into the printer. Guide the sheet into the printer; this is especially important with thicker papers.

7. The printer checks the alignment and measures the sheet.

**NOTE:** Depending on the length of the sheet, it feeds out the front of the printer.

8. If the length of the sheet is more than 600 mm (23 in), the front panel asks you to check that the rear of the sheet is hanging backwards over the roll cover (and not forwards over the scanner).

9. If the sheet is not correctly aligned, you may be asked to correct the alignment. Please follow the instructions on the front-panel display.

**NOTE:** If you have an unexpected problem at any stage of the paper loading process, see *The paper cannot be loaded successfully on page 173.*

### Unload a single sheet

To unload a single sheet after printing, you can simply pull the sheet free from the front of the printer.

To unload a sheet without printing, go to the front panel and press **OK** then the roll 1 icon, then **Unload > Unload sheet.**

Alternatively, press **OK** then **Paper** then **Paper unload** then **Unload sheet.**
The sheet unloads out of the front of the printer; either catch it manually or allow it to fall into the basket.

**View information about the paper**

To view the loaded paper information, press then the roll icon.

The following information is displayed on the front panel:

- Paper type you have selected
- Roll or sheet status
- Width of the paper in millimeters (estimated)
- Length of the paper in millimeters (estimated)

If no paper is loaded, the message **Out of paper** is displayed.

The same information is displayed in the HP Utility for Windows (**Overview** tab > **Supplies Status** tab), the HP Utility for Mac OS (Information group > **Printer Status** > **Supplies Details**) and the Embedded Web Server (upper-right corner).

**Paper presets**

Each supported paper type has its own characteristics. For optimum print quality, the printer changes the way it prints on each different paper type. For example, some may need more ink and some may require a longer drying time. So the printer must be given a description of the requirements of each paper type. This description is called the ‘paper preset’. The paper preset contains the ICC profile, which describes the color characteristics of the paper; it also contains information on other characteristics and requirements of the paper that are not directly related to color. Existing paper presets for your printer are already installed in the printer’s software.

However, as it is inconvenient to scroll through a list of all paper types available, your printer only contains paper presets for the most commonly used paper types. If you have a paper type for which your printer has no preset, you cannot select that paper type in the front-panel display.

There are two ways to assign a preset for a new paper type.

- Use an HP factory paper preset by selecting the closest category and type in the front panel or the HP Utility. See **The paper type is not in the driver on page 175**.

  **NOTE:** Colors may not be accurate. This method is not recommended for high-quality prints.


  **NOTE:** HP provides presets for HP paper types only. If you do not find the paper preset you want on the Web, you may find that it has been added to the latest firmware for your printer. You can check the firmware release notes for information, see **Update the firmware on page 162**.

To install the new preset in your printer, go to the Embedded Web Server’s Setup tab and select **Paper management > Import paper preset**.

If there are some paper types that you never use, you can hide them so that they do not appear in lists and cannot be selected. Go to the Embedded Web Server’s Setup tab and select **Paper management > Show/Hide papers**. Select the paper types that you want to hide, click the arrow
to move them into the hidden paper list, then click Apply. You can move them back into the visible list at any time.

**Printing paper info**

Enable the **Printing paper info** option to record the printer’s estimate of the remaining roll length, paper width and type. The information is a combination of barcode and text that is printed on the leading edge of the roll when the paper is unloaded from the printer.

![Barcode example]

**NOTE:** The paper-length estimate is available only if the printer registered the amount of paper that was on the roll when you loaded it. To provide this information to the printer, specify the roll length on the front panel when loading the paper, or load a roll that has the paper-data barcode printed on it.

**NOTE:** The barcode and text are printed on the roll only when the loading and unloading processes are started from the front panel.

**NOTE:** This option can be expected to work only with papers that are completely opaque. It may fail with transparent or translucent papers.

To enable the **Printing paper info** option, go to the front panel and press Setup > Printing preferences > Paper options > Enable printing paper info.

**NOTE:** Enabling this option slightly changes the paper loading and unloading procedures.

**Move the paper**

If the printer is idle (ready to print), you can move the paper forwards or backwards from the front panel. You may want to do this in order to have more or less white space between the last print and the next one.

To move the paper, press Paper > Move paper.

**NOTE:** You cannot use this option to move the paper in the scanner.

**Maintain paper**

To maintain paper quality, follow the recommendations below.

- Store rolls covered by another piece of paper or cloth.
- Store cut sheets covered and clean or brush them before loading them into the product.
- Clean input and output platens.
- Do not lift the scanner and leave it raised unnecessarily.

**NOTE:** Photo and coated papers require careful handling: they can easily be marked or scratched, especially if touched soon after printing.
Change the drying time

You may wish to change the drying time setting to suit special printing conditions such as multiple prints where time is of higher importance or when you need to be sure ink is dry before handling.

Press Setup, then Print retrieval, then Select drying time. You can select:

- Extended, to set a longer than recommended time to ensure ink is completely dry
- Optimal, to set the default and recommended time for your selected paper (this is the default setting)
- Reduced, to set a shorter than recommended time when quality is of lower importance
- None, to disable the drying time and remove your print as soon as it finishes printing

⚠️ CAUTION: If the ink is not dry when the print is removed it could leave ink in the output tray and marks on the print.

⚠️ NOTE: If you cancel the drying time during a print, the printer may not feed and cut the paper right away due to the printhead maintenance, which runs in parallel. If the dry time is zero, the printer cuts the paper and then performs the printhead maintenance. However, if the dry time is greater than zero, the printer does not cut the paper until after the printhead maintenance has completed.

Turn the automatic cutter on and off

To turn the printer’s paper cutter on or off:

- From the HP Utility for Windows, select the Settings tab and change the Cutter option in Printer Settings > Advanced.
- From the HP Utility for Mac OS, select Configuration > Printer Settings > Advanced and change the Cutter option.
- From the Embedded Web Server, select the Setup tab, then Printer Settings > Advanced, and change the Cutter option.
- From the front panel, press Setup, then Print retrieval, and change the cutter option.

The default setting is On.

⚠️ NOTE: If the cutter is turned off, it will not cut the paper between jobs, but it will continue to cut the paper on loading, unloading and switching between rolls.

💡 TIP: To cut roll paper while the automatic cutter is disabled, see Feed and cut the paper on page 60.
Feed and cut the paper

If you go to the front panel and press \[\text{Feed}\] then \[\text{Cut}\] then \textbf{Paper > Form feed and cut}, the printer advances the paper and makes a straight cut across the front edge. There are several possible reasons why you might want to do this.

- To trim the leading edge of the paper if it is damaged or not straight.
- To feed and cut the paper when the automatic cutter has been disabled.
- To cancel the waiting time and print the available pages immediately, if the printer is waiting to nest more pages.

\begin{itemize}
  \item \textbf{NOTE:} The printheads are serviced after each print, and the paper cannot be cut until the process completes, so you may notice a delay.
  \item \textbf{CAUTION:} Remove the cut piece from the output tray. If strips or short prints are left in the output tray the printer could jam.
\end{itemize}

\begin{itemize}
  \item \textbf{NOTE:} Photo and coated papers require careful handling: they can easily be marked or scratched, especially if touched soon after printing.
  \item \textbf{TIP:} To move the paper without cutting it, see \textit{Move the paper on page 58}.
\end{itemize}
6 Working with two rolls

The uses of a multiroll printer

A multiroll printer can be useful in several different ways:

- The printer can automatically switch between different paper types according to your needs.
- The printer can automatically switch between different paper widths according to your needs. This enables you to save paper by printing smaller images on narrower paper.
- If you load two identical rolls into the printer, you can leave it printing unattended for a long time, because it can switch from one roll to the other automatically when the first is exhausted. See Unattended printing/overnight printing on page 78.

When working with multiple rolls, bear in mind that a protected roll is protected from use unless the roll number or its paper type are specifically requested. See Roll protection on page 77.

The current status of both rolls is shown on the front panel if you press ✂.

**NOTE:** When you print from a USB flash drive, multiroll printing is considerably simplified: either you specify manually which roll you want to use, or you can select Save paper, in which case the printer chooses the narrowest roll on which the print will fit. You cannot specify the paper type.

How the printer allocates jobs to paper rolls

**NOTE:** The information in this section applies only when printing from a printer driver, the Embedded Web Server or the HP Utility.

When you submit a print job, you can specify (using the Paper type or Type is option) that you want it to be printed on a particular paper type; you can even specify (using the Paper source, Source is or Paper Feed option) that you want it to be printed on a particular roll (1 or 2). The printer will try to satisfy these requirements, and it will also look for a paper roll large enough to print the image without clipping.

- If both rolls are suitable for the job, the roll will be chosen according to the roll switching policy. See Roll switching options on page 37.
- If just one of the rolls is suitable for the job, it will be printed on that roll.
- If neither roll is suitable for the job, it will be held in the job queue with the status On hold for paper, or printed on an unsuitable roll, depending on the paper mismatch action. See Paper mismatch action on page 37.
Here are some settings that might be used in typical situations:

- With different paper types loaded:
  - **Type**: select the paper type you require
  - **Source**: Automatically select / Predetermined
  - **Roll switching policy**: doesn’t matter

- With different paper widths loaded:
  - **Type**: Any
  - **Source**: Automatically select / Predetermined
  - **Roll switching policy**: Minimize paper waste

**TIP:** You can also save paper in some cases by rotating or nesting your images. See [Use paper economically on page 75](#).

- With identical rolls loaded:
  - **Type**: Any
  - **Source**: Automatically select / Predetermined
  - **Roll switching policy**: Minimize roll changes
7 Printing

- Introduction
- Print from a USB flash drive
- Print from a computer using the Embedded Web Server or HP Utility
- Print from a computer using a printer driver
- Advanced print settings
Introduction

There are five different ways in which you can choose to print, depending on your circumstances and preferences.

- Print a TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a USB flash drive. See Print from a USB flash drive on page 64.
- Print a file that is already in one of the product’s two job queues. See Reprint a job from the queue on page 98.
- Print a TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript file directly from a computer connected to the product, using the Embedded Web Server or the HP Utility. See Print from a computer using the Embedded Web Server or HP Utility on page 65.
- Print any kind of file from a computer connected to the product by network or USB cable, using a software application that can open the file, and a printer driver supplied with your product. See Print from a computer using a printer driver on page 66.

NOTE: To print PDF or PostScript files, the T2300 PS is required.

Print from a USB flash drive

1. Insert a USB flash drive containing one or more TIFF, JPEG, HP-GL/2, RTL, PDF or PostScript files into one of the product’s USB ports.

NOTE: To print PDF or PostScript files, the T2300 PS is required.

NOTE: The use of USB flash drives with your product may be disabled in the Embedded Web Server (Setup > Security > Disable USB drives or Disable USB printing).

2. At the front panel, go to the home screen and press 📂.

3. Press 📂.

4. Select the file to be printed. Files that can be printed are indicated with ☑; files that cannot be printed are indicated with ☐. You can press folders to browse their contents.

5. The default print settings are displayed. If you want to change them, press Settings. The following settings are available:

   - Size allows you to resize the print in two different ways: to a percentage of its original size, or to fit a particular paper size. The default is 100% (its original size).
   - Color allows you to choose color or grayscale printing.
   - Print quality allows you to set the print quality to Best, Normal or Fast.
   - Roll allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which automatically chooses the narrowest roll on which the print will fit.
   - Rotation allows you to rotate the print by any multiple of 90°, or you can choose Automatic, which rotates the print automatically if that will save paper.
6. To display a preview of the printed job on the front panel, press 
When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.

7. When you are satisfied with the print settings, press Start.

8. If two rolls are loaded, you can choose to print on either roll, or you can let the printer choose automatically.

   NOTE: The printer will automatically rotate the image by 90° if it can save paper by doing so.

9. After printing, you can choose to print another file or go to the job queue. If you print another file immediately without returning to the home screen, the temporary settings used for the previous file are used again.

Print from a computer using the Embedded Web Server or HP Utility

You can print files in this way from any computer that can access the product’s Embedded Web Server. See Access the Embedded Web Server on page 43.

From the Embedded Web Server, select the Main tab and then Submit job. From the HP Utility, select Job Center > Submit Job. You will see the window below.
Press the Add files button to choose the files from your computer that you want to print. The files must be in one of the following formats:

- HP-GL/2
- RTL
- TIFF
- JPEG
- PDF (T2300 PS only)
- PostScript (T2300 PS only)

**NOTE:** When you print to a file, the file should be in one of the above formats, but its name may have an extension such as .plt or .prn.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and number of copies), you can just press the Print button and they will be sent to the printer.

If you need to specify printing settings, go to the Job settings section and select the options you need. Each option has explanatory text on the right, so that you can understand the behavior of each setting. Remember that, if you leave the setting as Default, the setting saved in the job will be used. If the job contains no setting, the setting in the printer will be used.

If you have chosen some non-default settings and expect to reuse the same group of settings in the future, you can save them all under a single name from the Manage presets tab, and recall them using that name later.

### Print from a computer using a printer driver

This is the traditional way of printing from a computer. The correct printer driver must be installed on the computer (see installing the software on page 15), and the computer must be connected to the product by network or USB cable.

When the printer driver has been installed and the computer is connected to the product, you can print from a software application by using the application’s own Print command and selecting the correct printer.

### Advanced print settings

The rest of this chapter explains the various print settings that you can use when printing with a printer driver, the Embedded Web Server or the HP Utility. These methods offer a relatively large number of settings in order to satisfy all requirements.

**TIP:** In general you are recommended to use the default settings unless you know that they do not meet your requirements.

**TIP:** If you intend to reuse a particular group of settings repeatedly, you can save those settings under a name of your own choice and recall them later. A saved group of settings is known as a 'quick set' in the Windows printer driver, and as a 'preset' in the Embedded Web Server.
Select print quality

The printer has various print-quality options because best-quality printing requires some loss of speed, while fast printing implies some reduction in print quality.

Therefore, the standard print-quality selector is a slider that allows you to choose between quality and speed. With some paper types, you can choose a compromise position between the two.

Alternatively, you can select from the custom options: **Best**, **Normal** and **Fast**. If you select **Fast**, you can also select **Economode**, which uses a lower rendering resolution and consumes less ink. It therefore increases printing speed even further, but reduces print quality. **Economode** can be selected only from the custom options (not from the slider).

There is also a supplementary custom option that may have an effect on print quality: **Maximum detail**. See **High-quality printing on page 72**.

**NOTE:** In the Windows driver dialog, the rendering resolution for your job is displayed in the Custom Print Quality Options dialog box (select **Custom options** and then **Settings**). In the Mac OS Print dialog, it is displayed in the **Summary** panel.

You can select print-quality options in the following ways:

- **In the Windows driver dialog**: go to the **Paper/Quality** tab and look at the Print Quality section. If you select **Standard Options**, you will see a simple slider with which you can select speed or quality. If you select **Custom Options**, you will see the more specific options described above.

- **In the Mac OS Print dialog (T2300)**: go to the **Paper/Quality** panel and look at the Quality Options section. If you select **Standard** quality options, you will see a simple slider with which you can select speed or quality. If you select **Custom** quality options, you will see the more specific options described above.

- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS)**: go to the **Paper/Quality** panel and look at the Quality Options section. If you select **Standard** quality options, you will see a simple slider with which you can select speed or quality. If you select **Custom** quality options, you will see the more specific options described above.

- **In the Mac OS X 10.4 PostScript Print dialog (T2300 PS)**: go to the **Image Quality** panel. If you select **Standard** quality options, you will see a simple slider with which you can select speed or quality. If you select **Custom** quality options, you will see the more specific options described above.

- **On the Embedded Web Server’s Submit Job page**: select **Basic settings** > **Print quality**. If you then select **Standard options**, you can choose between **Speed** and **Quality**. If you select **Custom options**, you will see the more specific options described above.

- **Using the front panel**: press  then  then **Setup > Printing preferences > Print quality**.

**NOTE:** If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

**NOTE:** You cannot change the print quality of pages that the printer is already receiving or has already received (even if they have not started to print yet).
Select paper size

The paper size can be specified in the following ways.

NOTE: The paper size specified here should be the paper size in which the document was created. It is possible to rescale the document to a different size for printing. See Rescale a print on page 70.

- In the Windows driver dialog: select the Paper/Quality tab, then select your paper size from the Document Size list.
- In the Mac OS Page Setup dialog: select your printer from the Format for list, then select your paper size from the Paper Size list.

NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

- Using the front panel: press \setup\, then \setup\, then Setup > Printing preferences > Paper options > Select paper size.

NOTE: If the paper size is set from your computer, it overrides the paper size setting in the front panel.

Custom paper sizes

To choose a non-standard paper size not shown in the list of paper sizes:

- Under Windows, there are two different ways:
  - In the driver dialog, click the Custom button in the Paper/Quality tab, then specify the name and the dimensions of your new paper size, then click Save to save your new paper size. To see your new custom size in the list of custom sizes, you need to exit the printer properties, then reenter them (and use the More button if necessary).
  
  NOTE: The driver will not allow you to create a paper size whose width exceeds its length.

  - From the Start menu, select Printers and Faxes, then from the File menu select Server Properties. In the Forms tab, check the Create a new form box, specify the name and dimensions of the new form, then click Save Form.


NOTE: If your application offers no Page Setup dialog, please use the Print dialog.

Select margins options

By default, the printer leaves a 5 mm margin between the edges of your image and the edges of the paper (increased to 17 mm at the foot of cut-sheet paper). However, you can change this behavior in several ways.

- **In the Windows driver dialog**: select the **Paper/Quality** tab and then the **Margins/Layout** button.
- **In the Mac OS Print dialog (T2300)**: select the **Margins/Layout** panel.
- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS)**: select the **Margins/Layout** panel.
- **In the Mac OS X 10.4 PostScript Print dialog (T2300 PS)**: select the **Finishing** panel and then **Layout**.
- **On the Embedded Web Server’s Submit Job page**: select **Advanced settings > Paper > Layout/Margins**.

You will then see at least some of the following options.

**NOTE:** Under Mac OS, the available margins options depend on the paper size selected. For instance, for borderless printing you must select a paper size name that includes the words “no margins”.

- **Standard**. Your image will be printed on a page of the size you have selected, with a narrow margin between the edges of the image and the edges of the paper. The image should be small enough to fit between the margins.
- **Oversize**. Your image will be printed on a page slightly larger than the size you have selected. If you cut off the margins, you will be left with a page of the size you selected, with no margins remaining between your image and the edges of the paper.
- **Clip Contents By Margins**. Your image will be printed on a page of the size you have selected, with a narrow margin between the edges of the image and the edges of the paper. In this case, if the image is the same size as the page, the printer assumes that the extreme edges of the image are either white or unimportant, and do not need to be printed. This may be useful when your image already contains a border.
- **Borderless**. Your image will be printed on a page of the size you have selected, with no margins. The image is slightly enlarged to ensure that no margin is left between the edges of the image and the edges of the paper. If you select **Automatically by Printer**, this enlargement is done automatically. If you select **Manually in Application**, you must select a custom page size slightly larger than the page on which you intend to print. See also Print with no margins on page 74.

Print on loaded paper

To print a job on whichever paper is loaded in the printer, select **Any** in the Paper Type option of your printer driver.

- **In the Windows driver dialog**: select the **Paper/Quality** tab, then select **Any** in the Paper Type drop-down list.
- **In the Mac OS Print dialog (T2300)**: select the **Paper/Quality** panel, then select **Any** in the Paper Type drop-down list.
In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): select the Paper/Quality panel, then select Any in the Paper Type drop-down list.

In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): select the Image Quality panel, then select Any in the Paper Type drop-down list.

**NOTE:** Any is the default Paper Type selection.

### Rescale a print

You can send an image to the printer at a certain size but tell the printer to rescale it to a different size (normally larger). This may be useful:

- If your software does not support large formats
- If your file is too large for the printer’s memory—in this case, you can reduce the paper size in your software and then scale it up again using the front-panel option

You can rescale an image in the following ways:

- **In the Windows driver dialog:** go to the Features tab and look at the Resizing Options section.
  - The Print document on option adjusts the image size to the paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size. This option avoids clipping, but does not guarantee to maintain the original proportions of the image.
  - The % of actual size option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size. This option maintains the original proportions of the image, but does not guarantee to avoid clipping.

- **In the Mac OS Print dialog (T2300):** select the Paper Handling panel, then Scale to fit paper size, and select the paper size to which you want to scale the image. If you want to increase the size of the image, make sure that the Scale down only box is unchecked.

- **In the Mac OS Print dialog (T2300 PS):** select the Finishing panel, then Print document on, and select the paper size to which you want to scale the image. For example, if you have selected ISO A2 as the paper size and you print an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size is selected, the printer reduces a larger image to fit the A4 size.

- **On the Embedded Web Server’s Submit Job page:** select Advanced settings > Resizing.
  - The Standard and Custom options adjust the image size to the standard or custom paper size you have selected. For example, if you have selected ISO A2 as the paper size and you print an A4-size image, it is enlarged to fit the A2 paper. If the ISO A3 paper size is selected, the printer reduces a larger image to fit the A3 size.
  - The % of actual size option enlarges the printable area of the original paper size (the page minus the margins) by the percentage indicated, then adds the margins to create the output paper size.

- **Using the front panel:** press , then , then Setup > Printing preferences > Paper options > Resize.
If you are printing to a single sheet, you must ensure that the image can actually fit onto the sheet, otherwise the image will be clipped.

Change the treatment of overlapping lines

**NOTE:** This topic applies only when printing an HP-GL/2 job.

The merge option controls the overlapping lines in an image. There are two settings:

- Off: where the lines cross, only the color of the top line is printed. This is the default setting.
- On: where the lines cross, the colors of the two lines merge.

To turn merge on, go to the front panel and press [Setup > Printing preferences > HP-GL/2 options > Enable merge]. You can set the merge option from your software in some applications. Settings in your software override the front-panel settings.

Preview a print

Previewing a print on the screen allows you to check the layout of the print before printing, which may help you to avoid wasting paper and ink on a bad print.

- To preview a print under Windows, you have the following options:
  - Use your application’s print preview option.
  - Check the **Show preview before printing** option, which you can find in the driver’s **Printing Shortcuts** tab, **Paper/Quality** tab and **Features** tab. The preview may be provided in different ways, depending on your printer and printer driver.

- To preview a print under Mac OS, you have the following options:
  - Use your application’s print preview option.
  - Click the **Preview** button at the bottom of the Print dialog box. This is the basic print preview provided by Mac OS.
  - If you are using the PostScript printer driver, check the **Show print preview** option, which you can find in the driver’s **Printing** dialog, in the **Finishing** panel. This preview is provided by the Embedded Web Server and will appear in a Web browser window.

  **NOTE:** This option does not work if the product is connected by USB cable to a different computer (printer sharing).

  - If you are using the PCL driver, check the **Show print preview** option, which you can find in the driver’s **Printing** dialog, in the **Finishing** panel. This provides a preview with more features, such as the ability to change paper size, paper type and print quality, and to rotate the image.

  **NOTE:** This option does not work if the product is connected by USB cable to a different computer (printer sharing).

- To preview a print using the Embedded Web Server, select **Basic settings > Hold for preview**.
Print a draft

You can specify fast draft-quality printing in the following ways:

- **In the Windows driver dialog:** go to the **Paper/Quality** tab and look at the Print Quality section. Move the print-quality slider to the extreme left (‘Speed’).

- **In the Mac OS Print dialog (T2300):** go to the **Paper/Quality** panel and move the print-quality slider to the extreme left (‘Speed’).

- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS):** go to the **Paper/Quality** panel and move the print-quality slider to the extreme left (‘Speed’).

- **In the Mac OS X 10.4 PostScript Print dialog (T2300 PS):** go to the **Image Quality** panel and move the print-quality slider to the extreme left (‘Speed’).

- **On the Embedded Web Server’s Submit Job page:** select **Basic settings > Print quality > Standard options > Speed**.

- **Using the front panel:** press 🌡️, then 🤖, then Setup > Printing preferences > Print quality > Select quality level > Fast.

You can specify even faster draft-quality printing by using Economode, as follows. This is intended mainly for documents containing only text and line drawings.

- **In the Windows driver dialog:** go to the **Paper/Quality** tab and look at the Print Quality section. Select **Custom Options**, then set the quality level to **Fast** and check the **Economode** box.

- **In the Mac OS Print dialog (T2300):** go to the **Paper/Quality** panel and set the quality options to **Custom**, then set quality to **Fast** and check the **Economode** box.

- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS):** go to the **Paper/Quality** panel and set the quality options to **Custom**, then set quality to **Fast** and check the **Economode** box.

- **In the Mac OS X 10.4 PostScript Print dialog (T2300 PS):** go to the **Image Quality** panel and set the quality options to **Custom**, then set quality to **Fast** and check the **Economode** box.

- **On the Embedded Web Server’s Submit Job page:** select **Basic settings > Print quality > Custom. Set Quality level to Fast, and Economode to On**.

- **Using the front panel:** press 🌡️, then 🤖, then Setup > Printing preferences > Print quality > Enable economode.

**NOTE:** If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

High-quality printing

You can specify high-quality printing in the following ways:

- **In the Windows driver dialog:** go to the **Paper/Quality** tab and look at the Print Quality section. Move the print-quality slider to the extreme right (‘Quality’).

- **In the Mac OS Print dialog (T2300):** go to the **Paper/Quality** panel and move the print-quality slider to the extreme right (‘Quality’).
• In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): go to the Paper/Quality panel and move the print-quality slider to the extreme right ('Quality').

• In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): go to the Image Quality panel and move the print-quality slider to the extreme right ('Quality').

• On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Standard options > Quality.

• Using the front panel: press \ then \ then Setup > Printing preferences > Print quality > Select quality level > Best.

**NOTE:** If the print quality is set from your computer, it overrides the print-quality setting in the front panel.

**If you have a high-resolution image**

If your image has a resolution greater than the rendering resolution (which you can see in the Custom Print Quality Options box under Windows), print sharpness may be improved by selecting the Maximum Detail option. This option is available only if you are printing on glossy paper and you have selected Best print quality.

• In the driver dialog (Mac OS Print dialog): select Custom instead of Standard print-quality options, then check the Maximum Detail box.

• On the Embedded Web Server's Submit Job page: select Basic settings > Print quality > Custom. Set Quality level to Best, and Maximum detail to On.

• Using the front panel: press \ then \ then Setup > Printing preferences > Print quality > Enable maximum detail.

**NOTE:** The Maximum Detail option results in slower printing with photo papers, but it does not increase the amount of ink used.

**Print in gray shades**

You can convert all colors in your image to shades of gray in the following ways:

• In your application program: many programs provide this option.

• In the Windows driver dialog: go to the Color tab and look at the Color Options section. Select Print in Grayscale. You can also select Print in pure black and white if you want only black and white, without gray shades.

• In the Mac OS Print dialog (T2300): go to the Color Options panel and select Grayscale from the Mode drop-down list. You can also select Pure Black and White if you want only black and white, without gray shades.

• In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS): go to the Color Options panel and select Grayscale from the Mode drop-down list. You can also select Pure Black and White if you want only black and white, without gray shades.
In the Mac OS X 10.4 PostScript Print dialog (T2300 PS): go to the Color Options panel and select Print In Grayscale. You can also select Print in Pure Black and White if you want only black and white, without gray shades.

On the Embedded Web Server's Submit Job page: select Color, then set Color/Grayscale to Print In Grayscale. You can also select Pure Black and White if you want only black and white, without gray shades.

Print with no margins

Printing with no margins (to the edges of the paper) is known as borderless printing. This can be done only on rolls of glossy paper.

In order to be sure of leaving no margins, the printer prints slightly past the edges of the paper. Any ink deposited outside the paper is absorbed by the sponge situated in the platen.

You can request printing with no margins in the following ways:

- **In the Windows driver dialog:** select the Paper/Quality tab and press the Margins/Layout button. Then select Borderless.

- **In the Mac OS Page Setup dialog (T2300):** select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

**NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

- **In the Mac OS X 10.5 or 10.6 PostScript Page Setup dialog (T2300 PS):** select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Margins/Layout > Borderless.

**NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

- **In the Mac OS X 10.4 PostScript Page Setup dialog (T2300 PS):** select a paper size name that includes the words “no margins”. Then, in the Print dialog, select Finishing > Layout > Borderless.

**NOTE:** If your application offers no Page Setup dialog, please use the Print dialog.

- **On the Embedded Web Server's Submit Job page:** select Advanced settings > Paper > Layout/Margins > Borderless.

When you select Borderless, you must also select one of the following Image Enlargement options:

- **Automatically by printer** means that the printer automatically enlarges your image slightly (normally by a few millimeters in each direction) in order to print over the edges of the paper.

- **Manually in application** means that you must enlarge the image yourself in your application, and select a custom paper size that is slightly larger than the actual paper size.

**NOTE:** If the first print job after loading paper is a borderless job, the printer may trim the leading edge of the paper before printing.

At the end of a borderless print, the printer normally cuts the print slightly inside the image area to ensure that the print is borderless. It then cuts the paper again so that no residual part of the image is included in the next print. However, if the job is cancelled, or if there is white space at the bottom of the image, only a single cut is made.
Print with crop lines

Crop lines indicate where the paper should be cut to reduce it to your selected page size. You can print crop lines with individual jobs in the following ways:

- **In the Windows driver dialog:** select the Features tab, then Crop lines.
- **In the Mac OS Print dialog:** select the Finishing panel, then Crop lines.
- **On the Embedded Web Server’s Submit Job page:** select Advanced settings > Roll options > Enable crop lines > Yes.

Alternatively, you can choose to print crop lines with all jobs by default:

- **In the Embedded Web Server:** select Setup > Printer settings > Job management > Use crop lines when printing > On.
- **Using the front panel:** press , then Setup > Printing preferences > Paper > Enable crop lines > On.

To print crop lines with nested jobs (see Nest jobs to save roll paper on page 75), you must select a different option:

- **In the Embedded Web Server:** select Setup > Printer settings > Job management > Use crop lines when nest is enabled > On.
- **Using the front panel:** press , then Setup > Job management > Nest options > Enable crop lines > On.

Use paper economically

Here are some recommendations for making economical use of paper:

- If you are printing relatively small images or document pages, you can use nesting to print them side by side instead of one after another. See Nest jobs to save roll paper on page 75.
- You may be able to save some roll paper by using the following options:
  - In the Windows driver dialog: select the Features tab and then Remove top/bottom blank areas and/or Rotate by 90 degrees. In the PostScript driver, you can also select Autorotate.
  - In the Mac OS Print dialog (T2300): select the Finishing panel, then Remove Top/Bottom Blank Areas.
  - In the Mac OS PostScript Print dialog (T2300 PS): select the Finishing panel, then Remove Top/Bottom Blank Areas and/or Autorotate.
  - On the Embedded Web Server’s Submit Job page: select Advanced settings > Roll options > Remove top/bottom blank areas and/or Rotate.
- If you check the print preview on your computer before printing, you can sometimes avoid wasting paper on prints containing obvious mistakes. See Preview a print on page 71.

Nest jobs to save roll paper

Nesting means automatically printing images or document pages side by side on the paper, rather than one after the other. This is done to avoid wasting paper.
1. Direction of paper flow
2. Nesting off
3. Nesting on
4. Paper saved by nesting

**When does the printer try to nest pages?**

When both of the following are true:

- The printer is loaded with roll paper, not sheet paper.
- The printer’s Nest option is not turned off. See Turn nesting on and off on page 38.

**What pages can be nested?**

All pages can be nested, unless they are so large that two of them cannot fit side by side on the roll, or unless there are too many of them to fit into the remaining length of the roll. A single group of nested pages cannot be split between two rolls.

**Which pages qualify for nesting?**

In order to be in the same nest, the individual pages must be compatible in all of the following ways:

- All pages must have the same print quality setting (Economode, Fast, Normal or Best).
- The Maximum Detail setting must be the same on all pages.
- The Layout/Margins setting must be the same for all pages.
- The Mirror Image setting must be the same for all pages.
- The Rendering Intent must be the same for all pages.
- The Cutter setting must be the same for all pages.
- The color adjustment settings must be the same for all pages. See Color adjustment options on page 108.
- Pages must be all color, or all grayscale: not some in color and some in grayscale.
All pages must be in one or other of the following two groups (the two groups cannot be mixed in the same nest):

- HP-GL/2, RTL, TIFF, JPEG
- PostScript, PDF

JPEG and TIFF pages with resolutions greater than 300 dpi may not nest with other pages in some cases.

How long does the printer wait for another file?

So that the printer can make the best nest possible, it waits after a file has been received to check whether a subsequent page will nest with it or with pages already in the queue. This waiting period is the nest wait time; the factory default nest wait time is two minutes. This means that the printer waits for up to two minutes after the last file is received before printing the final nest. You can change this waiting time from the printer’s front panel: press \[\text{Menu}\], then \[\text{Menu}\], then Setup > Job management options > Nest options > Select wait time. The available range is 1 to 99 minutes.

While the printer is waiting for nesting to time out, it displays the remaining time on the front panel.

Use ink economically

Here are some recommendations for making economical use of ink.

- For draft prints, use plain paper and move the print-quality slider to the left end of the scale (‘Speed’). For further economy, select custom print quality options, then select Fast and Economode.
- Clean the printheads only when needed, and clean only those printheads that need cleaning. Cleaning the printheads can be useful, but it uses a small amount of ink.
- Leave the product permanently turned on so that it can maintain the printheads in good condition automatically. This regular printhead maintenance uses a small amount of ink. However, if it is not done, the printer may need to use much more ink later to restore the health of the printheads.
- Wide prints make more efficient use of ink than narrow prints, because printhead maintenance uses some ink, and its frequency is related to the number of passes made by the printheads. Therefore, nesting jobs can save ink as well as saving paper (see Nest jobs to save roll paper on page 75).

Roll protection

If you choose to protect a roll, jobs will be printed on it only if the job explicitly specifies the roll number or the paper type loaded on the roll. This may be useful, for example, in the following cases.

- To stop people from accidentally printing unimportant jobs on expensive paper.
- To avoid printing on a particular roll when printing from AutoCAD without interacting with the HP printer driver.

To protect a roll, go to the front panel and press \[\text{Menu}\], then \[\text{Menu}\], then Setup > Printing preferences > Paper options > Roll protection.
NOTE: If you protect a roll, then later unload the current roll and load a new one, the new roll remains protected. You are protecting the roll number, not one specific roll of paper. That roll number will remain protected until you cancel the protection.

TIP: If you print without specifying a roll number or paper type, you will not be able to print on any protected roll.

Unattended printing/overnight printing

The printer is well suited to long, unattended print jobs, having multiple rolls plus robust and consistent image quality.

Here are some recommendations to help you deal with a long queue of printing jobs.

- If feasible, use brand-new long rolls of paper.
- If you want to print on partly-used rolls, you can check the paper type and the remaining length in the Embedded Web Server or in the front panel, to confirm that you have enough paper to print all your jobs.

NOTE: Information on the remaining length is available only if you told the printer the length of the roll when you loaded it, or if the printer read the length of the roll from the barcode printed on it.

- Load two rolls of paper suitable for your jobs. If the printer finishes one roll, it will automatically switch to the other.
- Check that you have paper wide enough to print all of your jobs. Any jobs that are too wide may be put “on hold for paper” if the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 37).
- Check the ink levels remaining in your ink cartridges.
- When you have submitted your print jobs, you can use the Embedded Web Server from a remote location to monitor their status.
- Drying time should be set to Optimal.
- Press , then , then Setup > Printing preferences > Paper options > Roll switching options > Minimize roll changes or Use roll with less paper.

We recommend the following settings, depending on the paper type and what kind of prints you are making.

Table 7-1  Recommended settings for unattended printing

<table>
<thead>
<tr>
<th>Print type</th>
<th>Print mode</th>
<th>MaxDetail</th>
<th>Drying time</th>
<th>Paper types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lines</td>
<td>Normal</td>
<td>Off</td>
<td>Optimal</td>
<td>Coated, Bond, Heavyweight Coated, Glossy</td>
</tr>
<tr>
<td>Lines and fills</td>
<td>Normal</td>
<td>On</td>
<td>Optimal</td>
<td>Coated, Bond, Heavyweight Coated, Glossy</td>
</tr>
<tr>
<td>Print type</td>
<td>Print mode</td>
<td>MaxDetail</td>
<td>Drying time</td>
<td>Paper types</td>
</tr>
<tr>
<td>-------------</td>
<td>------------</td>
<td>-----------</td>
<td>-------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Maps</td>
<td>Best</td>
<td>On</td>
<td>Optimal</td>
<td>Coated, Heavyweight Coated, Glossy</td>
</tr>
<tr>
<td>Renderings, photographs</td>
<td>Best</td>
<td>On</td>
<td>Optimal</td>
<td>Coated, Heavyweight Coated, Glossy</td>
</tr>
</tbody>
</table>
Paper types suitable for scanning

The scanner does not support the full range of paper types that may be used by the printer.

The following paper types are supported by the scanner.

- **White paper** to scan any matte original printed with inkjet technology. Choose this option to scan, for instance, anything printed with this product on any of these paper types: HP Universal Inkjet Bond Paper, HP Coated Paper, HP Heavyweight Coated Paper, plain paper.

- **Photo paper** to scan glossy and satin originals. Inkjet, offset and traditional photo technologies are supported by this option. Choose this option to scan, for instance, any photo or other image printed on any of these paper types: HP Universal High Gloss Photo Paper, HP Premium Instant Dry Gloss/Satin Photo Paper. However, for some specific photo originals, this option may not give completely accurate results, in which case you could try **White paper** instead.

⚠️ **CAUTION:** Photo and glossy papers may be scratched while passing through the scanner.

- **Old/recycled paper** to scan matte originals printed on recycled paper or very old originals, the background of which is no longer white. Choose this option to scan, for instance, anything printed on this product using HP Recycled Bond Paper, or any old print on plain paper that has become yellowish over the years.

- **Translucent paper** to scan semi-transparent tracing papers (> 65 g/m²), including HP Natural Tracing Paper, HP Vellum and HP Translucent Bond.

- **Blueprints** for scanning blueprint originals with optimum results, in grayscale only. This option greatly enhances the contrast of the resulting image.

For best results, you should select the correct paper type in the scan settings before scanning.

The following paper types are not supported by the scanner.

- Film
- Backlit material
- Cling material
- Translucent paper (< 65 g/m²)
Scan to file

1. Load the sheet with the printed side facing upwards (you can also load the sheet before step 1, if you prefer). Align the center of the sheet approximately with the center of the scanner. Use the standard size markings to help you.

NOTE: The scanner can scan a maximum length of 2378 mm (93.62 in). A longer sheet than this can be moved through the scanner, but only the first 2378 mm (93.62 in) will be scanned. An alert is displayed if the maximum length is exceeded.

NOTE: Scanned images may be saved to PDF files with the T2300 PS only.

2. Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will automatically grab the sheet and move it into position for scanning. You can press to eject the sheet if you feel that it has loaded badly and you want to try again.

3. At the front panel, go to the home screen and press then select where you would like to store the scanned image.

   ● In a USB flash drive

   NOTE: The use of USB flash drives with your product may be disabled in the Embedded Web Server (Setup > Security > Disable USB drives).

   ● In a network folder (a folder on a computer that is accessible through the network)

   NOTE: The network folder option will not work unless the network folder has been correctly set up and identified in the Embedded Web Server or HP Utility: see Create a scan-to-network folder on page 30.

   TIP: To check the currently-configured network folder, go to the front panel and press then

   NOTE: If the scanner is later unable to store your file in the chosen destination (USB flash drive or network folder), you are given the opportunity to change your mind and use the other alternative.
4. Some of the default scan settings are displayed. Press **Settings** to see the complete list of settings, and check in particular that the **Paper type** setting corresponds to the paper type that you intend to scan.

- **Format** allows you to specify the format of the file in which the scanned image will be saved: TIFF, JPEG or (with the T2300 PS only) PDF.
- **Quality** allows you to specify the scan resolution: Standard (200 dpi), High (300 dpi), or Max (600 dpi).
- **Color** allows you to choose color, grayscale or black and white scanning.
- **Content type** allows you to optimize the scan for a line drawing, a photographic image, or a mixed image.
- **Original type** allows you to specify the paper type on which the original image has been printed. To optimize scan quality, ensure that this setting is correct.
- **Background removal** allows you to remove unwanted background color. You can specify the strength of this setting, from 0 to 10.

**NOTE:** If you change the settings in this way, the changed settings apply to the current job but are not saved permanently. You can change most of the default settings from the main menu: press then **Scan preferences**.

5. When you are satisfied with the scan settings, press anywhere on the screen to return to the previous page, then press **Start**.

6. The filename of the scanned image is generated automatically; it is guaranteed not to overwrite an existing file.

7. If you are scanning to a USB flash drive, wait until the scanned image has been saved in a file, then press on the front panel and press **Eject**. Remove the USB flash drive when prompted by the front panel.

8. Press to eject the scanned sheet from the scanner; be ready to pick it up.

9. After scanning, you can choose to scan again or go to the job queue.

**TIP:** All scan jobs are saved in the scan queue, where they can be accessed by any user. If your job is private, you may wish to delete it from the queue after recovering the image file.

**TIP:** If you scan an image to a file and then decide to print it one or more times, you can change the print settings every time. You can also save it to another location.

**NOTE:** By default, if the original is skewed in the scanner (not loaded straight), the scanner will try to correct the skew automatically. To turn off this automatic correction, press then then **Scan preferences > De-skew > Off**.
9 Copying

Before starting to copy, see Paper types suitable for scanning on page 80.

1. Load the sheet with the printed side facing upwards (you can also load the sheet before step 1, if you prefer). Align the center of the sheet approximately with the center of the scanner. Use the standard size markings to help you.

   ![Loading sheet](image)

   **NOTE:** The scanner can scan a maximum length of 2378 mm (93.62 in). A longer sheet than this can be moved through the scanner, but only the first 2378 mm (93.62 in) will be scanned. An alert is displayed if the maximum length is exceeded.

2. Push the sheet into the insertion slot until you feel it contact the rollers. The scanner will automatically grab the sheet and move it into position for scanning. You can press the eject button to eject the sheet if you feel that it has loaded badly and you want to try again.

3. At the front panel, go to the home screen and press the settings button.

4. Some of the default copy settings are displayed. Press Settings to see the complete list of settings, and check in particular that the Paper type setting corresponds to the paper type that you intend to scan.

   - **Size** allows you to resize the print in two different ways: to a percentage of its original size, or to fit a particular paper size. The default is 100% (its original size).
   - **Copy quality** allows you to set the print quality to Best, Normal or Fast.
   - **Copy color** allows you to choose color or grayscale printing.
   - **Roll** allows you to specify printing on roll 1 or roll 2, or you can choose Save paper, which automatically chooses the narrowest roll on which the print will fit.
● **Content type** allows you to optimize the scan for a line drawing, a photographic image, or a mixed image.

● **Original type** allows you to specify the paper type on which the original image has been printed. To optimize scan quality, ensure that this setting is correct.

**NOTE:** If you change the settings in this way, the changed settings apply to the current job but are not saved permanently. You can change the default settings from the main menu: press then then **Copy preferences**.

5. When you are satisfied with the copy settings, press anywhere on the screen to return to the previous page, then press **Start**.

6. If two rolls are loaded, you can choose to print on either roll, or you can let the printer choose automatically.

**NOTE:** The printer will automatically rotate the image by 90° if it can save paper by doing so.

7. When the scan is complete, press to eject the scanned sheet from the scanner; be ready to pick it up.

8. While the scanned image is being printed, you can perform some other operation: you don’t need to wait for the end of the print.

9. After printing, you can choose to make another copy or go to the job queue. If you make another copy immediately without returning to the home screen, the temporary settings used for the previous copy are used again.

**NOTE:** By default, if the original is skewed in the scanner (not loaded straight), the scanner will try to correct the skew automatically. To turn off this automatic correction, press then then **Scan preferences > De-skew > Off**.
10 Web-connected printing and scanning

Your product can be connected to the Web, providing various benefits:

- Automatic firmware updates (see Update the firmware on page 162)
- Print on HP ePrinters from almost anywhere
- Print on HP ePrinters from almost any device, including smartphones, tablets, and laptops
- Scan directly to an email address anywhere

For the latest information, see http://www.hp.com/go/designjetprinters.

Print remotely with HP Designjet ePrint & Share

If you are working from home, and you want to print to your office printer, you can print using HP Designjet ePrint & Share.

1. From your application, send the file to print, selecting your printer.
2. As you are not locally connected to the printer, a dialog appears asking you if you are trying to print locally or remotely through the cloud.
3. Select the option Print remotely through the cloud and sign in to your account.
4. If you already set up the printer, it will appear in the list. Otherwise, you will need to add the printer’s email address.
5. After selecting the printer, select Continue. The driver dialog appears, in which you can select print settings.

**NOTE:** When printing remotely, no print preview is available.

6. Click Print, and your document is sent to print on your Web-connected printer.

Print by email

After you have enabled Web Services, you can print to your printer by email. Just check the Web Services menu or the ePrint menu for the email address of your printer, then send the file you want to print to that email address as an attachment.
In this way, you can print from anywhere with an Internet connection, without needing any printer driver. There are a few limitations that you should bear in mind:

- The attached files to be printed must be in PDF, JPEG, or TIFF formats.
- The maximum file size is 10 MB, but your email server may have a lower limit.
- Files are printed in the original document size (at 100% scale), in normal quality, in color, and normally in portrait orientation (some printers may offer autorotation).

**Print from a smartphone or tablet**

The HP Designjet ePrint & Share apps enable you to access files on your mobile device or in HP Designjet ePrint & Share and print them to an HP Designjet Web-connected printer. You can obtain these apps from the following sources:

- [http://www.hp.com/go/designjeteprinters](http://www.hp.com/go/designjeteprinters)
- Your smartphone’s application storefront

For the latest information, see [http://www.hp.com/go/eprintandshare](http://www.hp.com/go/eprintandshare).

You can use your 3G connection to print. You do not need to be connected with the printer by wifi, and you do not need a printer driver.

1. Select the files to print from your Online Print History or from any other location connected to your HP Designjet ePrint & Share account.

2. An image of your print is displayed. On some devices, you can zoom in and out.

   **NOTE:** The orientation of the preview (portrait/landscape) may not be the same as the orientation of the print.
3. To print the file, press the button.

4. Select the printer if it is already listed; or, if necessary, press **Add a printer** and give your printer's email address to add it to the list.

5. Choose the print settings, then press **Print**.

*NOTE:* Printing may not start immediately.

Whenever you print a document with HP Designjet ePrint & Share, it is saved in your Online Print History.

From other applications, when there is an ‘Open In’ option available, select ePrint & Share in order to print your documents on a Web-connected HP Designjet printer.

---

**View and print from the HP Designjet ePrint & Share website**

1. Go to [http://www.hp.com/go/eprintandshare](http://www.hp.com/go/eprintandshare) and log in to your account.
2. To view and print a file, select the category to filter your list of saved files (printed, scanned, shared with me, or all). You will see a list of your files ordered by time. The file can be identified by the name, the date and time of printing, the printer that was used, and the thumbnail.

![Print & Share interface](image)

3. Select the file, and a file preview is shown in the right panel. If the file contains multiple pages, you can navigate through the pages using the arrows. You can also click the preview to enlarge it, and zoom in to see details.

4. Press the **Print** button.

5. If you have the full HP Designjet software suite installed, a print-preview dialog appears, in which you can check and modify some settings and select your local or remote eprinters.

   If you do not have the software installed on the computer you are using, you will see a generic screen that allows you to select the remote printer and change basic settings.

6. Press the **Print** button again to send your document to print.

   To print on any printer, use the option **Print to .PDF**. This creates a copy of your document in your computer, which you can print later.
Print from HP Designjet ePrint & Share using the product’s front panel

HP Designjet ePrint & Share allows you to print files on any Web-connected printer, when you want. You don’t need a computer: you can use the product’s front panel.

1. At the front panel, press the Print icon.

   ![Print icon]

2. Press the HP ePrint & Share icon.

   ![Select source]

3. Sign in using your registered email address and password.

   ![Sign in to HP ePrint&Share]
4. Press the white Email address field to enter your email address. A keyboard is displayed so that you can enter the letters. Press OK when you have finished; then enter your password in the same way.

![Email address keyboard](image)

5. Select an event category by pressing its name. You can select All events, all Printed events, all Scanned events, all Shared events, all events Shared by you or all events Shared by others.

![Select an event category](image)

6. Select a particular event by pressing the event name. The number of files associated with each event is shown on the right.

7. Select a file from the event by pressing the file name.

8. The default print settings are displayed, and you can change them by pressing the Settings button. The number of copies can be changed by pressing the up or down arrows.

![Print settings](image)

9. When you are ready to print, press the Start button.
10. After sending one file to print, you can press the Add more icon to select another file. Alternatively, press the Sign out icon to return to the home screen, or the Job queue icon to go to the job queue.

**NOTE:** If you press Sign out or $\text{Sign out}$, your HP Designjet ePrint & Share session is closed and you will need to sign in to access it again.

## Scan to an email address

You can scan documents directly to any email address through HP Designjet ePrint & Share. Every scan you send is also copied to your Online Print History.

1. Press the Scan icon on the front panel's home screen.

2. Press the HP ePrint & Share icon.
3. Sign in using your registered email address and password.

4. Press the white Email address field to enter your email address. A keyboard is displayed so that you can enter the letters. Press OK when you have finished; then enter your password in the same way.

5. The default scan settings are displayed, and you can change them by pressing the Settings button.

**NOTE:** You can change the default settings from the front panel.

6. When you are ready to scan, press the Start button.
7. If you have not already done so, feed the document into the scanner as shown, centered and facing up.

![Please feed the original into the scanner centered and facing up](image)

8. When the scan is complete, the scan results are displayed. You can press the event name or the file name to change it; you can press the magnifying glass icon to preview the scan.

**NOTE:** The file name must end with `.pdf`.

If all is well and the scanned file is within your quota, press the **Next** button to continue. If the file exceeds your quota, or if the preview looks wrong, you can press **Scan again** to change the scan settings and try again.

![Scan details](image)

9. In the next screen, you can choose to share the scan with any of your contacts. You can also add new contacts. Press the **Send** button when ready.

**NOTE:** Your own email address is always selected by default.

**NOTE:** If you add a new contact who does not have an HP Designjet ePrint & Share account, the contact will receive an email invitation to open an account.

![Share file with](image)
10. After adding one document to the scan queue, you can press the **Make another scan** icon to scan another document. Alternatively, press the **Sign out** icon to return to the home screen, or the **Scan queue** icon to go to the scan job queue.

**NOTE:** If you press **Sign out** or ![Sign out icon](image), your HP Designjet ePrint & Share session is closed and you will need to sign in to access it again.

11. The scanned document will be available in the Scanned event that was named in the Scan details screen, and you can later print it or share it with other people.

### View and print from other content repositories

You may be able to connect your HP Designjet ePrint & Share account to other content repositories, such as FTP sites, in which case you can use HP Designjet ePrint & Share to print directly from those repositories.

### Create your Online Print History

Documents are automatically added to your Online Print History in each of the following cases:

- Whenever you print using the HP Designjet ePrint & Share driver, and you are logged into HP Designjet ePrint & Share.
- Whenever you print from the front panel using HP Designjet ePrint & Share.
- Whenever you scan from the front panel using HP Designjet ePrint & Share.
- Whenever you print from the mobile app on your smartphone or tablet.
- Whenever you print from an FTP site using HP Designjet ePrint & Share or the mobile app.

### Share files in your Online Print History

You can share any of the files in your Online Print History with your colleagues. For further information, see [http://www.hp.com/go/eprintandshare](http://www.hp.com/go/eprintandshare).

### HP Designjet ePrint & Share security

When you add new content to your Online Print History (by printing), only you will have access to that content; but, whenever you choose to share a file, which you do by sharing a special link with your colleague, anyone who has that link and an HP Designjet ePrint & Share account can access your file.

The access control mechanism is on a file-by-file basis, meaning that if you share something with someone, that person will have access only to the content of that specific shared file.

You can also unshare a file at any time, in which case the link will no longer work, and no-one will be able to see the file any more.

**NOTE:** Anyone who has printed the file will still have it in his or her online print history.

HP support personnel have special account privileges to help in troubleshooting any issue you may have, but they cannot download any of your files.
As part of the normal service operation, HP performs regular backups of your data. These backups are an automated process with only the software processes themselves having access to your data.

HP Designjet ePrint & Share is hosted in a first-class data center. Physical access to these premises is strictly controlled and restricted. Only employees who have a legitimate business need can access the data center.

All the computers hosting the HP Designjet ePrint & Share service are protected by a multi-tiered firewall, all the systems are constantly monitored, and intrusion detection tests are run periodically.

The servers on which your files are stored have additional levels of security and isolation, both physical and logical, even from other services hosted in the same premises.

HP takes security and data privacy very seriously. HP will not sell, rent, or lease your personal information to others.

You retain full ownership, and any intellectual property rights you may have, to the files you upload to HP Designjet ePrint & Share. By providing the service, HP does not obtain any special ownership or rights to these files.

In order for HP to be legally capable of making backups of your data and performing certain actions (generate a preview, etc.), you grant to HP the right to use the files, solely for the purposes of providing the HP Designjet ePrint & Share service.

Before you log off from your computer, check that all pending uploads to your Online History have been submitted or cancelled. Otherwise, they could be uploaded by another user of the same computer.

For the latest information, see http://www.hp.com/go/eprintandshare.
11 Job queue management

- Introduction
- The job queues in the front panel
- The print job queue in the Embedded Web Server or HP Utility
Introduction

You can manage your product's job queues from the front panel, the Embedded Web Server or the HP Utility.

- To use the front panel, you must be standing in front of the product. The front panel gives access to both of the job queues: the Print & Copy jobs, and the Scan jobs.

- You can use the Embedded Web Server or the HP Utility from any remote computer with network access to the product, but you can access only the Print & Copy jobs. The Scan jobs can be accessed only from the front panel.

The job queues in the front panel

To see the job queues on the front panel, press on the home screen. You can choose Print & Copy Jobs or Scan Jobs from the tabs at the top of the screen.

Job queue page

The job queue page shows all jobs that are available in whichever job queue you have selected. The print & copy queue includes jobs that are being received, parsed, rendered, printed and already printed. The scan queue includes jobs that are being scanned and jobs that have been scanned.

Each line shows the name of the job and its status. Scan and copy jobs are assigned automatically-generated names. For more information on a particular job, including a preview of the job, press the line showing the job.

Jobs that cannot be completed for any reason appear at the top of the queue.

Job preview

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job preview is available once the job is processed.

**NOTE:** Do not try to preview a job with more than 64 pages, which may cause software problems.

To preview a job, first press the name of the job in the job queue. The front panel displays a page of information about the job. Then press to see the preview.

**NOTE:** Previews may be blocked by an administrator, in which case you will not be able to see them.

When the preview is displayed, you can press it to zoom in on it. Press it again to zoom out.

You can also press to preview the previous job, or to preview the next job.

Select when to print a job in the queue

**NOTE:** The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Press then Setup > Job management options > When to start printing.
There are three options you can select:

- **When After Processing** is selected, the printer waits until the whole page has been processed and then it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.
- **When Immediately** is selected, the printer prints the page as it is processed. This is the quickest setting, but the printer may stop halfway through a print to process data. This setting is not recommended for complex images with dense color.
- **When Optimized** is selected (this is the default setting), the printer calculates the best time to begin printing the page. It is usually the best compromise between the After Processing and Immediately settings.

**Prioritize a job in the queue**

You can select a job in the queue and make it the next one to be printed. After selecting the job, press **Move to front**.

If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as described above.

In the following cases, the **Move to front** button is not displayed:

- The job is already at the front of the queue.
- The job is on hold—in this case the **Resume printing** button is displayed instead.
- The job has finished—in this case the **Reprint** button is displayed instead.
- The job has some error condition.

**Pause a job in the queue**

If you select the job in the queue that is currently printing, you will see a **Pause** button, which you can press to pause printing. The **Pause** button then changes to a **Resume** button, which you can press to resume printing.

Alternatively, you can press the **Options** button at the top right of the job queue screen, and then press **Pause printing**.

**Reprint a job from the queue**

To reprint an already-printed job, select the job from the queue, then select **Reprint**.

When reprinting a print job, you cannot change the print settings, because the job has already been rasterized. However, you can also print a scanned job from the scan queue, and in this case you can change the print settings.

**Delete a job from the queue**

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it, you can simply select the job and then press **Delete**.
An administrator password may be required.

In the same way, you can delete a job that has not been printed yet. If the job is currently being printed (its status is printing), you can press Cancel and then Delete.

**Delete all jobs**

To delete all jobs in a queue, press the Options button at the top right of the job queue screen, and then press Delete all Print & Copy jobs or Delete all Scan jobs.

An administrator password may be required.

**Turn off the job queue**

To turn off the job queue, press 

Setup > Job management options >

Enable queue > Off.
The print job queue in the Embedded Web Server or HP Utility

The HP Utility provides a different way of accessing the Embedded Web Server’s job management facilities, but the facilities are exactly the same whether you use the Embedded Web Server or the HP Utility.

To see the print queue in the Embedded Web Server, select Job queue in the Main tab.

Job queue page

By default, access to the job queue is open to all users. An administrator can set a password so that users are required to enter a password for:

- Seeing job previews
- Canceling or deleting jobs

The job queue page shows all jobs that are available in the print queue. The print queue includes jobs that are being received, parsed, rendered, printed and already printed.

The Embedded Web Server displays the following information for each print job:

- **Preview**: Click the icon to see the job preview. The job preview is available once the job is processed.
- **File name**: Click the file name to see the properties of the job.
- **Status**: Gives the current job status.
- **Pages**: Number of pages in the job.
- **Copies**: Number of copies printed.
- **Date**: Date and time the product received the job.
- **User**: The user’s name.

Jobs in the queue can be sorted by any of the information items (except Preview) by clicking on the title of the corresponding column. You can perform the following operations on one or all jobs in the queue:

- **Cancel**: Cancels the selected jobs. You are asked to confirm before the job is canceled. The job remains stored in the product, but will not be printed unless you click Reprint.
- **Hold**: Holds the select jobs until you click Continue to print.
- **Continue**: All selected jobs, which are on hold, continue printing.
- **Reprint**: Prints more copies of a job. Type the number of copies (default 1, maximum 99) and click Print.
- **Move to front**: Sends all selected jobs to the top of the job queue.
- **Delete**: Deletes selected jobs from the job queue. You are asked to confirm before the job is deleted.
NOTE: The Delete operation can be disabled by an administrator.

- Refresh: Refreshes the page, ensuring the information is updated.

NOTE: The job queue page does not automatically update.

**Job preview**

The printer generates a JPEG file for each incoming job, which can be displayed as a preview of the job. Job preview is available once the job is processed.

NOTE: Do not try to preview a job with more than 64 pages, which may cause software problems.

To reach the preview page, click the magnifying glass icon, which appears in the Preview column on the job queue page. The preview page shows the following job details along with a thumbnail preview of the job:

- **File name**: The file name of the job.
- **Loaded paper**: The type of paper loaded in the printer.
- **Job dimensions**: The dimensions of the job.

To see a larger preview of the job, click either the job thumbnail or the magnifying glass icon, which appears on the right hand side of the printer image.

NOTE: Browsers without the Adobe Flash plug-in show the job image as yellow shaded. Browsers that have the Adobe Flash plug-in version 7 and above show an enhanced preview of the job image inside the paper loaded in the printer.

**Select when to print a job in the queue**

NOTE: The When To Start Printing options cannot be used with PostScript jobs.

You can select at what point you want to print a file you have in the queue. Select the Setup tab, then Printer settings > Start printing.

There are three options you can select:

- **When After Processing** is selected, the printer waits until the whole page has been processed and then it starts to print. This is the slowest setting but ensures the best print quality in large or complex prints.

- **When Immediately** is selected, the printer prints the page as it is processed. This is the quickest setting, but the printer may stop halfway through a print to process data. This setting is not recommended for complex images with dense color.

- **When Optimized** is selected (this is the default setting), the printer calculates the best time to begin printing the page. It is usually the best compromise between the After Processing and Immediately settings.

**Prioritize a job in the queue**

You can select any job in the queue and make it the next one to be printed. After selecting the job, click Reprint.
If nesting is turned on, the prioritized job may still be nested with others. If you really want this job to be printed next, and not nested with others, first turn nesting off and then move it to the front of the queue as described above.

Delete a job from the queue

Under normal circumstances, there is no need to delete a job from the queue after printing it, as it will just fall off the end of the queue as more files are sent. However, if you have sent a file in error, and want to avoid printing it, you can simply select the job and then select Delete.

In the same way, you can delete a job that has not been printed yet.

If the job is currently being printed (its status is printing), you can select Cancel and then Delete.

Reprint or copy a job in the queue

To reprint or make extra copies of any job in the queue, select the job in the Embedded Web Server and click the Reprint icon, then specify the number of copies you want. The job will be moved to the top of the queue. To make more than one print of a non-printed job in the queue from the front panel, select the job and choose Copies, then specify the number of copies required. This overrides any value set by your software.

**NOTE:** If Rotate was On when you sent the file, every copy will be rotated.

**NOTE:** You cannot use this method for PCL3GUI jobs. To reprint old jobs that are PCL3GUI, you may be able to use your operating system’s printer spooler, if you have already set the spooler to save old jobs. This facility depends on your operating system.

**NOTE:** When reprinting a print job, you cannot change the print settings, because the job has already been rasterized.

Job status messages

These are the possible job status messages, approximately in the order in which they may be seen:

- **Receiving:** the printer is receiving the job from the computer
- **Waiting to process:** the job has been received by the printer and is waiting to be rendered (for jobs submitted through the Embedded Web Server only)
- **Processing:** the printer is parsing and rendering the job
- **Preparing to print:** the printer is performing writing system checks before printing the job
- **Waiting to print:** the job is waiting for the print engine to become free to proceed with printing
- **Waiting for nest:** the printer is set up with Nesting=On and is waiting for other jobs in order to complete the nest and proceed with printing
- **On hold:** the job was sent with the on hold for preview option and is on hold

**NOTE:** Do not send a job for preview with more than 64 pages, this may cause the driver software to crash.

**NOTE:** If the printer hangs up while printing a job, and the queue facility is turned on, the partially printed job will appear in the queue as on hold when the printer is next turned on. When you resume the job, it will start printing at the page at which it was interrupted.
- **On hold for paper**: the job can’t be printed because the right paper is not loaded in the printer. Load the required paper, see Printer paper handling on page 48, and click Continue to resume the job.

- **On hold for accounting**: the job can’t be printed because the printer requires all jobs to have an account ID: enter the account ID and then click Continue to resume the job.

  **TIP:** To set an account ID, see Require account ID on page 40.

- **Printing**
- **Drying**
- **Cutting paper**
- **Ejecting page**
- **Canceling**: the job is being canceled, but will remain in the printer job queue
- **Deleting**: the job is being deleted from the printer
- **Printed**
- **Canceled**: the job has been canceled by the printer
- **Canceled by user**
- **Empty job**: the job does not contain anything to print

### Reactivate a job on hold

When the printer puts a job on hold you receive an alert, see Alerts on page 202, which explains why the job is on hold. Follow the instructions on the screen to remove the hold and continue printing.

### Turn off the job queue

To turn off the job queue, select the Setup tab, then Printer settings > Job management > Queue and select Off.
12 Color management

- Introduction
- How colors are represented
- A summary of the color management process
- Color calibration
- Color management from printer drivers
- Color management from printer drivers (T2300 PS)
- Color management from the Embedded Web Server
- Color management from the front panel
- Color management and the scanner
Introduction

Your printer has been engineered with advanced hardware and software features to ensure predictable and dependable results.

- Color calibration for consistent colors.
- One gray and two black inks provide neutral grays on all paper types.
- The Photo Black ink provides pure blacks when printing on photo papers.
- Color emulation of other HP Designjet printers.

How colors are represented

All devices that display color use a color model to represent color in numerical terms. Most monitors use the RGB (Red-Green-Blue) color model, while most printers use the CMYK (Cyan-Magenta-Yellow-Black) color model.

An image can be converted from one color model to another, but in general the conversion is not perfect. Your printer uses the RGB color model: the same color model that is used by your monitor.

This simplifies but does not completely solve the problem of matching colors. Each device represents colors a little differently from another device, even if they use the same color model. However, software can adjust the colors in an image according to the characteristics of the particular device, using a color profile of the device, in order to achieve correct colors.

A summary of the color management process

To get the accurate and consistent colors that you want, you should follow these steps for each paper type that you use.

1. Color-calibrate the paper type, for consistent colors. Calibration should be repeated every now and then (see Color calibration on page 105). In addition, you may wish to calibrate immediately before a particularly important print job for which color consistency is vital.

2. When printing, select the correct color preset for the paper type you are using.

Color calibration

Color calibration enables your printer to produce consistent colors with the particular printheads, inks and paper type that you are using, and under your particular environmental conditions. After color calibration, you can expect to get similar prints from any two different printers situated in different geographical locations.

Some paper types cannot be calibrated. For all other paper types, calibration should be done in any of the following circumstances:

- Whenever a printhead is replaced
- Whenever a new paper type is introduced that has not yet been calibrated with the current set of printheads
- Whenever the environmental conditions (temperature and humidity) change significantly
You can check the color calibration status of the currently loaded paper at any time by pressing ⏳ and then ⪤ on the front panel. The status may be one of the following:

- **Recommended**: the paper has not been calibrated.

- **Obsolete**: the paper has been calibrated, but the calibration is now out of date because a printhead has been replaced, and should be repeated.

- **Done**: the paper has been calibrated, and the calibration is up to date.

- **Disabled**: this paper cannot be calibrated.

**NOTE**: Color calibration cannot be performed on plain paper, nor on any kind of transparent material.

You can also check the color calibration status by using the HP Utility.

You can start color calibration in the following ways:

- From the HP Utility for Windows: select **Color Center > Calibrate paper**, and choose the paper to be calibrated.

- From the HP Utility for Mac OS: select **Paper Preset Management** from the HP Color Center group, choose the paper to be calibrated, press the ⬅️ button and select **Calibrate Paper**.

- From the front panel: press ⏳, then ⪤, then **Image quality maintenance > Calibrate color**.

The calibration process is fully automatic and can be performed unattended after you have loaded paper of the type you wish to calibrate—which should be A4 or any larger size. If you have more than one roll loaded, the product will ask which roll you want to use for the calibration.

The process takes about 3–5 minutes and consists of the following steps.

1. A calibration chart is printed, which contains patches of each ink used in your printer.

2. The chart is allowed to dry for a period of time that depends on the paper type, so that the colors have time to stabilize.

3. The chart is scanned and measured.

4. From the measurements, the printer calculates the necessary correction factors to apply for consistent color printing on that paper type. It also calculates the maximum amount of each ink that can be applied to the paper.
Color management from printer drivers

Color management options

The aim of color management is to reproduce colors as accurately as possible on all devices: so that, when you print an image, you see very similar colors as when you view the same image on your monitor.

There are two basic approaches to color management for your printer:

- **Application-Managed Colors**: in this case your application program must convert the colors of your image to the color space of your printer and paper type, using the ICC profile embedded in the image and the ICC profile of your printer and paper type.

- **Printer-Managed Colors**: in this case your application program sends your image to the printer without any color conversion, and the printer converts the colors to its own color space. The details of this process depend on the graphics language that you are using.
  - **PostScript (T2300 PS)**: the PostScript interpreter module performs the color conversion using the profiles stored in the printer and any additional profiles sent with the PostScript job. This kind of color management is done when you are using the PostScript driver and you specify printer color management or when you send a PostScript, PDF, TIFF or JPEG file directly to the printer through the Embedded Web Server. In either case you have to select the profiles to use as default (in case the job doesn’t specify any) and the rendering intent to apply.
  - **Non-PostScript (PCL, RTL, HP-GL/2)**: the color management is done using a set of stored color tables. ICC profiles are not used. This method is somewhat less versatile than the alternatives, but is a little simpler and faster, and can produce good results with standard HP paper types. This kind of color management is done when you are using a non-PostScript driver and you specify printer color management, or when you send a PCL, RTL or HP-GL/2 file directly to the printer through the Embedded Web Server.

**NOTE:** There are only two color spaces that the printer can convert to its own color space using the stored color tables: Adobe RGB and sRGB if you are using Windows, Adobe RGB and ColorSync if you are using Mac OS.

ColorSync is the Mac OS built-in Color Management System; so, when you select ColorSync, color management is performed by Mac OS, and it is done based on the ICC profiles of the specified paper type. ColorSync is available with the PCL3GUI driver only.

ColorSync can be selected under Mac OS X 10.4 from the **Color Options** panel: select **Use Embedded (ICC/ColorSync)** from the **Source Profile** drop-down list. Under Mac OS X 10.5 and 10.6, ColorSync can be selected from the **Color Matching** panel.

You are recommended to consult the Knowledge Center (see Knowledge Center on page 207) to see how to use the color management options of your particular application.

To choose between **Application-Managed Colors** and **Printer-Managed Colors**:

- **In the Windows driver dialog**: select the **Color** tab.
- **In the Mac OS Print dialog**: select the **Color Options** panel.
- **In some applications**: you can make this choice in the application.
Printer emulation

If you want to print a particular job and to see approximately the same colors that you would get from printing the same job on a different HP Designjet printer, you can use the emulation mode provided by your printer.

**NOTE:** This option is available only when printing an HP-GL/2, PostScript or PDF job. It will work correctly only when printing on plain, coated or heavyweight coated paper.

- **In the Windows HP-GL/2 or PostScript driver dialog:** select the Color tab, then Printer Managed Colors, then select Printer Emulation from the Source Profile list. You can then select from the Emulated Printer list.

- **In the Mac OS Print dialog (T2300):** select the Color Options panel, then select Printer Emulation from the Source Profile list.

- **In the Mac OS Print dialog (T2300 PS):** select the Color Options panel, then select from the Printer Emulation list.

Color adjustment options

The aim of color management is to print accurate colors. If you perform color management correctly, then you should be able to print accurate colors with no need of any manual color adjustments.

However, manual adjustments may be useful in the following situations:

- If your color management is not working correctly for some reason
- If you want colors that are subjectively pleasing rather than accurate

The printer driver provides different adjustment facilities depending on whether you are printing in color or in grayscale. If you are printing in pure black and white, there are no color adjustment options.

Printing in color

You can adjust the colors of your print in similar ways under Windows and Mac OS:

- **In the Windows driver dialog:** select the Color tab, ensure that the Advanced color adjustments box is checked, then press the Settings button beside it.

- **In the Mac OS Print dialog (T2300):** select the Color Options panel, select Color from the Mode list, then press the Adjust button.

- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS):** select the Color Options panel, select Color from the Mode list, then press the Adjust button.

- **In the Mac OS X 10.4 PostScript Print dialog (T2300 PS):** select the Color Options panel, then Lightness and Hue.

Under either operating system, you will then be able to make adjustments using a lightness slider and three color sliders.
• The lightness slider simply makes the whole print lighter or darker.

• The color sliders can be used to fade or emphasize each of the primary colors in the print. The primary colors may be red, green and blue; or cyan, magenta and yellow; depending on the color model used in the image.

The Reset button restores each slider to its default central position.

### Printing in grayscale

You can adjust the gray balance of your print in similar ways under Windows and Mac OS:

• **In the Windows driver dialog:** select the Color tab, ensure that the Advanced color adjustments box is checked, then press the Settings button beside it.

• **In the Mac OS Print dialog (T2300):** select the Color Options panel, select Grayscale from the Mode list, then press the Adjust button.

• **In the Mac OS X 10.5 and 10.6 PostScript Print dialog (T2300 PS):** select the Color Options panel, select Grayscale from the Mode list, then press the Adjust button.

• **In the Mac OS X 10.4 PostScript Print dialog (T2300 PS):** select the Color Options panel, then Print in Grayscale, then the Gray balance tab.

Under either operating system, you will then be able to make adjustments using separate controls for highlights, midtones and shadows.
The lightness slider simply makes the whole print lighter or darker. This slider is available in the same window as the other grayscale controls, except under Mac OS X 10.4, where it is available by selecting **Lightness and Hue**.

The zone definition sliders can be used to define what you mean by highlight, midtone and shadow.

The other controls for highlight, midtone and shadow can be used to adjust the gray balance of highlights, midtones and shadows respectively.

The **Reset** button restores each control to its default setting.

**Color management from printer drivers (T2300 PS)**

This facility is available when printing with the PostScript driver.

**HP Professional PANTONE Emulation**

When you use a named PANTONE color in an image, your application will normally send to the printer a CMYK or RGB approximation to that color. But the application does not take the printer or the paper type into account, it merely produces a generic approximation of the PANTONE color, which will look different on different printers and on different papers.

HP Professional PANTONE Emulation can do a much better job by taking into account the characteristics of the printer and the paper type. The results look as similar to the original PANTONE colors as is possible on a given printer using a given paper type. This technology is designed to produce emulations similar to those set up manually by prepress professionals.

To use HP Professional PANTONE Emulation, all you have to do is to turn it on. In fact, it is normally on by default.

- **In the Windows PostScript driver dialog:** go to the **Color** tab and select **HP Professional PANTONE Emulation**.
- **In the Mac OS Print dialog:** go to the **Color Options** panel and select **HP Professional PANTONE Emulation**.
You can also use the Embedded Web Server to print a swatch book showing emulations of PANTONE colors as made by your printer, together with a measure of the color difference (ΔE) between each emulation and the original PANTONE spot color. So HP Professional PANTONE Emulation not only provides the closest match that can be achieved on your printer; it also gives clear information on how close the emulation is to the original spot color. See Printing PANTONE swatch books on page 114.

Color emulation

Your printer can emulate the color behavior of other devices: RGB devices such as monitors, and CMYK devices such as presses and printers.

You can set color emulation in the following ways:

- **In the Windows PostScript driver dialog**: select the **Color** tab, and **Printer Managed Colors**.
- **In the Mac OS Print dialog**: select the **Color Options** panel, then select **Printer** from the Color Management list.

For a good emulation, the printer needs a specification of the colors these devices can reproduce. The standard way of encapsulating such information is in ICC profiles. As part of the solution, we provide the most common standards for the different devices.

The options are as follows.

**CMYK color emulation**

A traditional workflow defines color in the CMYK space. For best results, the colors must be adjusted to the printer, because different printers will produce different colors from the same CMYK data. If the image file you are printing was not created specifically for your printer, it will require some readjustment, which can be done using one of the following options provided with your printer.

- **None (Native)**: no emulation. The printer will use its default internal conversion from CMYK to RGB, without following any color standard. This does not imply that results will be bad

- **ISO Coated 2-ECI** is based on the characterization dataset FOGRA39L.txt, applicable to the following reference printing conditions according to the international standard ISO 12647-2:2004/Amd 1: commercial and specialty offset, paper type 1 and 2, gloss or matt coated paper, positive plates, tone value increase curves A (CMY) and B (K), white backing.

- **Coated GRACoL 2006-ISO12647** provides GRACoL proofing and printing on Grade 1 coated paper, ISO 12647-2 Paper type 1.

- **PSO Uncoated ISO12647-ECI** is based on the characterization data set FOGRA47L.txt, applicable to the following reference printing condition according to the international standards ISO 12647-2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, paper type 4, uncoated white paper, positive plates, tone value increase curves C (CMY) and D (K), white backing.

- **PSO LWC Improved-ECI** is based on the characterization data set FOGRA45L.txt, applicable to the following reference printing condition according to the international standards ISO 12647-2:2004 and ISO 12647-2:2004/Amd 1:2007: commercial and specialty offset, improved LWC paper (light weight coating), positive plates, tone value increase curves B (CMY) and C (K), white backing.

- **Web Coated SWOP 2006 Grade 3** provides SWOP® proofing and printing on U.S. Grade 3 coated publication paper.
• **Web Coated SWOP 2006 Grade 5** provides SWOP® proofing and printing on U.S. Grade 5 coated publication paper.

• **U.S. Sheetfed Coated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 350% total area of ink coverage, negative plate, bright white offset stock.

• **U.S. Sheetfed Uncoated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.

• **U.S. Web Coated (SWOP) 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 300% total area of ink coverage, negative plate, coated publication-grade stock.

• **U.S. Web Uncoated 2** uses specifications designed to produce quality separations using U.S. inks under the following printing conditions: 260% total area of ink coverage, negative plate, uncoated white offset stock.

• **Euroscale Uncoated 2** uses specifications designed to produce quality separations using Euroscale inks under the following printing conditions: 260% total area of ink coverage, positive plate, uncoated white offset stock.

• **Japan Web Coated (Ad)** uses specifications developed by the Japan Magazine Publisher Association for digital proofing of images in the Japanese magazine/advertising market.

• **Japan Color 2001 Coated** uses the Japan Color 2001 specification for type 3 (coated) paper. It is designed to produce quality separations using 350% total ink coverage, positive film and coated paper.

• **Japan Color 2001 Uncoated** uses the Japan Color 2001 specification for type 4 (uncoated) paper. It is designed to produce quality separations using 310% total ink coverage, positive film and uncoated paper.

• **Japan Color 2002 Newspaper** uses the Japan Color 2002 for Newspapers specification. It is designed to produce quality separations using 240% total ink coverage, positive film and standard newsprint paper.

• **Japan Color 2003 WebCoated** is for type 3 coated paper. It is designed to produce quality separations for standard ISO printing using 320% total ink coverage, positive film, and coated paper on heat-set web offset presses.

• **JMPA**: Japanese standard foroffset press.

• **Toyo** is designed to produce quality separations for Toyo printing presses.

• **DIC** is designed to produce quality separations for Dainippon Ink Company printing presses.

**NOTE:** These options have no effect if the application is defining its own CMYK space, known as calibrated CMYK or CIEBasedDEFG in PostScript terminology.
**RGB color emulation**

Your printer is provided with the following color profiles:

- **None (Native)**: no emulation, for use when the color conversion is done by the application or operating system, and therefore the data arrive at the printer already color-managed.

- **sRGB IEC61966-2.1** emulates the characteristics of the average PC monitor. This standard space is endorsed by many hardware and software manufacturers, and is becoming the default color space for many scanners, printers and software applications.

- **ColorMatch RGB** emulates the native color space of Radius Pressview monitors. This space provides a smaller gamut alternative to Adobe RGB (1998) for print production work.

- **Apple RGB** emulates the characteristics of the average Apple monitor, and is used by a variety of desktop publishing applications. Use this space for files that you plan to display on Apple monitors, or for working with old desktop publishing files.

- **Adobe RGB (1998)** provides a fairly large gamut of RGB colors. Use this space if you need to do print production work with a broad range of colors.

**Color management from the Embedded Web Server**

**Submit Job options**

When you send jobs to the printer using the Embedded Web Server’s **Submit Job** page, you have the following color management options.

If you leave an option set to **Default**, the setting saved in the job will be used. If the job contains no setting, the front-panel setting in the printer will be used.

**T2300 and T2300 PS options**

- **Color/Grayscale**: you can choose to print in color, in shades of gray or in pure black and white.

- **Default RGB source profile**: you can choose from a selection of RGB source profiles recognized by the printer.

- **Printer emulation**: you can choose to emulate a different HP Designjet printer. Default: **Off** (no printer emulation).

**T2300 PS options (with PostScript or PDF jobs)**

- **Default CMYK source profile**: you can choose from a selection of CMYK source profiles recognized by the printer. Default: **US Coated SWOP v2**.

- **Rendering intent**: you can select the rendering intent.

- **Black point compensation**: you can turn black point compensation on or off.

- **HP Professional PANTONE Emulation**: you can turn HP Professional PANTONE Emulation on or off.
Rendering intent

Rendering intent is one of the settings used when doing a color transformation. As you probably know, some of the colors you want to print may not be reproducible by the printer. The rendering intent allows you to select one of four different ways of handling these so-called out-of-gamut colors.

- **Saturation (graphics)**: best used for presentation graphics, charts or images made up of bright, saturated colors.
- **Perceptual (images)**: best used for photographs or images in which colors blend together. It tries to preserve the overall color appearance.
- **Relative colorimetric (proofing)**: best used when you want to match a particular color. This method is mainly used for proofing. It guarantees that, if a color can be printed accurately, it will be printed accurately. The other methods will probably provide a more pleasing range of colors but do not guarantee that any particular color will be printed accurately. It maps the white of the input space to the white of the paper on which you are printing.
- **Absolute colorimetric (proofing)**: the same as relative colorimetric, but without mapping the white. This rendering is also used mainly for proofing, where the goal is to simulate the output of one printer (including its white point).

Perform black point compensation

The black point compensation option controls whether to adjust for differences in black points when converting colors between color spaces. When this option is selected, the full dynamic range of the source space is mapped into the full dynamic range of the destination space. It can be very useful in preserving shadows when the black point of the source space is darker than that of the destination space. This option is allowed only when the Relative colorimetric rendering intent is selected (see Rendering intent on page 114).

Printing PANTONE swatch books

You can use the Embedded Web Server to print a swatch book showing emulations of PANTONE colors as made by your printer, together with a measure of the color difference (ΔE) between each emulation and the original PANTONE spot color.

To print a swatch book, select the Embedded Web Server’s **Main** tab, then **HP Professional PANTONE Emulation**. Select the PANTONE stock to emulate, and one or more strips of PANTONE colors that you want to print. You can select color strips from more than one PANTONE stock. When you have selected all the colors you want, press the **Next** button. The next window displays your selection; you can press **Print** to print that selection, or **Back** to change the selection.
Color management from the front panel

You can color-calibrate the loaded paper type from the front panel by pressing [1], then [2], then [3]. See Color calibration on page 105.

The other color options in the front panel can all be found by pressing [4], then [5], then Setup > Printing preferences > Color options.

**NOTE:** These front panel settings can all be overridden by the printer driver or by Embedded Web Server job submission settings.

**T2300 and T2300 PS options**

- **Color/Grayscale:** you can choose to print in color or in shades of gray. Default: Print in color.
- **Select RGB source profile:** you can choose from a selection of RGB source profiles recognized by the printer. Default: sRGB (HP).
- **Emulate printer:** you can choose to emulate a different HP Designjet printer. Default: Off (no printer emulation).
TIP: If you have old HP-GL/2 or PostScript files made for a different HP Designjet printer, you can send them to the printer and use the front panel to turn on the appropriate emulation mode.

T2300 PS options (with PostScript or PDF jobs)

- **Select CMYK source profile**: you can choose from a selection of CMYK source profiles recognized by the printer. Default: **US Coated SWOP v2**.
- **Select rendering intent**: you can select the rendering intent. Default: **Perceptual**.
- **Black point compensation**: you can turn black point compensation on or off. Default: **On**.
- **HP Professional PANTONE Emulation**: you can turn HP Professional PANTONE Emulation on or off. Default: **On**.

**Color management and the scanner**

The files obtained from your scanner (TIFF, JPEG, PDF) contain an embedded ICC profile corresponding to the type of paper selected prior to making the scan. When you load these files into any image reader software application, the information of the ICC profile is automatically used for optimum color appearance on your monitor. When you print a scanned image, or copy an original, the embedded ICC profile is also automatically used by the printer for optimum printing results.
13 Practical printing examples

- Print a draft for revision with the correct scale
- Print a project
- Print a presentation
- Print and scale from Microsoft Office
Print a draft for revision with the correct scale

This section demonstrates how to print a draft for revision with the correct scale from Adobe Acrobat.

Using Adobe Acrobat

1. In the Acrobat window, bring the mouse cursor to the bottom left corner of the document pane to check the plot size.

2. Select File > Print and ensure that Page Scaling is set to None.

   **NOTE:** The page size will **not** be automatically selected according to the drawing size.
3. Press the **Properties** button and then select the **Paper/Quality** tab.

4. Choose whatever **Document Size** and **Print Quality** you want to use. If you want to define a new custom paper size, press the **Custom** button.

5. Select the **Features** tab, and then **Autorotate**.
6. Click OK, and check that the print preview in the Print dialog box seems correct.

Print a project

This section demonstrates how to print a project from AutoCAD and the Embedded Web Server.

Using AutoCAD

1. The AutoCAD window can show a model or layout. Normally a layout is printed rather than the model.

2. Click the Plot icon at the top of the window.
3. The Plot window opens.

4. You can see further options by pressing the circular button in the lower right corner of the window.

**NOTE:** The Quality option here does not refer to the final print quality but to the quality of AutoCAD viewport objects that are sent for printing.
5. Press the **Properties** button.

6. Select the **Device and Document Settings** tab, and press the **Custom Properties** button.
7. In the **Paper/Quality** tab, check the **Show preview before printing** box, and select the paper type that you intend to use.

**NOTE:** If you select neither the paper source nor the paper type, the printer will not print on any protected roll (see **Roll protection on page 77**).

8. Select the print quality (your own choice between speed and quality of printing).

9. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press the **Margins/Layout** button and select **Clip contents by margins**.
10. Select the **Features** tab, then select the **Autorotate** and **Crop lines** options. Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the paper after printing.

![Image of HP printer software interface with Autorotate and Crop lines options highlighted]

11. Press the **OK** button and save your configuration changes to a PC3 file.

![Image of save dialog box with PC3 file selected]
12. When you have pressed the OK button in the Plot window, the printer will construct a print preview.

Using the Embedded Web Server to submit files

From the HP Utility or the Embedded Web Server, select Job Center > Submit Job. With some Web browsers, you will see the window below; with other Web browsers, the mechanism for adding files is slightly different.
Press the **Add files** button (or **Choose File, Add another file**) to choose the files from your computer that you want to print. The files must be in one of the following formats:

- HP-GL/2
- RTL
- TIFF
- JPEG
- PDF (T2300 PS only)
- PostScript (T2300 PS only)

**NOTE:** When you print to a file, the file should be in one of the above formats, but its name may have an extension such as `.plt` or `.prn`.

If the files are not in one of these formats, they will not be printed successfully.

If the jobs have been generated with the appropriate settings (such as page size, rotation, resizing and number of copies), you can just press the **Print** button and the project will be sent to the printer.

If you need to specify printing settings, go to the **Job settings** section and select the options you need. Each option has explanatory text on the right, so that you can understand the behavior of each setting. Remember that, if you leave the setting as **Default**, the setting saved in the job will be used. If the job contains no setting, the setting in the printer will be used.

**Using printer emulation**

Printer emulation can be requested by selecting **Advanced settings > Color > Color management > Printer emulation**.

You can select **Off** (no printer emulation) or the name of the printer model that you want to emulate.
This setting will apply to jobs that do not contain any printer emulation setting saved in the job.

**Using clip contents by margins**

You can select this margins option from *Advanced settings > Paper > Layout/Margins > Print with margins > Layout > Clip contents by margins.*

Use this option when the contents to be printed have white borders and a size equal to that of the paper you have selected. The printer will use the white border for its margins and you will get a page of size equal to that which is selected in the driver.

**Print a presentation**

This section demonstrates how to print a presentation from AutoCAD and from Photoshop.

**Using AutoCAD**

1. Open the AutoCAD file and select a layout.

2. Click the Plot icon at the top of the window.
3. Ensure that the correct printer is selected, then press the **Properties** button.

4. Select the **Device and Document Settings** tab, and press the **Custom Properties** button.
5. In the **Paper/Quality** tab, check the **Show preview before printing** box, and select the paper type that you intend to use.

**NOTE:** If you select neither the paper source nor the paper type, the printer will not print on any protected roll (see **Roll protection on page 77**).

6. Select the print quality (your own choice between speed and quality of printing).

7. If you intend to print on roll paper, you must decide where the printer should cut the paper. Press the **Margins/Layout** button and select **Clip contents by margins**.
8. If you are using photo or glossy paper, you can select \textbf{Borderless} printing.

9. Select the \textbf{Features} tab, then select the \textbf{Autorotate} and \textbf{Crop lines} options. Autorotation can help to avoid wasting paper, and the crop lines will show you where to cut the paper after printing.

10. Press the \textbf{OK} button and save your configuration changes to a PC3 file.
11. When you have pressed the **OK** button in the Plot window, the printer will construct a print preview.

![Printer progress](image)

**Using Adobe Photoshop**

1. In Photoshop CS5, select **File > Print** and then select your printer.
2. Choose from the available paper sizes.

If you do not find the paper size that you intend to use, press the **Custom** button. Enter the width, the length and the name of your custom paper size. Press the **Save** and **OK** buttons.
3. Select **Show preview before printing**. You may also wish to change the default paper source, paper type and print quality.

4. In the **Color** tab, the default color management option is **Printer managed colors**, and this is the correct option because you have already selected **Printer Manages Colors** in Photoshop.

---

**Print and scale from Microsoft Office**

This section demonstrates how to print and scale from Microsoft Office.
Using PowerPoint

1. Select the Office Button, then Print, and select the name of your printer.

2. Select Properties > Features > Print document on to scale the document to a particular size.
3. Select the **Paper/Quality** tab, then select **Paper Source** and **Paper Type**.

![Paper/Quality settings](image)

4. Select **Margins/Layout**, then select **Clip contents by margins** to keep the size.

![Margins/Layout settings](image)

---

**Using Project**

1. Select **File > Page Setup > Print**.

![Page Setup settings](image)
2. Select your printer’s name, then **Close**.

3. Select **Page Setup**, and choose the **Paper Size** you want.

4. Select **Options** to go to the printer driver. The default options in the **Paper/Quality** tab are probably suitable: **Paper source**: Printer auto select and **Paper Type**: Any.
5. Select **Features > Print document on** to scale the document to a particular size. Alternatively, you can scale the document in Project.

![Print document on settings](image)

**Using Excel**

1. Select the Office Button, then **Print**. Select your printer’s name, then click **Close**.

![Excel print settings](image)
2. Select the **Page Layout** tab, then **Size**, and choose the paper size you want.

3. Select the Office Button, then **Print > Properties** to go to the printer driver. In the **Paper/Quality** tab, select **Paper source**, **Paper Type** and **Print Quality**.
4. Select **Features > Print document on** to scale the document to a particular size. Alternatively, you can scale the document in Excel.
14 Retrieving usage information

- Get accounting information
- Check usage statistics
- Check usage statistics for a job
- Request accounting data by email
Get accounting information

There are various different ways of getting accounting information from your product.

- View product usage statistics for the whole lifetime of the product, see Check usage statistics on page 141.
- View ink and paper usage for each of your recent jobs by using the HP Utility, see Check usage statistics for a job on page 142. If the HP Utility is not available, see Access the HP Utility on page 43.
- Request accounting data by email. The product sends data in XML at regular intervals to a specified email address; the data may be interpreted and summarized by a third-party application, or displayed as an Excel spreadsheet. See Request accounting data by email on page 142.
- Use a third-party application to request product status, product usage or job accounting data from the product through the Internet. The product provides data in XML to the application whenever requested. HP provides a Software Development Kit to facilitate the development of such applications.

Check usage statistics

There are various ways of checking your product’s usage statistics.

**NOTE:** The accuracy of the usage statistics is not guaranteed.

From the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 43.
2. Go to the Main tab.
3. Select History > Usage.

From the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 43.
2. Under Windows, go to the Overview tab and click on the Printer usage link.
   Under Mac OS, select Information > Printer Usage and click on the Lookup button.

From the front panel

1. Press  
2. Press  
3. Press Internal prints.
5. Press Print usage report.
Check usage statistics for a job

There are two ways to check usage statistics for a particular job.

NOTE: The accuracy of the usage statistics is not guaranteed.

Accounting statistics with the HP Utility

1. Access the HP Utility, see Access the HP Utility on page 43.
2. Select Job center to view information regarding the most recent jobs.
3. Under Windows, click on the Accounting link.
   Under Mac OS, select Job Accounting and click on the Look Up button.

Accounting statistics with the Embedded Web Server

1. Access the Embedded Web Server, see Access the Embedded Web Server on page 43.
2. Go to the Main tab.
3. Select History > Accounting.

Request accounting data by email

1. Obtain the IP address of the outgoing mail server (SMTP) from your IT department; this is required in order to send email messages.
2. Ensure that the outgoing email server is configured to enable relaying of email messages that the product will send.
3. Open your Web browser and connect to the product’s Embedded Web Server.
4. Select the Setup tab.
5. From the Configuration menu in the left-hand column, select Date & Time.
6. Ensure that the product’s date and time have been set correctly.
7. From the Configuration menu, select Email server.
8. Enter the IP address of the outgoing mail server (SMTP).
9. Specify an email address for the product. The latter does not need to be a valid email address, because the product will not receive messages; but it should have the form of an email address. It serves to identify the product when it sends email messages.
10. From the Configuration menu, select Printer settings.
11. In the Accounting section, if you set Require account ID to On, then every time someone sends a print job to the product, he or she must provide an account ID: for example, an ID corresponding to his or her department or to a specific project or client. If someone sends a job
without providing an account ID, the product will hold the unidentified job in the queue without printing it until an account ID is provided.

If you set Require account ID to Off, then the product will print all jobs whether or not they have an account ID.

12. Set Send accounting files to Enabled.

13. Set Send accounting files to the email address (or addresses) to which you want the accounting information sent. This may be an address that you have created specifically to receive automatically generated messages from the product.

14. Set Send accounting files every to the frequency with which you want the information sent, choosing a specific number of days or prints.

15. You may want to set Exclude personal information from accounting email to On, so that the accounting messages will not contain personal information. If this option is Off, information such as user name, job name, and account ID will be included.

When you have completed the above steps, the product will send accounting data by email with the frequency that you specified. The data are provided in XML and can easily be interpreted by a third-party program. The data provided on each print job include when the job was submitted, when the job was printed, the printing time, the type of image, the number of pages, the number of copies, the paper type and size, the amount of each color of ink used and various other attributes of the job. Accounting data are also provided on scan and copy jobs.

You can download an Excel template from HP’s Web site (http://www.hp.com/go/designjet/accounting) that will enable you to display the XML data more readably in the form of a spreadsheet.

Analysis of the accounting data will enable you to bill customers precisely and flexibly for the use of your product. You can, for instance:

- Bill each customer for the total amount of ink and paper used by that customer over a particular period.
- Bill each customer separately per job.
- Bill each customer separately for each project, broken down by job.

NOTE: In some circumstances Excel may lose or misplace the decimal point in a number: for instance, the number 5,180.6 may be misunderstood as 51806 and displayed as 51,806. This is an Excel problem that cannot be solved by HP.
15 Handling ink cartridges and printheads

- About the ink cartridges
- Check the ink cartridges status
- Remove an ink cartridge
- Insert an ink cartridge
- About the printheads
- Check the printhead status
- Remove a printhead
- Insert a printhead
About the ink cartridges

Ink cartridges store the ink and are connected to the printheads, which distribute the ink on the paper. To purchase additional cartridges, see Accessories on page 165.

⚠️ CAUTION: Observe precautions when handling ink cartridges because they are ESD-sensitive devices (see the Glossary on page 215). Avoid touching pins, leads and circuitry.

Check the ink cartridges status

To view the ink levels of your ink cartridges, press \(^1\) on the front panel, then \(^2\). There is a Replace ink cartridges option on the ink information page in case you want to do so (see also Remove an ink cartridge on page 145).

To get more information on your ink cartridges, you can press the color of the cartridge on which you want information.

You can also get this information from the HP Utility.

For an explanation of the ink cartridge status messages, see Ink cartridge status messages on page 186.

HP Utility procedures

- In the HP Utility for Windows, go to the Overview tab, each cartridge’s status is under Supplies Status > Cartridges.
- In the HP Utility for Mac OS, select Printer Status in the Information group.

Remove an ink cartridge

There are two occasions when you need to remove an ink cartridge.

- The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing (you can use up the remaining ink in the first cartridge at a more convenient time).
- The ink cartridge is empty or faulty, and you must replace it to continue printing.

⚠️ CAUTION: Do not try to remove an ink cartridge while printing.

⚠️ CAUTION: Remove an ink cartridge only if you are ready to insert another one.

⚠️ CAUTION: Make sure the product wheels are locked (the brake lever is pressed down) to prevent the product from moving.

⚠️ NOTE: When a cartridge runs out of ink, the current job is not automatically cancelled: unless you cancel it manually, it will resume printing when the empty cartridge has been replaced. If there is a delay in replacing the cartridge, you may see some banding on the print.

1. From the front panel, press \(^1\), then \(^2\), then Replace ink cartridges.

Alternatively, press \(^1\), then \(^2\), then Ink > Replace ink cartridges.
2. Open the ink cartridge cover on the left-hand side of the product.

3. Grip the cartridge you wish to remove.

4. Pull the cartridge straight up.

5. The front-panel display identifies the missing ink cartridge.

**NOTE:** Avoid touching the end of the cartridge that is inserted into the product, as there may be ink on the connection.

**NOTE:** Avoid storing partially used ink cartridges.
Insert an ink cartridge

1. Before removing the cartridge from its wrapping, shake it vigorously.

2. Unwrap the new ink cartridge, find the label identifying the ink color. Check that the letter or letters (in these illustrations, M for magenta) marking the empty slot, matches the letter or letters on the cartridge label.

3. Insert the ink cartridge into its slot.

4. Push the cartridge into the slot until it snaps into position. You should hear a beep and see confirmation that the cartridge has been inserted.

If you have difficulty, see Cannot insert an ink cartridge on page 186.

5. When all cartridges have been inserted, close the cover.

6. The front-panel display confirms that all cartridges have been correctly inserted.
About the printheads

The printheads are connected to the ink cartridges and jet ink onto the paper.

⚠️ **CAUTION:** Observe precautions when handling printheads because they are ESD-sensitive devices (see the Glossary on page 215). Avoid touching pins, leads and circuitry.

Check the printhead status

The product automatically checks and services the printheads after each print. Follow the steps below to get more information on your printheads.

1. From the front panel, press 📰 then 📰, then the printhead on which you want information.

2. The front panel displays:
   - Colors
   - Product name
   - Product number
   - Serial number
   - Status, see Front-panel error messages on page 203
   - Volume of ink it has used
   - Warranty status

You can also get most of this information from the HP Utility.

For an explanation of the printhead status messages, see Printhead status messages on page 192.

If the warranty status is **See warranty note**, this indicates that non-HP ink is being used. See the HP Legal Information document provided with your product for details of the warranty implications.

Remove a printhead

⚠️ **CAUTION:** Make sure the product wheels are locked (the brake lever is pressed down) to prevent the product from moving.
**CAUTION:** Printhead replacement must be performed with the product powered on.

1. From the front panel, press \( \text{ } \), then \( \text{ } \), then **Replace printheads**.

   Alternatively, press \( \text{ } \), then \( \text{ } \), then **Ink > Replace printheads**.

2. The printer moves the carriage into the correct position.

   **CAUTION:** If the carriage is left in the removal position for more than three minutes without inserting or removing any printheads, it tries to move back to its normal position in the right-hand end.

3. When the carriage has stopped moving, the front-panel display asks you to lift the scanner.

4. Locate the carriage on the right side of the printer.

5. Pull the handle up and toward you to release the wire loop.
6. Push the handle back to raise the lid.

7. This gives you access to the printheads.

8. To remove a printhead, lift up the blue handle.
9. Using the blue handle, use steady force to disengage the printhead.

10. Pull the blue handle upward until the printhead is released from the carriage.

⚠️ **CAUTION:** Do not pull abruptly because this can damage the printhead.

11. The front-panel display identifies the missing printhead.
Insert a printhead

1. Remove the orange protective caps by pulling them down.

2. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check that the colored label on the printhead matches the colored label of the carriage slot into which the printhead is to be inserted.

3. Insert the new printhead into its correct slot in the carriage.

⚠️ **CAUTION:** Insert the printhead slowly and vertically, straight down. It may be damaged if you insert it too fast, or at an angle, or if you rotate it as you insert it.
4. Push down as indicated by the arrow shown below.

![Image of printhead installation]

⚠️ **CAUTION:** When installing the new printhead there may be some resistance, so you need to press it down firmly but smoothly. You should hear a beep and see confirmation on the front-panel display that the printhead has been inserted. If you have difficulty, see Cannot insert a printhead on page 186.

5. Insert all other printheads that need to be installed, and close the carriage lid.

![Image of printhead installation]

6. Ensure the end of the blue handle catches the wire loop on the near side of the carriage.
7. Lower the handle to rest on the carriage cover.

When all the printheads have been inserted correctly and are accepted by the printer, the printer beeps.

**NOTE:** If the printer does not beep when you insert the printhead and the Replace message appears on the front-panel display, the printhead may need to be reinserted.

8. Lower the scanner.

9. The front-panel display confirms that all printheads are correctly inserted. The printer starts checking and preparing the printheads. The default routine process, when all printheads are changed, takes 10 minutes. If the printer finds problems in preparing the printheads, it takes longer, up to 45 minutes. For a single printhead insertion, the times vary between 2 and 40 minutes. After all printheads are checked and prepared, the printhead realignment procedure runs automatically if paper is loaded, see Align the printheads on page 190.

10. You are recommended to perform a color calibration after inserting a new printhead. See Color calibration on page 105.
16 Maintaining the product

- Check product status
- Clean the exterior of the product
- Maintain the ink cartridges
- Clean the scanner’s glass plate
- Replace the scanner’s glass plate
- Calibrate the scanner
- Move or store the product
- Update the firmware
- Update the software
- Product maintenance kits
- Secure Disk Erase
Check product status

You can check the current status of the product in various ways:

- If you start the HP Utility and select your product, you see a page of information describing the status of the product and its paper and ink supplies.

- If you access the Embedded Web Server, you see information about the general status of the product. The Supplies page in the Main tab describes the status of the paper and ink supplies.

- At the front panel, you can press \( 
\) for information about paper, ink levels, ink cartridges, and printheads. If there is a current problem, you are taken automatically to the area with the most urgent problem.

If there are any current alerts, the upper row of the home screen shows the top-priority alert. Press the alert message to see a list of all current alerts.

Clean the exterior of the product

Clean the outside of the product and all other parts of the product that you regularly touch as part of normal operation with a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap.

⚠️ **WARNING!** To avoid an electric shock, make sure that the product is turned off and unplugged before you clean it. Do not let water get inside the product.

⚠️ **CAUTION:** Do not use abrasive cleaners on the product.

Maintain the ink cartridges

During the normal lifetime of a cartridge, no specific maintenance is required. However, in order to maintain the best print quality, replace a cartridge when it reaches its expiration date. The front panel notifies you when any cartridge reaches its expiration date.

You can also check a cartridge’s expiration date at any time: see Check product status on page 156.

See also Handling ink cartridges and printheads on page 144.

Clean the scanner’s glass plate

You are recommended to clean the scanner’s glass plate periodically, depending on how often you use the scanner.

1. Turn off the product using the Power key at the front, then also turn off the power switch at the rear and disconnect the power cable.

2. There is a small lever at the rear left of the scanner. Slide the lever to the right and open the scanner cover.
3. Gently wipe the glass plate and the surrounding area with a lint-free cloth dampened with water and then wrung dry. A suitable cloth is provided with the product.

⚠️ **CAUTION:** Do not use abrasives, acetone, benzene or fluids that contain these chemicals. Do not spray liquids directly onto the scanner glass plate or anywhere else in the scanner.

Do not worry about tiny droplets of water left on the glass: they will evaporate.

4. Optionally, for more thorough cleaning:
   - Remove the glass plate and clean it on both sides. See Replace the scanner’s glass plate on page 158.
   - Clean the pressure rollers (between the feed rollers).
5. Close the scanner cover and gently push it down to lock it into place.

6. Clean the area immediately in front of the scanner, where the scanned sheet rests before scanning.

7. Reconnect the product’s power cable, turn on the power switch at the rear, and turn on the product using the Power key.

**Replace the scanner’s glass plate**

Over time, the condition of the glass plate can deteriorate. Small scratches on the surface of the glass can reduce image quality. Contact HP Support (see [Contact HP Support on page 209](#)) to order a new glass plate.

1. Turn off the product using the Power key at the front, then also turn off the power switch at the rear and disconnect the power cable.

2. There is a small lever at the rear left of the scanner. Slide the lever to the right and open the scanner cover.

3. Remove the plastic insert.

4. Remove four small parts as shown.
5. Press down the four white plastic tabs.

6. Simultaneously, lever up the glass at each end with a small implement. (You may need several people for this operation.)

7. Remove the glass.
8. Insert the new glass. Be very careful not to scratch it. Press the four white plastic tabs until they click into place.

9. Replace the four parts that you removed initially, to keep the plastic tabs in place.

10. Close the scanner cover and gently push it down to lock it into place.

11. Reconnect the product's power cable, turn on the power switch at the rear, and turn on the product using the Power key.

**Calibrate the scanner**

Your scanner has been calibrated at the factory, and theoretically CIS scanners do not need to be recalibrated during their lifetimes. Nevertheless, because of environmental changes, your scanner may start showing image defects that can be easily corrected by recalibrating the scanner. The whole procedure takes less than 10 minutes, and you are recommended to recalibrate the scanner whenever you see some undesired artifact or a lack of quality in scanned files or copies, bearing in mind the limitations of CIS technology already explained in this guide. If you perform calibration successfully and still have concerns about the image quality, please read the Image-quality troubleshooting guide in order to detect whether you are facing a product limitation, and may want to consider buying a CCD scanner.
To calibrate the scanner

1. Clean the scanner. See Clean the scanner’s glass plate on page 156.
2. Go to the front panel and press \( \text{Home, then Image Quality Maintenance > Calibrate scanner.} \)
3. Follow the instructions in the front panel.

The supplied maintenance sheet required to perform scanner calibration looks like this:

![Maintenance Sheet Image]

Load the maintenance sheet into the scanner face up, centered and with as little skew as possible. Once the calibration is finished, the maintenance sheet should be carefully placed into its solid cover, and saved in a fresh and dry place. Otherwise, it could be damaged, which could affect the operation of your scanner in the future. Check that the maintenance sheet is not dirty, wrinkled, scratched or folded before calibrating the scanner. If necessary, call HP support and ask for a new maintenance sheet.

If calibration fails

1. Ensure that the product is turned on and ready for normal operation.
2. Ensure that the scanner is working correctly. To test it, scan a small document to file.
3. Ensure that the scanner is clean before calibration. If in doubt, clean the scanner and restart the calibration process.
4. Eject and reload the calibration sheet, checking that it is clean and in good condition. The sheet must be perfectly centered in the scanner for correct calibration.
5. If the above steps do not help, eject the sheet and restart the product (turn off and on). When the system has restarted, repeat the calibration.
6. If you cannot perform the calibration successfully in three consecutive attempts, call HP support and report the error code that appears in the front panel.

Move or store the product

If you need to move or store the product, prepare it correctly to avoid possible damage to it. To prepare the product, follow the instructions below.

1. Do not remove the ink cartridges or printheads.
2. Make sure that no paper is loaded.
3. Make sure that the product is idle.
4. Disconnect any cables connecting the product to a network or a computer.
5. Before moving the product through a doorway, remove the foot extensions.

If you need to leave the product turned off for a long time, follow the additional steps below.

1. Turn off the power using the Power key on the front panel.
2. Also turn off the power switch at the rear of the product.
3. Disconnect the product’s power cable.

⚠️ **CAUTION:** If you turn the product upside down, ink could escape into the product and cause serious damage.

When the product is turned back on, it takes about three minutes to initialize itself and to check and prepare the printheads. Preparing the printheads normally takes just over a minute. However, if the product has been off for a six weeks or more, preparing the printheads could take up to 45 minutes.

⚠️ **CAUTION:** If the product remains off for a long period of time, the printheads may become unusable. In this case, you need to replace the printheads with new ones.

💡 **TIP:** Because preparing and purging the printheads uses both time and ink, you are strongly recommended to leave the product always on or in sleep mode, whenever possible, to maintain the health of the printheads. In both cases, the product wakes up from time to time to maintain the printheads. Thus you can avoid going through lengthy preparation processes before using your product.

## Update the firmware

The product’s various functions are controlled by firmware that resides in the product.

From time to time firmware updates will be available from Hewlett-Packard. These updates increase the product’s functionality, enhance its features, and may correct minor problems.

⚠️ **IMPORTANT:** You are strongly recommended to update the firmware periodically in order to take advantage of the latest developments.

There are various ways of downloading and installing firmware updates; you can choose whichever you find most convenient. They can be divided into two categories: automatic and manual updates.
NOTE: The firmware includes a set of the most commonly used paper presets. Extra paper presets can be downloaded separately; see Paper presets on page 57.

Automatic firmware updates

Automatic firmware updates are a convenience that is possible with Web-connected products. Your product can automatically download the latest firmware release and install it for you.

Important notes

- Your product must be connected to the Internet; see Set up your Web-connected product on page 28.
- To configure automatic firmware updates, you can use the front panel or the Embedded Web Server; see Set up your Web-connected product on page 28.
- If an administrator password has been set, it will be required to change these settings.
- A firmware update package can be large; you may want to consider whether there are any implications for your network or Internet connection. Downloads made with a Jetdirect adaptor are slower than those made with the built-in Ethernet adaptor.
- A firmware update is downloaded in the background: the printer can be printing at the same time. However, it cannot be installed in the background: printing must stop.

Manual firmware updates

Manual firmware updates can be performed in the following ways:

- Using the Embedded Web Server, select the Firmware update maintenance tab and then Firmware update. Press Check now to check whether new firmware is available. If new firmware is available, some information about the new firmware is displayed, and you are given the opportunity to download and install it.
- Using the HP Utility under Windows, select your product, the Support tab and then Firmware Update.
- Using the HP Utility under Mac OS, select Firmware Update in the Support group.
- Using HP Web Jetadmin, with which you can make manual firmware updates or request automatic updates.
- Using a USB flash drive. Download the firmware file from http://www.hp.com/go/T2300/ firmware into the USB flash drive and insert it into the Hi-Speed USB host port beside the front panel. A firmware update assistant will appear on the front panel to guide you through the update process.

Update the software

To update printer drivers and other software for your product, go to http://www.hp.com/go/T2300/drivers.

If your operating system is Windows, HP Software Update regularly offers to update your software automatically.
Product maintenance kits

Four maintenance kits are available for your product, containing components that may need to be replaced after long use. When one of them is needed, a message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact HP Support (see Contact HP Support on page 209) and request the maintenance kit. The kits are installed by service engineers only.

Secure Disk Erase

The product's hard disk is used as a temporary storage area for print jobs. The Secure Disk Erase facility can completely erase your information from the hard disk to protect it from unauthorized access. You can choose to erase particular files, or the whole hard disk.

Secure Disk Erase provides three different levels of security:

- **Non-Secure Fast Erase:** all pointers to the information are erased. The information itself remains on the hard disk until the disk space it occupies is needed for other purposes, and it is then overwritten. While it remains on the disk, it is difficult for most people to access, but may be accessed using software designed for the purpose. This is the normal method in which files are erased on most computer systems; it is the fastest method but the least secure.

- **Secure Fast Erase:** all pointers to the information are erased, and the information itself is also overwritten with a fixed character pattern. This method is slower than Non-Secure Fast Erase, but more secure. It may still be possible to access fragments of the erased information by using special tools to detect residual magnetic traces.

- **Secure Sanitizing Erase:** all pointers to the information are erased, and the information itself is repetitively overwritten using an algorithm designed to eliminate any residual traces. This is the slowest method, but the most secure. Secure Sanitizing Erase meets the US Department of Defense 5220-22.m requirements for clearing and sanitization of disk media. This is the default security level when using Secure Disk Erase.

Secure Disk Erase is one of the facilities provided by Web JetAdmin, which is HP's free Web-based print management software: see [http://www.hp.com/go/webjetadmin](http://www.hp.com/go/webjetadmin).

If you have difficulty in using Secure Disk Erase from Web JetAdmin, please contact HP Support: see Contact HP Support on page 209.

**NOTE:** If you choose to erase the whole hard disk, you may be asked to restart the product several times during the process, which will take about 6 hours with Secure Disk Erase or 24 hours with Secure Sanitizing Erase.
17 Accessories

- How to order supplies and accessories
- Introduction to the accessories
How to order supplies and accessories

There are two alternative ways to order supplies or accessories for your product:

- Contact HP Support (see Contact HP Support on page 209).

The rest of this chapter lists the available supplies and accessories, and their part numbers.

Order ink supplies

The following ink supplies can be ordered for your product.

**Table 17-1  Ink cartridges**

<table>
<thead>
<tr>
<th>Cartridge</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 72 69 ml Photo Black Ink Cartridge</td>
<td>C9397A</td>
</tr>
<tr>
<td>HP 72 69 ml Cyan Ink Cartridge</td>
<td>C9398A</td>
</tr>
<tr>
<td>HP 72 69 ml Magenta Ink Cartridge</td>
<td>C9399A</td>
</tr>
<tr>
<td>HP 72 69 ml Yellow Ink Cartridge</td>
<td>C9400A</td>
</tr>
<tr>
<td>HP 72 69 ml Gray Ink Cartridge</td>
<td>C9401A</td>
</tr>
<tr>
<td>HP 72 130 ml Matte Black Ink Cartridge</td>
<td>C9403A</td>
</tr>
<tr>
<td>HP 72 130 ml Photo Black Ink Cartridge</td>
<td>C9370A</td>
</tr>
<tr>
<td>HP 72 130 ml Cyan Ink Cartridge</td>
<td>C9371A</td>
</tr>
<tr>
<td>HP 72 130 ml Magenta Ink Cartridge</td>
<td>C9372A</td>
</tr>
<tr>
<td>HP 72 130 ml Yellow Ink Cartridge</td>
<td>C9373A</td>
</tr>
<tr>
<td>HP 72 130 ml Gray Ink Cartridge</td>
<td>C9374A</td>
</tr>
<tr>
<td>HP 726 300 ml Matte Black Ink Cartridge</td>
<td>CH575A</td>
</tr>
</tbody>
</table>

**Table 17-2  Printheads**

<table>
<thead>
<tr>
<th>Printhead</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP 72 Gray &amp; Photo Black Printhead</td>
<td>C9380A</td>
</tr>
<tr>
<td>HP 72 Magenta &amp; Cyan Printhead</td>
<td>C9383A</td>
</tr>
<tr>
<td>HP 72 Matte Black &amp; Yellow Printhead</td>
<td>C9384A</td>
</tr>
</tbody>
</table>

Order paper

The following paper types are currently provided for use with your printer.

**NOTE:** This list is likely to change over the course of time. For the latest information, see [http://www.hp.com/go/T2300/accessories](http://www.hp.com/go/T2300/accessories).

**NOTE:** Paper types that HP does not support may nevertheless be compatible with your printer.
Key to availability:

- (A) indicates papers available in Asia (excluding Japan)
- (C) indicates papers available in China
- (E) indicates papers available in Europe, the Middle East and Africa
- (J) indicates papers available in Japan
- (L) indicates papers available in Latin America
- (N) indicates papers available in North America

If the part number is not followed by parentheses, the paper is available in all regions.

**Table 17-3 Roll paper**

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Universal Inkjet Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>594 mm (23.39 in) (A1) Q8003A (AJ)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)  Q1396A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)  Q1397A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in) Q1398A</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>91.4 m (300 ft)</td>
<td>594 mm (23.39 in) (A1) Q8004A (EAJ)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0) Q8005A (EAJ)</td>
<td></td>
</tr>
<tr>
<td>HP Bright White Inkjet Bond Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2) Q1446A (J)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in) (A1) Q1445A (EJ)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)  C1860A (EN), C6035A (AEJ)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0) Q1444A (EJ)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)  C1861A (EN), C6036A (AEJ)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>91.4 m (300 ft)</td>
<td>914 mm (36 in)  C6810A</td>
<td></td>
</tr>
<tr>
<td>HP Recycled Bond Paper</td>
<td>80</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2) CG892A (E)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)  CG889A (EN)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)  CG890A (EN)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in) CG891A (EN)</td>
<td></td>
</tr>
<tr>
<td>HP Cockle-free Coated Paper</td>
<td>100</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)  CG883A (EN)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)  CG884A (EN)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in) CG885A (EN)</td>
<td></td>
</tr>
<tr>
<td>HP Cockle-free Heavyweight Coated</td>
<td>170</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)  CG886A (EN)</td>
<td></td>
</tr>
<tr>
<td>Paper</td>
<td></td>
<td></td>
<td>914 mm (36 in)  CG887A (EN)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in) CG888A (EN)</td>
<td></td>
</tr>
<tr>
<td>Paper type</td>
<td>g/m²</td>
<td>Length</td>
<td>Width</td>
<td>Part numbers</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------</td>
<td>--------------</td>
<td>----------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>HP Universal Coated Paper</td>
<td>95</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1404A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1405A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1406A</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>Q1443A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>457 mm (18 in)</td>
<td>Q7897A (EJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1442A (E)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C6019B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0)</td>
<td>Q1441A (E)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6020B</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>C6567B</td>
</tr>
<tr>
<td></td>
<td>91.4 m (300 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1413A</td>
<td></td>
</tr>
<tr>
<td>HP Universal Heavyweight Coated Paper</td>
<td>120</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1412A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1413A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1414A (AEJN)</td>
</tr>
<tr>
<td>HP Heavyweight Coated Paper</td>
<td>131</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>C6029C (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C6030C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>C6569C</td>
</tr>
<tr>
<td></td>
<td>67.5 m (225 ft)</td>
<td>1067 mm (42 in)</td>
<td>Q1956A (EN)</td>
<td></td>
</tr>
<tr>
<td>HP Super Heavyweight Plus Matte Paper</td>
<td>210</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6626A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6627A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6628A (AEJN)</td>
</tr>
<tr>
<td>HP Colored Paper Fluorescent Yellow</td>
<td>100</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1757A (E)</td>
</tr>
<tr>
<td>HP Colored Paper Yellow</td>
<td>92</td>
<td>45.7 m (150 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1760A (EN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>90 m (295.3 ft)</td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q6596A (E)</td>
</tr>
<tr>
<td>HP Technical Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Natural Tracing Paper</td>
<td>90</td>
<td>45.7 m (150 ft)</td>
<td>420 mm (16.54 in) (A2)</td>
<td>Q1440A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>594 mm (23.39 in) (A1)</td>
<td>Q1439A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>C3869A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>841 mm (33.11 in) (A0)</td>
<td>Q1438A (J)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3868A</td>
</tr>
<tr>
<td>HP Translucent Bond</td>
<td>67</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3860A (AJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3859A (LN)</td>
</tr>
<tr>
<td>HP Vellum</td>
<td>75</td>
<td>45.7 m (150 ft)</td>
<td>610 mm (24 in)</td>
<td>C3862A (N)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3861A (LN)</td>
</tr>
<tr>
<td>Paper type</td>
<td>g/m²</td>
<td>Length</td>
<td>Width</td>
<td>Part numbers</td>
</tr>
<tr>
<td>------------</td>
<td>------</td>
<td>-----------------</td>
<td>----------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td><strong>HP Film (Technical and Graphic)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Clear Film</td>
<td>174</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>C3876A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>C3875A</td>
</tr>
<tr>
<td>HP Matte Film</td>
<td>160</td>
<td>38.1 m (125 ft)</td>
<td>610 mm (24 in)</td>
<td>51642A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>51642B</td>
</tr>
<tr>
<td>HP Polyester Film White Matte</td>
<td>167</td>
<td>15.2 m (50 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1736A (AEN)</td>
</tr>
<tr>
<td>HP Vivid White Glossy Polyester Film</td>
<td>230</td>
<td>20.1 m (66 ft)</td>
<td>610 mm (24 in)</td>
<td>CG827A (EJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>CG828A (EJN)</td>
</tr>
<tr>
<td><strong>HP Photographic Paper</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Gloss</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6574A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6575A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6576A</td>
</tr>
<tr>
<td>HP Universal Instant-Dry Photo Semi-Gloss</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q6579A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q6580A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q6581A</td>
</tr>
<tr>
<td><strong>TIP:</strong> The dye inks used by your printer will fade very quickly on instant-dry photo papers. If you plan to display the prints for more than two weeks, you should laminate them to achieve longer life.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Premium Plus Photo Gloss</td>
<td>280</td>
<td>15.2 m (50 ft)</td>
<td>610 mm (24 in)</td>
<td>Q5488A</td>
</tr>
<tr>
<td>HP Premium Plus Photo Satin</td>
<td>280</td>
<td>15.2 m (50 ft)</td>
<td>457 mm (18 in)</td>
<td>Q7920A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>610 mm (24 in)</td>
<td>Q5491A</td>
</tr>
<tr>
<td>HP Universal High-Gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1426A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1427A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1428A (AEJN)</td>
</tr>
<tr>
<td>HP Universal Semi-Gloss Photo Paper</td>
<td>190</td>
<td>30.5 m (100 ft)</td>
<td>610 mm (24 in)</td>
<td>Q1420A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1421A (AEJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1422A (AEJN)</td>
</tr>
<tr>
<td>HP Photo Paper RC Matte</td>
<td>200</td>
<td>30.5 m (100 ft)</td>
<td>914 mm (36 in)</td>
<td>C7946A (AEN)</td>
</tr>
<tr>
<td><strong>HP Backlit Material</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Backlit Film Reverse Print Matte</td>
<td>160</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>C7960A (AEJN)</td>
</tr>
<tr>
<td><strong>HP Self-Adhesive Material and Laminate</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Two-View Cling</td>
<td>240</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1914A (AEN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>1067 mm (42 in)</td>
<td>Q1915A (AEN)</td>
</tr>
<tr>
<td>HP Indoor Paper Self-Adhesive</td>
<td>170</td>
<td>22.9 m (75 ft)</td>
<td>610 mm (24 in)</td>
<td>CG948A (EJN)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>914 mm (36 in)</td>
<td>Q1733A (EJN)</td>
</tr>
</tbody>
</table>
### Table 17-3  Roll paper (continued)

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Matte Adhesive-back Polypropylene</td>
<td>225</td>
<td>21.3 m (70 ft)</td>
<td>914 mm (36 in)</td>
<td>Q1908A (AEN)</td>
</tr>
<tr>
<td>HP Colorfast Adhesive Vinyl</td>
<td>328</td>
<td>12.2 m (40 ft)</td>
<td>914 mm (36 in)</td>
<td>C6775A</td>
</tr>
<tr>
<td>HP Adhesive-backed Polypropylene</td>
<td>128</td>
<td>50 m (164 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8044A (C)</td>
</tr>
<tr>
<td>HP Everyday Adhesive Matte Polypropylene</td>
<td>180</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8884A (C)</td>
</tr>
<tr>
<td>HP Self-adhesive Gloss Polypropylene</td>
<td>180</td>
<td>22.9 m (75 ft)</td>
<td>914 mm (36 in)</td>
<td>Q8834A</td>
</tr>
</tbody>
</table>

### Table 17-4  Sheet paper

<table>
<thead>
<tr>
<th>Paper type</th>
<th>g/m²</th>
<th>Length</th>
<th>Width</th>
<th>Part numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Bond and Coated Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td>90</td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q1961A (AEJN)</td>
</tr>
<tr>
<td>HP Coated Paper</td>
<td></td>
<td>914 mm (36 in)</td>
<td>610 mm (24 in)</td>
<td>Q1962A (AEN)</td>
</tr>
<tr>
<td>HP Photographic Paper</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HP Premium Plus Photo Gloss</td>
<td>280</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>Q5486A</td>
</tr>
<tr>
<td>HP Premium Plus Photo Satin</td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q5487A</td>
</tr>
<tr>
<td>HP Premium Plus Photo Satin</td>
<td>280</td>
<td>483 mm (19 in)</td>
<td>330 mm (13 in)</td>
<td>Q5489A</td>
</tr>
<tr>
<td>HP Premium Plus Photo Satin</td>
<td></td>
<td>610 mm (24 in)</td>
<td>457 mm (18 in)</td>
<td>Q5490A</td>
</tr>
</tbody>
</table>

### Order accessories

The following accessories can be ordered for your product.

<table>
<thead>
<tr>
<th>Name</th>
<th>Product number</th>
</tr>
</thead>
<tbody>
<tr>
<td>HP Designjet PostScript Upgrade</td>
<td>CN500A</td>
</tr>
<tr>
<td>HP Designjet External Hard Disk Accessory</td>
<td>CN501A</td>
</tr>
<tr>
<td>HP Designjet T2300 44-in Spindle</td>
<td>Q6709A</td>
</tr>
<tr>
<td>HP Designjet T2300 Rear Deflector Extension</td>
<td>CN727-40043</td>
</tr>
<tr>
<td>HP Jetdirect 635n IPv6/IPsec Print Server</td>
<td>J7961A</td>
</tr>
</tbody>
</table>
Introduction to the accessories

PostScript upgrade

The PostScript upgrade provides a PostScript interpreter, enabling you to send PostScript and PDF files to the printer and save scanned images as PDF files. The PostScript upgrade should be plugged into the Hi-Speed USB host port at the rear of the product.

External hard disk accessory

This external hard disk enables you to remove the hard disk for security reasons. It should be plugged into the Hi-Speed USB host port at the rear of the product.

**NOTE:** Other external hard disk drives are not supported because they may exceed the USB standard power supply requirements.

Spindle

With extra spindles, you can change rapidly from one paper type to another.

Jetdirect print server

Jetdirect print servers support extra connectivity and security options beyond those provided in the standard Gigabit Ethernet interface built into the product.

HP Web Jetadmin

HP Web Jetadmin is an imaging and printing device management tool that helps optimize HP Designjet utilization, control supplies costs, secure HP Designjets and streamline supplies management by enabling remote batch configuration and management, proactive monitoring, troubleshooting and usage reporting of HP Designjets.
18 Troubleshooting printer paper issues

- The paper cannot be loaded successfully
- The paper type is not in the driver
- The printer printed on the wrong paper type
- An “on hold for paper” message
- Paper jam in the printer
- A strip stays on the output tray and generates jams
- The printer displays out of paper when paper is available
- Prints do not fall neatly into the basket
- The sheet stays in the printer when the print has been completed
- The paper is cut when the print has been completed
- The cutter does not cut well
- The roll is loose on the spindle
- Recalibrate the paper advance
The paper cannot be loaded successfully

- Ensure no paper is loaded.
- Ensure the paper is far enough inside the printer, you should feel the printer grab the paper.
- Do not attempt to straighten the paper during the aligning process, unless instructed to do so by the front-panel display. The printer automatically attempts to straighten the paper.
- The paper may be crumpled, or warped, or may have irregular edges.

General unsuccessful roll load issues

- If the paper does not load, the leading edge of the paper may not be straight or clean and needs to be trimmed. Remove the initial 2 cm (1 in) from the roll and try again. This may be necessary even with a new roll of paper.
- Ensure the roll ends are tight against the spindle ends.
- Check that the spindle is correctly inserted.
- Check that the paper is correctly loaded on the spindle, and that it loads over the roll towards you.
- Check that all roll end plugs have been removed.
- Check that the paper is wound tightly on the roll.
- Do not touch the roll or paper at during the alignment process.
- When loading a roll, the roll cover must remain open until the front panel asks you to close it.
- When loading the upper roll, avoid inserting the paper into the cut sheet slot.

Unsuccessful roll load

If the paper has not been inserted straight, the front panel displays the following instructions.

1. When prompted by the front-panel display, lift the blue lever on the left. The printer attempts to straighten the roll.

2. When prompted by the front-panel display, lower the blue lever. The printer checks the alignment. If the roll is aligned, the printer asks you to close the roll cover, and you are now ready to print.

   If the roll is still not aligned, the front panel displays an error and instructions to start again.
If you would like to start the load process again, cancel the process on the front panel and rewind the roll from the end of the spindle until the edge is removed from the printer.

**NOTE:** If the roll has become loose around the core, the printer cannot load the paper.

### Unsuccessful sheet load

- Guide the sheet, especially thick papers, when the printer initially feeds the sheet.
- Ensure that the sheet is aligned with the reference line on the roll cover.
- Do not attempt to straighten the sheet during the loading process, unless instructed to by the front-panel display.
- Do not use hand-cut sheets, which may be of irregular shapes. Use only purchased sheets.

In case of any problem, please follow the instructions given on the front-panel display.

If you would like to start the load process again, cancel the process on the front panel; the printer ejects the sheet from the front of the printer.

### Paper loading error messages

Here is a list of front-panel messages related to paper loading, with the suggested corrective action.

<table>
<thead>
<tr>
<th>Front-panel message</th>
<th>Suggested action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Close the roll cover when the paper load is finished</td>
<td>Close the roll cover when the paper load is finished.</td>
</tr>
<tr>
<td>Lever lifted</td>
<td>During the load process the blue lever was lifted. This prevents the printer from loading the paper. Follow the instructions on the front-panel display.</td>
</tr>
<tr>
<td>Paper incorrectly loaded</td>
<td>The paper has not been loaded correctly. Lift the blue lever, remove the paper and lower the lever.</td>
</tr>
<tr>
<td>Paper loaded with too much skew</td>
<td>During the paper load process the printer detected that the paper had too much skew. Follow the instructions on the front-panel display.</td>
</tr>
<tr>
<td>Paper loose around core</td>
<td>The end of the roll has become loose around the core. Tighten the paper to the core or insert a new roll.</td>
</tr>
<tr>
<td>Paper not detected</td>
<td>During the paper load process the printer did not detect any paper. Ensure the paper is inserted fully and is not transparent.</td>
</tr>
<tr>
<td>Paper too big</td>
<td>During the load process the printer has detected that the paper is either too wide or too long (sheet only) to be loaded correctly. Press [x] to stop the load process. See <a href="#">Functional specifications on page 212</a>.</td>
</tr>
<tr>
<td>Paper too small</td>
<td>During the load process the printer detected that the paper is too narrow or too short to be loaded in the printer. Press [x] to stop the load process. See <a href="#">Functional specifications on page 212</a>.</td>
</tr>
<tr>
<td>Roll cover closed during paper load process</td>
<td>Do not close the roll cover until you are asked to do so by the front panel.</td>
</tr>
<tr>
<td>Upper roll load and paper is inserted through the single sheet path</td>
<td>Avoid inserting roll paper into the cut sheet slot.</td>
</tr>
</tbody>
</table>
The paper type is not in the driver

To work with a paper not in the driver, you can use your paper as one of the presets already in the driver, however, you must identify whether your paper is transparent or translucent, glossy or matte.

**NOTE:** For glossy paper, it is important to use a glossy paper type, as matte black ink does not print well on glossy paper.

### Transparent or translucent paper

If your paper is a transparent film (for example, a transparency), select paper type **Film > Transparent/Clear film.**

If your paper is a translucent paper (for example, technical paper), select paper type **Technical paper > Natural Tracing Paper, Vellum or Translucent bond.**

### Glossy paper

If your paper is a photo paper, use the **Photo Paper** category. For glossy or high-gloss paper select paper type **Photo Gloss Paper.** For Semi-gloss, Satin, Pearl or Luster finishes, select paper type **Semi-gloss/Satin Paper.**

To increase gamut on photo paper, select paper type **HP Universal High-Gloss Photo Paper** or **HP Universal Semi-Gloss Photo Paper,** depending on the finish.

### Matte Paper

Your paper type selection for matte paper depends on the paper’s ink absorption capacity. To select a paper category and type, first identify if your paper is general purpose or photographic. Then select the recommended paper types.

**General-purpose paper**

- For natural tracing papers, select paper type **Natural Tracing Paper < 65 g/m²** or **Natural Tracing Paper > 65 g/m²,** depending on the weight of the paper.

- For thin papers (< 90 g/m²) uncoated papers (for example plain paper or bright white paper) select paper type **Bond and Coated Paper > Plain Paper.**

- For light coated papers (< 110 g/m²), select paper type **Bond and Coated Paper > HP Coated Paper.**

- For heavyweight coated papers (< 200 g/m²), select paper type **Bond and Coated Paper > Heavyweight Coated Paper.**

- For cockle-free very thick coated papers (> 200 g/m²), select paper type **Bond and Coated Paper > Super Heavyweight Coated Paper.**

**Photographic paper**

For photographic paper, select paper type **Photo Paper > Photo Matte Paper.**
Black ink is easily removed when touched

This happens when your paper is incompatible with matte black ink. To use non-matte black ink, select paper type **Photo Paper > Photo Gloss Paper**.

After printing, the paper has wrinkles or there is too much ink

This happens when too much ink is used. To use less ink, select a thinner category. Matte paper categories from thinnest to thickest are:

- Plain Paper
- Coated Paper
- Heavyweight Coated Paper
- Super Heavyweight Coated Paper

For other image quality problems, see **Troubleshooting print-quality and scan-quality issues on page 197**.

The printer printed on the wrong paper type

If the printer prints your job before you were able to load your desired paper, you may have **Any** selected for the Paper Type in the printer driver. When **Any** is selected the printer will print immediately on whichever paper is loaded. Load your desired paper, see **Printer paper handling on page 48**, and select your paper type specifically in the driver.

- **In the Windows driver dialog**: select the Paper/Quality tab, then select your paper type from the Paper Type list.
- **In the Mac OS Print dialog (T2300)**: select the Paper/Quality panel, then select your paper type from the Paper Type list.
- **In the Mac OS X 10.5 or 10.6 PostScript Print dialog (T2300 PS)**: select the Paper/Quality panel, then select your paper type from the Paper Type list.
- **In the Mac OS X 10.4 PostScript Print dialog (T2300 PS)**: select the Image Quality panel, then select your paper type from the Paper Type list.

**NOTE**: **Any** is the driver default.

An “on hold for paper” message

Based on a set of conditions that you can set when sending a job (see **Paper mismatch action on page 37**), the printer will decide which of the loaded rolls of paper is more suitable to print the job. If there is no roll of paper available that meets all the conditions, the printer will put the job on hold for paper. You can manually resume the job, forcing it to print on a paper other than the one originally specified, otherwise it will stay on hold.
Which criteria are used to decide on which roll a job will be printed?

When a user sends a job, the desired paper type can be set (in the driver or in the Embedded Web Server). The printer will print the job on a roll of paper of the chosen paper type that is large enough to print the drawing without clipping. If there is more than one roll on which the job could be printed meeting all the criteria, the roll will be chosen according to your preferences. These can be set from the front panel: see Roll switching options on page 37.

When is a job put on hold for paper?

If the paper mismatch action is set to Put job on hold (see Paper mismatch action on page 37), a job is put on hold for paper in the following cases:

- The paper type that has been selected by the user is not currently loaded on the specified roll—or on either of the rolls, if no roll has been specified.
- The paper type that has been selected by the user is loaded on the specified roll, but the drawing is too large to fit on the roll—or on either of the rolls, if no roll has been specified.

If I load a new roll of paper, will jobs that were on hold for paper be automatically printed?

Yes. Every time a new roll of paper is loaded, the printer will check if there are any jobs on hold for paper that could be printed on the loaded roll.

I don’t like jobs being put on hold for paper. Can I prevent it?

Yes, this can be done from the front panel: see Paper mismatch action on page 37.

I set the option “Paper mismatch action” to Print anyway, but some jobs are still put on hold

If the Show print preview option is selected in the driver or the Embedded Web Server, jobs are put on hold until you have checked the preview and resumed the job. Check that the Show print preview option is not checked in the driver, and that there are no pending preview windows waiting for confirmation to continue printing.

My job is exactly as wide as the roll of paper that is loaded on the printer, but is put on hold for paper

Margins are managed in different ways depending on the file type:

- For HP-GL/2 and HP RTL files, by default, margins are included inside the drawing, so a 914 mm (36 in) HP-GL/2 and HP RTL file can be printed on a 914 mm (36 in) roll of paper and will not be put on hold for paper.
- For other file formats, such as PostScript, PDF, TIFF or JPEG, the printer assumes that margins need to be added outside the drawing (as, in many cases, these formats are used for photographs and other images that do not include margins). This means that, to print a 914 mm (36 in) TIFF, the printer needs to add margins, and the drawing needs 925 mm (36.4 in) of paper to be printed;
this would cause the job to be put on hold if the paper that is loaded on the printer is only 914 mm (36 in) wide.

If you wish to print these file formats without adding extra margins outside of the drawing, the Clip contents by margins option can be used. This option will force the margins to be set inside of the drawing, so a 914 mm (36 in) TIFF can be printed on a 914 mm (36 in) roll of paper without being put on hold. However, if there is no white space already included in the drawing’s borders, some contents could be clipped because of the margins.

**Paper jam in the printer**

When a paper jam occurs, you normally see the Possible paper jam message in the front-panel display.

1. Power off the product at the front panel and also switch it off at the rear.

2. Lift the scanner.
3. Try to move the printhead carriage out of the way.

4. Lift the blue lever as far up as it will go.

5. Carefully remove any of the jammed paper that you can lift up and out from the top of the printer.

⚠️ **CAUTION:** Do not move the paper sideways, as it could damage the printer.

6. Rewind the roll. If the paper is stuck and cannot be rewound further, cut it from the roll.
7. Remove all pieces of paper from the rear of the printer.

8. Lower the blue lever.

9. Lower the scanner.
10. Switch on the product.

11. Reload the roll, or load a new sheet see Printer paper handling on page 48.

NOTE: If you find that there is still some paper causing an obstruction within the printer, restart the procedure and carefully remove all pieces of paper.

A strip stays on the output tray and generates jams

If a small piece of paper (200 mm or smaller) has been cut, such as before (if new roll) and after a full-bleed print or after the front panel option Form feed and cut has been used, the cut strip remains in the output tray. Only when the printer is not printing, reach into the tray and remove the strip.

The printer displays out of paper when paper is available

If the roll has become loose from its core, it will not feed correctly and the printer will not load the paper. If possible, tighten the paper to its core or load a new roll.

Prints do not fall neatly into the basket

- Ensure the basket is correctly installed.
- Ensure the basket is open.
- Ensure the basket not full.
- Paper often tends to curl near the end of a roll, which can cause output problems. Load a new roll, or remove prints manually as they are completed.

The sheet stays in the printer when the print has been completed

The printer holds the paper to allow the print to dry after printing, see Change the drying time on page 59. If the paper is only partially ejected after the drying time, gently pull the sheet out of the printer. If the automatic cutter is disabled, use the Form feed and cut option in the front panel, see Feed and cut the paper on page 60.

The paper is cut when the print has been completed

By default the printer cuts the paper after the drying time has been completed, see Change the drying time on page 59. You can disable the cutter, see Turn the automatic cutter on and off on page 59.

The cutter does not cut well

By default the printer is set to automatically cut the paper after the drying time has been completed. If the cutter is turned on but not cutting correctly, check that the cutter rail is clean and clear of any obstacles.

The roll is loose on the spindle

The roll may need to be replaced or reloaded.

Recalibrate the paper advance

Accurate paper advance is important to image quality because it is part of controlling the proper placement of dots on the paper. If the paper is not advanced the proper distance between printhead passes, light or dark bands appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all the papers appearing in the front panel. When you select the type of loaded paper, the printer adjusts the rate at which to advance the paper while printing. However, if you are not satisfied with the default calibration of your paper, you may need to recalibrate the rate at which the paper advances. See Troubleshooting print-quality and scan-quality issues on page 197 for steps to determine if paper advance calibration will solve your issue.
You can check the paper advance calibration status of the currently loaded paper at any time by pressing \[ \text{Image Quality Maintenance} \] and then \[ \text{Paper advance calibration} \] on the front panel. The status may be one of the following.

- **DEFAULT**: This status appears when loading any paper that has not been calibrated. HP papers in the Front Panel have been optimized by default and unless you experience image quality problems in your printed image such as banding or graininess it is not recommended to recalibrate the paper advance.

- **OK**: This status indicates that the loaded paper has been calibrated before. However, you may need to repeat the calibration if you experience image quality problems such as banding or graininess in your printed image.

**NOTE**: Whenever you update the product's firmware, the paper advance calibration values are reset to factory default, see Update the firmware on page 162.

**CAUTION**: Transparent papers and films must be calibrated by pressing \[ \text{Image Quality Maintenance} \] and then \[ \text{Paper advance calibration} \] and \[ \text{Adjust paper advance} \], from step four in Recalibrating the paper advance procedure.

### Recalibrating the paper advance procedure

1. From the front panel, press \[ \text{Image Quality Maintenance} \], then \[ \text{Paper advance calibration} \], then \[ Calibrate paper advance \]. The printer automatically recalibrates the paper advance and prints a paper advance calibration image.

2. Wait until the front panel displays the status screen and re-print your print.

**NOTE**: The recalibration procedure takes approximately three minutes. Do not worry about the paper advance calibration image. The front-panel display shows any errors in the process.

If you are satisfied with your print, continue using this calibration for your paper type. If you see improvement in your print, continue with step three. If you are dissatisfied with the recalibration, return to the default calibration, see Return to default calibration on page 184.

3. If you would like to fine-tune the calibration or are using a transparent paper, press \[ \text{Image Quality Maintenance} \], then \[ \text{Paper advance calibration} \] and \[ \text{Adjust paper advance} \].
4. Select the percentage of change from –100% to +100%. To correct light banding, decrease the percentage.  

To correct dark banding, increase the percentage.

5. Press **OK** on the front panel, to save the value.

6. Wait until the front panel displays the status screen and reprint your print.

**Return to default calibration**

Returning to the default calibration sets all the corrections made by the paper advance calibration to zero. To return to the default paper advance calibration value, you must reset the calibration.

1. From the front panel, press \( \text{Image Quality Maintenance} \) > **Paper advance calibration** > **Reset paper advance**.

2. Wait until the front panel displays the operation has completed successfully.
19 Troubleshooting ink cartridge and printhead issues

- Cannot insert an ink cartridge
- Ink cartridge status messages
- Cannot insert a printhead
- The front-panel display recommends reseating or replacing a printhead
- Clean the printheads
- Clean the printhead drop detector
- Align the prinheads
- Printhead status messages
Cannot insert an ink cartridge

1. Check that you have the correct type of cartridge (model number).
2. Check that the colored label on the cartridge is the same color as the label on the slot.
3. Check that the cartridge is correctly oriented, with the letter or letters marking the cartridge label right-side up and readable.

⚠️ CAUTION: Never clean inside the ink cartridge slots.

Ink cartridge status messages

These are the possible ink cartridge status messages:

- **OK**: the cartridge is working normally, with no known problems.
- **Missing**: there is no cartridge present, or it is not correctly connected to the product.
- **Low**: the ink level is low.
- **Very low**: the ink level is very low.
- **Empty**: the cartridge is empty.
- **Reseat**: you are recommended to remove the cartridge and then reinsert it.
- **Replace**: you are recommended to replace the cartridge with a new cartridge.
- **Altered**: there is something unexpected about the cartridge's status.
- **Expired**: it is past the cartridge's expiration date.

Cannot insert a printhead

1. Check that you have the correct type of printhead (model number).
2. Check that you have removed the two orange protective caps from the printhead.
3. Check that the colored label on the printhead is the same color as the label on the slot.
4. Check that the printhead is correctly oriented (compare with the others).
5. Check that you have correctly closed and latched the printhead cover, see Insert a printhead on page 152.

The front-panel display recommends reseating or replacing a printhead

1. From the front panel, turn the power off then on.
2. Check the front-panel display message, if it shows the ready message, the printer is ready to print.
   If the problem remains continue with the next step.
3. Remove the printhead, see Remove a printhead on page 148.
4. Clean the electrical connections on the backside of the printhead with a lint free cloth. You can carefully use a mild rubbing alcohol if moisture is needed to remove residue. Do not use water.

⚠️ **CAUTION:** This is a delicate process and may damage the printhead. Do not touch the nozzles on the bottom side of the printhead, especially not with any alcohol.

5. Reinsert the printhead, see Insert a printhead on page 152.

6. Check the front-panel display message. If the problem remains, try a new printhead.

### Clean the printheads

As long as the product is kept turned on, automatic cleaning is performed periodically. This ensures there is fresh ink in the nozzles and prevents nozzle clogs, which ensures color accuracy.

To clean the printheads, go to the front panel and press "Image Quality Maintenance" > **Clean printheads**. If you have gone through the Image Quality Diagnostic print process (see the Image-quality troubleshooting guide), you know which colors are failing. Select the pair of printheads which contain the failing colors. If you are not sure which colors to clean, you can also select to clean all printheads. Cleaning all printheads takes about nine minutes. Cleaning a single pair of printheads takes about six minutes.

**NOTE:** Cleaning all printheads uses more ink than cleaning a single pair.

### Clean the printhead drop detector

The printhead drop detector is a sensor that detects which nozzles on the printheads are not printing in order to substitute them for good printing nozzles. If particles, such as fibers, hair or paper pieces, block the sensor print-quality is affected.

When the front panel displays a warning message that the clean process is needed, you are recommended to clean the printhead drop detector. If you do not clean the printhead drop detector immediately, the printer continues working normally, however, the front panel display continues to show the warning.

⚠️ **CAUTION:** Wear gloves to avoid getting ink on your hands.
1. Turn off the product with the **Power** key.

2. To avoid an electric shock, switch the product off and unplug it.

3. Lift the scanner.
4. Find the printhead drop detector beside the stored printhead carriage.

5. Remove any debris blocking the printhead drop detector.

6. With a dry lint free cloth, wipe the surface of the drop detector to remove any non-visible debris.

7. Lower the scanner.
8. Plug in and switch on the product.

9. Turn the product on using the Power key.

Align the printheads

Precise alignment between printheads is essential for accurate colors, smooth color transitions and sharp edges in graphical elements. Your printer has an automatic printhead alignment process which runs whenever a printhead has been accessed or replaced.

In cases where the paper has jammed or you are experiencing problems with color accuracy, see Color management on page 104; you may need to align the printheads.

**NOTE:** If the paper has jammed, it is recommended that you reinsert the printheads and initiate the realignment procedure by pressing \[\text{Print} \] , then \[\text{X} \] , then Image Quality Maintenance > Align printheads.

**CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

Reinsert printheads procedure

1. If the realignment process is running and the wrong paper is loaded, press \[\text{Stop} \] on the front panel.

   **CAUTION:** Do not print if the realignment process has been canceled. You can restart the alignment by pressing \[\text{Print} \] , then \[\text{X} \] , then Image Quality Maintenance > Align printheads.

2. Load the paper you wish to use, see Printer paper handling on page 48. You can use a roll that is at least 610 mm (24 in) wide or a cut sheet that is A2 landscape or larger.

   **CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

3. Remove and re-insert all the printheads, see Remove a printhead on page 148 and Insert a printhead on page 152. This starts the printhead alignment procedure.
4. Ensure that the scanner is lowered, as a strong light source near the printer during printhead realignment can affect alignment.

5. The process takes about six minutes. Wait until the front-panel display shows the process complete before using the printer.

**NOTE:** The printer prints a calibration image. Do not worry about the image. The front-panel display shows any errors in the process.

**Image Quality Maintenance menu procedure**

1. Load the paper you wish to use, see *Printer paper handling on page 48*. You can use a roll or cut sheet, however, it must be A3 landscape or larger (420 by 297 mm).

   **CAUTION:** Do not use transparent or semi-transparent paper to align the printheads.

2. From the front panel, press , then , then *Image Quality Maintenance > Align printheads*. The printer checks to see if it has enough paper to run the realignment.

3. If the loaded paper is satisfactory, the printer runs the realignment and prints a realignment pattern. Ensure that the scanner is lowered, as a strong light source near the printer during printhead realignment can affect alignment.

4. The process takes about five minutes. Wait until the front-panel display shows the process complete before using the printer.
Scanning errors during alignment

If the alignment process fails, a Scanning problems message appears on the front panel. This means that the alignment has not completed successfully. Therefore the printer is not aligned and the alignment should be repeated before printing with good image quality. The problem may be due to:

- The paper used was not valid, repeat the alignment with valid paper.
- Printhead health problems, clean printheads, see Clean the printheads on page 187.
- The alignment was done with the scanner raised, repeat the alignment with the scanner lowered.

If the problem persists after using valid paper, cleaning the printheads and keeping the scanner lowered, there may be a failure in the scanning system needing reparation or the printheads, although clean, may not work and need to be replaced.

Printhead status messages

These are the possible printhead status messages:

- **OK**: the printhead is working normally, with no known problems
- **Missing**: there is no printhead present, or it is not correctly installed in the printer.
- **Test printhead separately**: you are recommended to test the prinheads individually to find the failing printhead. Remove all the prinheads and insert them alone one by one, closing the latch and the carriage cover after every insertion. The front-panel display indicates the failing one showing the reseat or replace message.
- **Reseat**: you are recommended to remove the printhead and then reinsert it. If that fails, clean the electrical connections, see The front-panel display recommends reseating or replacing a printhead on page 186. If that fails, replace the printhead with a new printhead, see Remove a printhead on page 148 and Insert a printhead on page 152.
- **Replace**: the printhead is failing. Replace the printhead with a working printhead, see Remove a printhead on page 148 and Insert a printhead on page 152.
- **Replacement incomplete**: a printhead replacement process has not completed successfully, relaunch the replacement process and let it finish completely (it is not needed to change the printheads).
- **Remove**: the printhead is not a suitable type for use in printing.
20 Troubleshooting other printer issues

The printer does not print

If all is in order (paper loaded, all ink components installed and no file errors), there are still reasons why a file you have sent from your computer may not start printing when expected:

- You may have an electrical power problem. If there is no activity at all from the product, and the front panel does not respond, check that the power cable is connected correctly and that there is power available at the socket.

- You may be experiencing unusual electromagnetic phenomena, such as strong electromagnetic fields or severe electrical disturbances, which can cause the product to behave strangely or even stop working. In this case, turn off the product using the Power key on the front panel and unplug the power cord, wait until the electromagnetic environment has returned to normal, then turn it on again. If you still experience problems, please contact your customer service representative.

- Nesting may be on and the printer is waiting for the specified nest wait time before calculating the appropriate nests. In this case, the front panel shows the remaining time needed for nesting.

- You may have the wrong graphic language setting, see Change the printer’s graphic language setting on page 46.

- You may not have installed in your computer the correct driver for your printer, see the Assembly instructions.

- If you are printing on a sheet, you must specify Manual Feed as the paper source in your printer driver.

- The printer may be holding the job for paper or accounting information, see Job status messages on page 102.

- You may have requested a print preview from your printer driver. This is a function you can use to check that the image is the one you want. In this case, the preview is displayed on your screen, and you must click the Print button to start printing.

- If you are using Mac OS with a USB connection, you may find that you need to change the data encoding (T2300 PS only). Press then then Setup > Printing preferences > PS > Select encoding > ASCII. Then configure your application to send ASCII data.
The printer seems slow

Here are some possible explanations.

- Did you set the print-quality to Best or Max Detail? Best-quality and maximum detail prints take longer.

- Did you specify the correct paper type when loading the paper? Some paper types require more time for printing; for example, photo and coated papers require more drying time between passes. To find out the printer’s current paper type setting, see View information about the paper on page 57.

- If your printer is connected by network, check that all components used in the network (network interface cards, routers, switches, cables) are capable of high-speed operation. Is there a lot of traffic from other devices on the network?

- If your printer is connected by USB, make sure that the USB host controller is Hi-Speed USB; and check that the USB cables are Hi-Speed USB certified.

- Did you specify Extended drying time in the front panel? Try changing the drying time to Optimal.

Unavailable driver features when printing from QuarkXpress

When you print from QuarkXPress, the following driver features are not available.

- Print Preview
- Rotation
- Resizing
- Microsoft Office features or paper saving options
- Back to front printing

If you are using the HP-GL/2 and HP RTL driver, the following features are not available.

- Print Preview
- Back to front printing

To get the same results, use the equivalent features available in QuarkXPress.
21 Troubleshooting scanner issues

Cannot access the network folder

If you have set up a network folder (see Create a scan-to-network folder on page 30), but the product cannot access it, try the following suggestions.

- Check that you have filled in each field correctly.
- Check that the product is connected to the network.
- Check that the remote computer is switched on, working normally and connected to the network.
- Check that the folder is shared.
- Check that you can put files into the same folder from a different computer on the network, using the product’s logon credentials.
- Check that the product and the remote computer are in the same network subnet; if they are not, check that the network routers are configured to forward the CIFS protocol traffic (also known as Samba).

Scanning to file is slow

Scanning large formats creates large files. This means that scanning to file can take time even under optimal system configurations and conditions. This is especially true when scanning across a network. However, if you think scanning to file with your system is unreasonably slow, the following steps may help you to locate and solve the problem.

1. Use the front panel to check the status of your scan job. If it is taking an intolerably long time, you can select the job and then cancel it.
2. Check that the Quality setting is right for the job. Not all scanning tasks require high resolutions. If you lower the resolution, you will speed up the scanning process.
3. Check your network configuration. Your network should be a Gigabit Ethernet or one of a higher transfer rate in order to achieve optimal scanning speeds. If your network is a 10/100 Ethernet configuration, you can expect slower transfer of the scan data and thus slower scanning speeds.
4. Contact your network administrator for information about your network configuration, transfer rates, scan-to-file destinations on the network and possible solutions for increasing the speeds.
5. If scanning to files on the network is too slow and the network configuration cannot be amended to correct this, improved speeds can be achieved by scanning to a USB flash drive.
6. If scanning to a USB flash drive seems slow, check your USB flash drive interface compatibility. Your system supports a Hi-Speed USB interface. Your USB flash drive should be compatible with
Hi-Speed USB (sometimes known as USB 2). Also check that your USB flash drive contains enough storage space for scanned large-format images.

**Paper jam in the scanner**

In the event of a paper jam in the scanner, the product will ask you to remove the paper. If removing all of the paper does not solve the problem, the scanner’s motor may be faulty.

1. Open the scanner cover.

![Scanner cover open](image)

When the cover is fully open, underneath you should see red flashing lights, then green, then blue.

2. In the center of the scanner cover, between the flashing lights, are four small sensors. Put your fingers over the R, G and B sensors simultaneously, and the scanner motor should advance.

3. If there is no response from the scanner motor, contact HP Support (see [Contact HP Support on page 209](#)) and explain the situation.
22 Troubleshooting print-quality and scan-quality issues

See the Image-quality troubleshooting guide.
23 Troubleshooting general product issues

- The product will not start
- Communication failures between computer and product
- Cannot access the HP Utility
- Cannot access the Embedded Web Server
- Cannot connect to the Internet
- Web Services issues
- Automatic file system check
- Alerts
The product will not start

If the product will not start (the front panel is blank or the diagnostic LEDs are all off), you are recommended to replace the firmware, in the following way.

1. Go to the Knowledge Center (see Knowledge Center on page 207) and download the firmware.
2. Save the firmware on a USB flash drive. Ideally, the USB flash drive should be empty and formatted with the FAT filesystem.
3. Ensure that the product is turned off. Connect the USB flash drive to the Hi-Speed USB host port beside the front panel, then turn the product on.
4. The product takes about a minute to read the firmware file, then asks you to remove the USB flash drive.
5. The product automatically installs the new firmware and restarts.

Communication failures between computer and product

Some symptoms are:

- The front-panel display does not show the Receiving message when you have sent an image to the printer.
- Your computer displays an error message when you are trying to print.
- Your computer or product hangs (stays idle), while communication is taking place.
- Your printed output shows random or inexplicable errors (misplaced lines, partial graphics etc.)

To solve a communication problem:

- Ensure that you have selected the correct printer in your application, see Print from a computer using a printer driver on page 66.
- Ensure that the printer works correctly when printing from other applications.
- Remember that very large prints may take some time to receive, process and print.
- If the printer is connected to a network, try using it when connected directly to your computer through a USB cable.
- If your printer is connected to your computer through any other intermediate devices, such as switch boxes, buffer boxes, cable adapters, cable converters, etc., try using it when connected directly to your computer.
- Try another interface cable.
- Ensure that the graphic language setting is correct, see Change the printer’s graphic language setting on page 46.
- If the printer is connected by USB cable, try disconnecting and reconnecting the USB cable. Also try using a different USB port on the computer.
Cannot access the HP Utility

If you have not done so already, please read Access the HP Utility on page 43.

From the front panel, press \( \text{Setup} \), then \( \text{Connectivity} \), then \( \text{Setup} > \text{Connectivity} > \text{Advanced} > \text{Web Services} > \text{Printer utility software} > \text{Enabled} \).

If you still cannot connect, switch the product off and back on with the Power key on the front panel.

Cannot access the Embedded Web Server

If you have not done so already, please read Access the Embedded Web Server on page 43.

\( \text{NOTE:} \) If you connect directly to your product with a USB cable, use the HP Utility.

From the front panel, press \( \text{Setup} \), then \( \text{Connectivity} \), then \( \text{Setup} > \text{Connectivity} > \text{Advanced} > \text{Embedded Web Server} > \text{Allow EWS} > \text{On} \).

If you are using a proxy server, try bypassing the server and accessing the Web server directly.

- In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and check the Bypass proxy server for local addresses box. Alternatively, for more precise control, click the Advanced button and add the product’s IP address to the list of exceptions, for which the proxy server is not used.

- In Safari for Mac OS, go to Safari > Preferences > Advanced and click the Proxies: Change Settings button. Add the product’s IP address or its domain name to the list of exceptions, for which the proxy server is not used.

If you still cannot connect, switch the product off and back on with the Power key on the front panel.

Cannot connect to the Internet

If your product has difficulty in connecting to the Internet, it may start the Connectivity Wizard automatically. You can also start the wizard manually at any time.

- From the Embedded Web Server: Select Support > Connectivity troubleshooting > Connectivity wizard.

\( \text{NOTE:} \) You cannot change connectivity settings from the Embedded Web Server.

- From the front panel: Press \( \text{Setup} \), then \( \text{Connectivity} \), then \( \text{Connectivity} > \text{Connectivity wizard} \).

- From the front panel: Press \( \text{Setup} \), then \( \text{Connectivity} \), then \( \text{Internal prints} > \text{Service information prints} > \text{Print connectivity config} \). In this case, the results are printed out.

\( \text{NOTE:} \) The results printed out are from the last run of the Connectivity wizard, so you must already have run the Connectivity wizard in order to get any results.
The Connectivity Wizard performs a series of tests automatically. You can also choose to perform individual tests. From the front panel, press then then Connectivity > Diagnostics & troubleshooting > Diagnostics & troubleshooting. The following options are available:

- **All tests**
- **Network connectivity test**: check the product’s connection to the local area network.
- **Internet connectivity test**: check the product’s connection to the Internet.
- **HP Designjet ePrint & Share test**: check the product’s connection to HP Designjet ePrint & Share.
- **HP ePrint Center test**: check the product’s connection to the HP ePrint Center.
- **Firmware update test**: check the product’s connection to HP’s firmware update servers.

If any test fails, the wizard describes the problem and recommends how to solve it. You can modify settings and rerun the test, unless you are using the Embedded Web Server or the settings are protected.

### Web Services issues

For any issues with HP ePrint, please refer to the HP ePrint Center.

For any issues with HP Designjet ePrint & Share, please refer to the HP Designjet ePrint & Share website.

### Automatic file system check

When you turn on the product, you will occasionally see a front panel display similar to the one shown below.

![File system check display](image)

A file system check is taking place; it can take up to 40 minutes. Please wait until it finishes.

⚠️ **CAUTION:** If you turn the product off before the file system check has finished, the file system could be seriously damaged, making the product’s hard disk unusable. In any case, the file system check will restart from the beginning whenever you turn the product on again.

A file system check is scheduled every 90 days, in order to maintain the hard disk’s file system integrity.
NOTE: When the product is powered back on, it takes about three minutes to initialize and check and prepare the printheads. However, it can take up to 40 under some conditions, for example, when the product has not been used for a long period of time and requires more time to prepare the printheads.

Alerts

Your product can communicate two types of alerts:

- **Errors**: Mainly alerting you to the fact that the product is unable to work normally. However, in the printer driver, errors can also alert you to conditions that could ruin the print, such as clipping, even if the printer is able to print.

- **Warnings**: Alert you when the product needs attention either for an adjustment, such as a calibration or for a possible unprintable situation, such as a preventive maintenance or low ink.

There are four different alerts communicators within your product’s system.

- **Front-panel display**: The front panel shows only the most relevant alert at a time. In the case of a warning, it disappears after a timeout. There are permanent alerts, such as “ink cartridge low on ink”, that reappear when the product becomes idle and there is not another more severe alert.

  **TIP**: From the front panel display you can configure paper mismatch alerts, see [Paper suitability options on page 37](#).

- **Embedded Web Server**: The upper-right corner of the Embedded Web Server window shows the product status. If there is an alert in the product, the status shows the alert text.

- **Driver**: The driver shows alerts. The driver warns about job configuration settings that may produce a problem in the final output. If the printer is not ready to print, it displays a warning.

- **HP Utility**: To see alerts, go to the **Overview** tab and review the **Items needing attention** list on the right-hand side.

  By default, alerts are displayed only when you are printing or scanning. If alerts are enabled and there is a problem that prevents a job from completing, you see a pop-up window, which explains the reason for the problem. Follow the instructions to achieve your required result.

**NOTE**: There are environments that do not support bidirectional communication, for example: a Windows computer connected to the product with USB. In those cases, alerts do not reach the job owner.
Occasionally you may see one of the following messages appear on the front-panel display. If so, please follow the advice in the Recommendation column.

If you see an error message that does not appear here, and you feel in doubt about the correct response, contact HP Support. See Contact HP Support on page 209.

Table 24-1  Text messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Color] cartridge altered</td>
<td>Check the cartridge.</td>
</tr>
<tr>
<td>[Color] cartridge has expired</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 144.</td>
</tr>
<tr>
<td>[Color] cartridge is low on ink</td>
<td>Ensure that you have a new cartridge of the same color ready.</td>
</tr>
<tr>
<td>[Color] cartridge is missing</td>
<td>Insert a cartridge of the correct color. See Handling ink cartridges and printheads on page 144.</td>
</tr>
<tr>
<td>[Color] cartridge is out of ink</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 144.</td>
</tr>
<tr>
<td>[Color] cartridge is very low on ink</td>
<td>Ensure that you have a new cartridge of the same color ready.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: not present</td>
<td>Insert the correct printhead. See Handling ink cartridges and printheads on page 144.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: please remove</td>
<td>Remove the incorrect printhead and insert a new printhead of the correct type (color and number). See Handling ink cartridges and printheads on page 144.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: replace</td>
<td>Remove the non-functional printhead and insert a new printhead of the correct type (color and number). See Handling ink cartridges and printheads on page 144.</td>
</tr>
<tr>
<td>[Color] printhead #[n] error: reseat</td>
<td>Remove and reinsert the same printhead, or try cleaning the electrical connections. If necessary, insert a new printhead. See The front-panel display recommends reseating or replacing a printhead on page 186.</td>
</tr>
<tr>
<td>Cutter replacement advised</td>
<td>Contact HP Support to replace the cutter. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>Job queue notification</td>
<td>Cancel, resume or delete the job. See Job queue management on page 96.</td>
</tr>
<tr>
<td>Maintenance #1 advised</td>
<td>Contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>Maintenance #2 advised</td>
<td>Contact HP Support. See Contact HP Support on page 209.</td>
</tr>
</tbody>
</table>
### Table 24-1  Text messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper loaded incorrectly: remove paper</td>
<td>Remove the paper and try to reload it.</td>
</tr>
<tr>
<td>Paper mispositioned: remove paper</td>
<td>Remove the paper and try to reload it.</td>
</tr>
<tr>
<td>Paper path error: incorrectly loaded</td>
<td>Unload and reload the paper.</td>
</tr>
<tr>
<td>Paper path error: misaligned</td>
<td>Unload and reload the paper.</td>
</tr>
<tr>
<td>Printhead replacement incomplete. Restart it.</td>
<td>Restart the printhead replacement process.</td>
</tr>
<tr>
<td>Printheads need individual testing. Do replacement</td>
<td>Test the printheads using the Image Diagnostics Print (see the Image-quality troubleshooting guide) and replace any that are not working correctly.</td>
</tr>
<tr>
<td>Replace [color] cartridge</td>
<td>Replace the cartridge. See Handling ink cartridges and printheads on page 144.</td>
</tr>
<tr>
<td>Reseat [color] cartridge</td>
<td>Remove and reinset the same cartridge. See Handling ink cartridges and printheads on page 144.</td>
</tr>
</tbody>
</table>

### Table 24-2  Numerical error codes

<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>01.0, 01.1, 01.2</td>
<td>Restart the product. If the problem persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>08:04</td>
<td>Restart the product. If the problem persists, update the product’s firmware. See Update the firmware on page 162. If the problem still persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>08:08</td>
<td>Retry the operation that you were attempting. If it fails again, restart the product. If the problem persists, update the product’s firmware. See Update the firmware on page 162. If the problem still persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>09:01</td>
<td>Paper jam in the scanner. See Paper jam in the scanner on page 196.</td>
</tr>
<tr>
<td>09:02</td>
<td>Calibrate the scanner. See Calibrate the scanner on page 160.</td>
</tr>
<tr>
<td>09:03</td>
<td>Restart the product. If the problem persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>09:04</td>
<td>Restart the product. If the problem persists, update the product’s firmware. See Update the firmware on page 162. If the problem still persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>21, 21.1, 22.0, 22.1, 22.2, 22.3, 22.4</td>
<td>Restart the product. If the problem persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>61:01</td>
<td>The file format is wrong and the printer cannot process the job. Check the graphic language setting of your printer (see Change the printer’s graphic language setting on page 46). If you are sending PostScript from Mac OS over a USB connection, select ASCII encoding in both the driver and the application. Check for the latest firmware and driver releases.</td>
</tr>
<tr>
<td>62, 63, 64, 65, 67</td>
<td>Update your product’s firmware. See Update the firmware on page 162.</td>
</tr>
<tr>
<td>63:01</td>
<td>The product has failed to get an IP address. Connect to another network or change the IPv4 configuration.</td>
</tr>
<tr>
<td>71.04</td>
<td>Out of memory. To avoid this, in the HP-GL/2 and HP RTL driver select the Advanced tab and then Send job as a bitmap.</td>
</tr>
</tbody>
</table>
Table 24-2  Numerical error codes (continued)

<table>
<thead>
<tr>
<th>Error code</th>
<th>Recommendation</th>
</tr>
</thead>
<tbody>
<tr>
<td>74:04</td>
<td>The firmware upgrade has failed. Press OK and try again. See Update the firmware on page 162.</td>
</tr>
<tr>
<td>74.1</td>
<td>Try the firmware update again. Do not try to use your computer while the update is in progress. If the problem persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>74.8:04</td>
<td>The firmware upgrade has failed. Your firmware file may be incorrect; try to download it again. See Update the firmware on page 162.</td>
</tr>
<tr>
<td>79:03</td>
<td>Restart the product. If the problem persists, contact HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>79:04</td>
<td>Update your product’s firmware. See Update the firmware on page 162.</td>
</tr>
<tr>
<td>81:01, 86:01</td>
<td>Please follow the instructions on the front panel. You may be asked to run a test procedure and write down a numeric code before contacting HP Support. See Contact HP Support on page 209.</td>
</tr>
<tr>
<td>94, 94.1</td>
<td>Restart color calibration. See Color calibration on page 105.</td>
</tr>
</tbody>
</table>

The system error log

The product saves a log of system errors that you can access in the following ways.

Using a USB flash drive

1. Create an empty file named pdipu_enable.log in a USB flash drive.
2. Insert the USB flash drive into the Hi-Speed USB host port at the front of the product. The log will be automatically copied into the drive.

Using the Embedded Web Server

1. In your Web browser, go to http://printer IP address/hp/device/webAccess/log.html.
2. The Embedded Web Server will send you a file called log.tar.gz containing the system error log.
25 HP Customer Care

- Introduction
- HP Professional Services
- HP Instant Support
- HP Proactive Support
- Customer Self Repair
- Contact HP Support
Introduction

HP Customer Care offers award-winning support to ensure you get the most from your HP Designjet, providing comprehensive, proven support expertise and new technologies to give you unique end-to-end support. Services include setup and installation, troubleshooting tools, warranty upgrades, repair and exchange services, phone and Web support, software updates and self-maintenance services. To find out more about HP Customer Care, please visit us at:

http://www.hp.com/go/graphic-arts

or call us on the telephone (see Contact HP Support on page 209). To register your warranty:

http://register.hp.com/

HP Professional Services

Knowledge Center

Enjoy a world of dedicated services and resources to ensure you always get the best performance from your HP Designjet products and solutions.

Join the HP community at the Knowledge Center, your large-format printing community, for 24x7 access to:

- Multimedia tutorials
- Step-by-step how-to guides
- Downloads — the latest product firmware, drivers, software, paper presets, etc.
- Technical support — online troubleshooting, customer care contacts and more
- Workflows and detailed advice for completing various printing tasks from particular software applications
- Forums for direct contact with the experts, both HP and your colleagues
- Warranty tracking online, for your peace of mind
- Latest product information — products, supplies, accessories, software, etc.
- Supplies Center for all you need to know about ink and paper

The Knowledge Center can be found at the following locations, depending on your product:

* http://www.hp.com/go/T2300/knowledgecenter
* http://www.hp.com/go/T2300ps/knowledgecenter

By customizing your registration for the products you have purchased and your type of business, and by setting your communication preferences, you decide the information you need.

HP Start-up Kit

The HP Start-up Kit is the DVD that comes with your product; it contains the product’s software and documentation.
HP Care Packs and Warranty Extensions

HP Care Packs and Warranty Extensions allow you to extend your product’s warranty beyond the standard period.

They include remote support. On-site service is also provided if necessary, with two alternative response-time options.

- Next business day
- Same business day, within four hours (may not be available in all countries)

For more information on HP Care Packs, please visit http://www.hp.com/go/printservices.

HP Installation

The HP Installation service unpacks, sets up and connects the product for you.

This is one of the HP Care Pack services; for more information, please visit http://www.hp.com/go/printservices.

HP Instant Support

HP Instant Support Professional Edition is HP’s suite of troubleshooting tools that collect diagnostic information from your product and match it with intelligent solutions from HP’s knowledge bases, allowing you to resolve problems as quickly as possible.

You can start an HP Instant Support session by clicking on the link provided on the Troubleshooting page of your product’s Embedded Web Server. See Access the Embedded Web Server on page 43.

To be able to use HP Instant Support:

- You must have a TCP/IP connection to your product, because HP Instant Support is accessible only through the Embedded Web Server.
- You must have access to the World Wide Web, because HP Instant Support is a Web-based service.

HP Instant Support is currently available in English, Korean, Simplified Chinese and Traditional Chinese.

You can find more information about HP Instant Support at http://www.hp.com/go/ispe.

HP Proactive Support

HP Proactive Support helps reduce costly product downtime by preemptively identifying, diagnosing and resolving product issues before they become problems for you. HP’s Proactive Support tool is designed to help businesses of all sizes reduce support costs and maximize productivity—all with the click of a mouse.

A component of the HP Imaging and Printing suite of services, Proactive Support helps you gain control of your printing environment—with a clear focus on maximizing the value of your investment, increasing product uptime and reducing product management costs.
HP recommends that you enable Proactive Support right away to save you time and prevent problems before they occur, reducing costly downtime. Proactive Support runs diagnostics and checks for software and firmware updates.

You can enable Proactive Support in the HP Utility for Windows or the HP Printer Monitor for Mac OS, where you can specify the frequency of connections between your computer and HP’s Web server, and the frequency of diagnostic checks. You can also choose to run the diagnostic checks at any time. To change these settings:

- In the HP Utility for Windows, select the **Tools** menu, then **HP Proactive Support**.
- In the HP Printer Monitor for Mac OS, select **Preferences > Monitoring > HP Proactive Support**.

If Proactive Support finds any potential problem, it notifies you with an alert, which will explain the problem and recommend a solution. In some cases, the solution may be applied automatically; in other cases, you may be asked to perform some procedure to solve the problem.

### Customer Self Repair

HP’s Customer Self Repair program offers our customers the fastest service under either warranty or contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them. Using this program, you can replace parts at your own convenience.

**Convenient, easy to use**

- An HP Support Specialist will diagnose and assess whether a replacement part is required to address a defective hardware component.
- Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact HP.
- Available for most HP products currently under warranty or contract.
- Available in most countries.


### Contact HP Support

HP Support is available to you by telephone. What to do before you call:

- Review the troubleshooting suggestions in this guide.
- Review the relevant driver documentation.
- If you have installed third-party software drivers and RIPs, see their documentation.
- If you call one of the Hewlett-Packard offices, please have the following information available to help us answer your questions more quickly:
  - The product you are using (the product number and the serial number, found on the label at the back of the product)
  - If there is an error code on the front panel, note it down; see [Front-panel error messages on page 203](#).
• The product’s Service ID: at the front panel, press 0, then 0, then 0.

• The computer you are using

• Any special equipment or software you are using (for example, spoolers, networks, switch-boxes, modems or special software drivers)

• The cable you are using (by part number) and where you purchased it

• The type of interface used on your product (USB or network)

• The software name and version you are currently using

• If possible, print out the following reports; you may be asked to fax them to the support center helping you: Configuration, Usage Report and “all pages above” from Service Information (see Internal prints on page 13)

**Telephone number**

26 Product specifications

- Functional specifications
- Physical specifications
- Memory specifications
- Power specifications
- Ecological specifications
- Environmental specifications
- Acoustic specifications
Functional specifications

Table 26-1  HP 72 ink supplies

| Printheads | Two inks in each printhead: gray and photo black, matte black and yellow, and magenta and cyan |
| Ink cartridges | Cartridges containing 69 ml of ink: gray, photo black, yellow, magenta and cyan |
| | Cartridges containing 130 ml of ink: gray, photo black, matte black, yellow, magenta and cyan |
| | Cartridges containing 300 ml of ink: matte black only |

Table 26-2  Paper sizes

<table>
<thead>
<tr>
<th>Minimum</th>
<th>Maximum</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roll width</td>
<td>279 mm (11 in)</td>
</tr>
<tr>
<td>Roll length</td>
<td>91.4 m (300 feet)</td>
</tr>
<tr>
<td>Sheet width (printer)</td>
<td>210 mm (8.3 in)</td>
</tr>
<tr>
<td>Sheet length (printer)</td>
<td>279 mm (11 in)</td>
</tr>
<tr>
<td>Sheet width (scanner)</td>
<td>914 mm (36 in)</td>
</tr>
<tr>
<td>Sheet length (scanner)</td>
<td>2378 mm (93.62 in)</td>
</tr>
</tbody>
</table>

Table 26-3  Printing resolutions

<table>
<thead>
<tr>
<th>Print quality</th>
<th>Maximu m detail</th>
<th>Driver</th>
<th>Rendering resolution (ppi)</th>
<th>Printing resolution (dpi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best (glossy paper*)</td>
<td>On</td>
<td>HP-GL/2, HP PCL3GUI</td>
<td>1200 × 1200</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>On</td>
<td>PostScript</td>
<td>600 × 600</td>
<td>2400 × 1200</td>
</tr>
<tr>
<td></td>
<td>Off</td>
<td>Any</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Best (other papers)</td>
<td>Off</td>
<td>Any</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Normal</td>
<td>Off</td>
<td>HP-GL/2, HP PCL3GUI</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td></td>
<td>PostScript, HP PCL3GUI</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
<td></td>
</tr>
<tr>
<td>Fast</td>
<td>Off</td>
<td>HP-GL/2</td>
<td>600 × 600</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td></td>
<td>PostScript, HP PCL3GUI</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
<td></td>
</tr>
<tr>
<td>Economode (heavyweight coated and glossy paper*)</td>
<td>Off</td>
<td>Any</td>
<td>300 × 300</td>
<td>1200 × 1200</td>
</tr>
<tr>
<td>Economode (other papers)</td>
<td>Off</td>
<td>Any</td>
<td>300 × 300</td>
<td>600 × 1200</td>
</tr>
</tbody>
</table>

* For a list of supported glossy papers, see Order paper on page 166.

Scanner resolutions: 200, 300, 600 ppi.
Table 26-4  Printing margins

<table>
<thead>
<tr>
<th>Margin Description</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top, right and left margins</td>
<td>5 mm (0.2 in)</td>
</tr>
<tr>
<td>Bottom margin (trailing edge)</td>
<td>5 mm (0.2 in) (roll)</td>
</tr>
<tr>
<td></td>
<td>17 mm (0.67 in) (sheet)</td>
</tr>
</tbody>
</table>

Table 26-5  Mechanical printing accuracy

±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative humidity, on E/A0 printing material in Best or Normal mode with HP Matte Film roll feed.

Table 26-6  Graphic languages supported

<table>
<thead>
<tr>
<th>HP Designjet</th>
<th>Languages</th>
</tr>
</thead>
<tbody>
<tr>
<td>T2300 (printing)</td>
<td>HP PCL3GUI, HP-GL/2, HP RTL, TIFF, JPEG, CALS</td>
</tr>
<tr>
<td>T2300 PS (printing)</td>
<td>HP PCL3GUI, HP-GL/2, HP RTL, TIFF, JPEG, CALS, PDF, PostScript</td>
</tr>
<tr>
<td>T2300 (scanning)</td>
<td>TIFF, JPEG</td>
</tr>
<tr>
<td>T2300 PS (scanning)</td>
<td>TIFF, JPEG, PDF</td>
</tr>
</tbody>
</table>

Scanner file formats: TIFF, JPEG, PDF.

Physical specifications

Table 26-7  Product physical specifications

<table>
<thead>
<tr>
<th>Specification</th>
<th>Measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>86 kg (189 lb)</td>
</tr>
<tr>
<td>Width</td>
<td>1770 mm (69.7 in)</td>
</tr>
<tr>
<td>Depth</td>
<td>Minimum: 692 mm (27.2 in)</td>
</tr>
<tr>
<td></td>
<td>Maximum: 722 mm (28.4 in)</td>
</tr>
<tr>
<td>Height</td>
<td>1046 mm (41.2 in) (1046 mm)</td>
</tr>
</tbody>
</table>

The depth is measured without the upper spindle; ink cover opened; roll covers and basket closed.

Memory specifications

Table 26-8  Memory specifications

<table>
<thead>
<tr>
<th>HP Designjet</th>
<th>Dedicated file-processing memory *</th>
<th>Hard disk</th>
</tr>
</thead>
<tbody>
<tr>
<td>T2300</td>
<td>32 GB</td>
<td>160 GB</td>
</tr>
<tr>
<td>T2300 PS</td>
<td>32 GB</td>
<td>160 GB</td>
</tr>
</tbody>
</table>
Power specifications

**Table 26-9 Product power specifications**

<table>
<thead>
<tr>
<th>Source</th>
<th>100–240 V ac ±10%, auto-ranging</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>50–60 Hz</td>
</tr>
<tr>
<td>Current</td>
<td>&lt; 2 A</td>
</tr>
<tr>
<td>Consumption</td>
<td>&lt; 200 W</td>
</tr>
</tbody>
</table>

Ecological specifications

This product complies with European Union WEEE and RoHS Directives. To determine the ENERGY STAR qualification status of these product models, please go to [http://www.hp.com/go/energystar](http://www.hp.com/go/energystar).

For the up-to-date ecological specifications of your product, please go to [http://www.hp.com/](http://www.hp.com/) and search for “ecological specifications”.

Environmental specifications

**Table 26-10 Product environmental specifications**

<table>
<thead>
<tr>
<th>Temperature range</th>
<th>Humidity range</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating for optimal print quality</td>
<td>15 to 35°C (59 to 95°F)</td>
</tr>
<tr>
<td>Operating for standard printing</td>
<td>5 to 40°C (41 to 104°F)</td>
</tr>
<tr>
<td>Product without consumables</td>
<td>–25 to 55°C (–13 to 131°F)</td>
</tr>
<tr>
<td>Packed product without consumables</td>
<td>–40 to 70°C (–40 to 158°F)</td>
</tr>
</tbody>
</table>

Acoustic specifications

Product acoustic specifications (declared according to ISO 9296).

**Table 26-11 Product acoustic specifications**

<table>
<thead>
<tr>
<th>Idle sound power level</th>
<th>4.4 B (A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating sound power level</td>
<td>6.3 B (A)</td>
</tr>
<tr>
<td>Idle sound pressure at bystander position</td>
<td>32 dB (A)</td>
</tr>
<tr>
<td>Operating sound pressure at bystander position</td>
<td>47 dB (A)</td>
</tr>
</tbody>
</table>
**Glossary**

**AppleTalk**
A suite of protocols that Apple Computer developed in 1984 for computer networking. Apple now recommends TCP/IP and Bonjour networking instead. HP Designjet products no longer support AppleTalk.

**Bonjour**
Apple Computer’s trade name for its implementation of the IETF Zeroconf specification framework, a computer network technology used in Apple’s Mac OS X from version 10.2 onwards. It is used to discover services available on a local area network. It was originally known as Rendezvous.

**CCD**
Charge-Coupled Devices is a high-quality imaging technology based on charge transfer between adjacent pixels or cells.

**CIS**
Contact Image Sensor is an imaging technology based on micro-lenses and LED illumination of each individual pixel.

**Color accuracy**
The ability to print colors that match the original image as closely as possible, bearing in mind that all devices have a limited color gamut and may not be physically capable of matching certain colors precisely.

**Color consistency**
The ability to print the same colors from a particular print job from print to print and from printer to printer.

**Color model**
A system of representing colors by numbers, such as RGB or CMYK.

**Color space**
A color model in which each color is represented by a specific set of numbers. Many different color spaces can use the same color model: for instance, monitors generally use the RGB color model, but they have different color spaces, because a particular set of RGB numbers results in different colors on different monitors.

**Cutter**
A printer component that slides back and forth across the platen to cut the paper.

**ESD**
ElectroStatic Discharge. Static electricity is common in daily life. It is the spark when touching the car door, or the cling of clothing. Although controlled static electricity has some useful applications, uncontrolled electrostatic discharges are one of the main hazards to the electronics products. Therefore, to prevent damage some precautions are needed when setting up the product, or handling ESD sensitive devices. This type of damage may reduce the life expectancy of the device. One way to minimize uncontrolled ESDs, and therefore reduce this type of damage is by touching any exposed grounded part of the product (mainly metal parts) before handling ESD sensitive devices (such as the printheads or ink cartridges). Additionally, to reduce the generation of electrostatic charge in your body try to avoid working in a carpeted area, and keep your body movements to a minimum when handling ESD sensitive devices. Also, avoid working in low humidity environments.

**Ethernet**
A popular computer networking technology for local area networks.
**Firmware**
Software that controls your product’s functionality and is stored semi-permanently in the product (it can be updated).

**Gamut**
The range of colors and density values reproducible on an output device, such as a printer or monitor.

**Gigabit Ethernet**
An Ethernet network capable of transferring data at up to 1,000,000,000 bits/second. Gigabit Ethernet interfaces are capable of negotiating slower speeds when required for compatibility with older Ethernet devices.

**Hi-Speed USB**
A version of USB, sometimes called USB 2.0, that can run 40 times faster than original USB, but is otherwise compatible with original USB. Most personal computers today use Hi-Speed USB.

**HP RTL**
Hewlett-Packard Raster Transfer Language: a language defined by HP to describe raster (bitmap) graphics.

**HP-GL/2**
Hewlett-Packard Graphics Language 2: a language defined by HP to describe vector graphics.

**I/O**
Input/Output: this term describes the passing of data between one device and another.

**ICC**
The International Color Consortium, a group of companies that have agreed on a common standard for color profiles.

**Ink cartridge**
A removable printer component that stores ink of a particular color and provides it to the printhead.

**IP address**
May mean an IPv4 address (most likely) or an IPv6 address.

**IPSec**
A sophisticated mechanism for providing network security by authenticating and encrypting IP packets sent between nodes on a network. Each network node (computer or device) has an IPSec configuration. Applications are usually unaware whether IPSec is being used or not.

**IPv4 address**
A unique identifier that identifies a particular node on an IPv4 network. An IPv4 address consists of four integers separated by full stops. Most networks in the world use IPv4 addresses.

**IPv6 address**
A unique identifier that identifies a particular node on an IPv6 network. An IPv6 address consists of up to 8 groups of hexadecimal digits separated by colons. Each group contains up to 4 hexadecimal digits. Only a few new networks in the world use IPv6 addresses.

**Jetdirect**
HP’s brand name for its series of print servers that allow a printer to be connected directly to a local area network.

**LED**
Light-Emitting Diode: a semiconductor device that emits light when electrically stimulated.

**MAC address**
Media Access Control address: a unique identifier used to identify a particular device on a network. It is a lower-level identifier than the IP address. Thus, a device may have both a MAC address and an IP address.

**Network**
A network is a set of connections that pass data between computers and devices. Every device is able to communicate with every other device in the same network. This allows data to be moved between computers and devices, and allows devices such as printers to be shared between many computers.
Nozzle
One of many tiny holes in a printhead through which ink is deposited onto the paper.

Paper
A thin, flat material made to be written or printed on; most commonly made from fibers of some kind which are pulped, dried and pressed.

Platen
The flat surface within the printer over which the paper passes while it is being printed on.

Printer driver
Software that converts a print job in a generalized format into data suitable for a particular printer.

Printhead
A removable printer component that takes ink of one or more colors from the corresponding ink cartridge(s) and deposits it on the paper, through a cluster of nozzles. In the HP Designjet T2300 series, each printhead prints two different colors.

Rendezvous
Apple Computer’s original name for its networking software later known as Bonjour.

Spindle
A rod that supports a roll of paper while it is being used for printing.

TCP/IP
Transmission Control Protocol/Internet Protocol: the communications protocols on which the Internet is based.

USB
Universal Serial Bus: a standard serial bus designed to connect devices to computers. Your product supports Hi-Speed USB (sometimes called USB 2.0).

USB device port
A square USB socket found on USB devices, through which a computer can control the device. For a computer to print to your product using a USB connection, the computer must be connected to the product’s USB device port.

USB host port
A rectangular USB socket such as those on found on computers. A product can control USB devices that are connected to such a port. Your product has two USB host ports, which it uses to control accessories and USB flash drives.
Index

A
access control 39
accessories
  order 170
account ID
  requiring 40
accounting 141
accounting data by email 142
acoustic specifications 214
alerts
  errors 202
  turn on and off 39
  warnings 202

B
banding problems 182
basket
  output problems 181
black and white 73
black point compensation 114
brightness in front panel 44
buzzer on/off 44

color
  adjustment options 108
  advantages 105
  calibration 105
  CMYK 105
  emulation 111
  printer emulation 108
  profile 105
  RGB 105
color management
  from drivers 107
  from EWS 113
  from front panel 115
  from PS drivers 110

D
disk erase, secure 164
draft for revision, print 118
draft printing 72
driver features
  QuarkXpress 194
driver preferences 41
drying time
  change 59
e
ecological specifications 214
economize
  on ink 77
  on paper 75
email printing 85
Embedded Web Server
  access 43
  cannot access 200
  job preview 101
  job queue 100
language 44
  usage per job 142
  usage statistics 141
ePrinter security 47
erase hard disk securely 164
error messages, front panel 202
external hard disk 171

F
features of product 5
file system check 201
firmware update 162
  manual setup 29
  setup 28
front panel
  brightness 44
  job preview 97
  job queues 97
  language 43
  units 45
front panel option
  adjust paper advance 183
  align printheads 191
  allow EWS 200
  black point compensation 116
  calibrate color 106
  calibrate paper advance 183
  clean printheads 187
  CMYK source profile 116
  color/grayscale 115
  connectivity wizard 28
  emulate printer 115
  enable buzzer 44
  enable crop lines 75
  enable cutter 59
  enable economode 72
  enable maximum detail 73
  enable merge 71
  form feed and cut 60
  Internet connectivity 29
  modify configuration 46
  move paper 58
PANTONE emulation 116
paper mismatch action 37
print quality 67
Printer utility software 200
printhead information 148
rendering intent 116
replace ink cartridges 145
replace printheads 149
reset paper advance 184
resize 70
RGB source profile 115
roll protection 77
roll switching options 37
select display brightness 44
select drying time 59
select graphics language 46
select language 43
select paper size 68
select paper type 175, 176
select units 45
select wait time 77
sleep mode wait time 44
unload paper 55
front view 6
functional specifications 212

G
graphic language for printing 46
graphic languages 213
gray shades 73

H
hard disk specification 213
hard disk, external 171
HP Care Packs 208
HP Customer Care 207
HP Designjet ePrint & Share
introduction 11
print 85
scan 91
security 94
set preferences 30
HP ePrint Center
disable 40
HP Installation 208
HP Instant Support 208
HP Proactive Support 208
HP Start-up Kit 207
HP Start-up Kit DVD 2
HP Support 209
HP Utility
access 43
cannot access 200
language 44
HP Web Jetadmin 171

I
ink
economical use of 77
usage 142
ink cartridge
about 145
cannot insert 186
insert 147
maintenance 156
order 166
remove 145
specification 212
status 145
status messages 186
Instant Support 208
internal prints 13
Internet connection
manual setup 29
setup 28
troubleshooting 200
IP address 44
iPad 86
iPhone 86
iPod Touch 86
IPSec 17
IPv6 17

J
Jetadmin 171
Jetdirect print server 171
job preview
Embedded Web Server 101
front panel 97
job queue
Embedded Web Server 100
front panel 97

K
Knowledge Center 207

L
language 43
load paper
cannot load 173
general advice 49
paper not in driver 175
roll cannot load 173
roll into printer 51
roll onto spindle 50
sheet 55
sheet cannot load 174
loading paper problems 173

M
main components 6
main features 5
maintenance kits 164
margins 69
none 74
specification 213
mechanical accuracy 213
memory specifications 213
Microsoft Office
print from 133
models, product 2
move the product 161
multiroll printer 61

N
nesting 75
turn on and off 38
network folder
cannot access 195
create 30
use 81
network settings 45

O
on hold for paper
enable/disable 177
message 176
order
accessories 170
ink cartridges 166
paper 166
printheads 166
overlapping lines 71
overnight printing 78

P
page size 68
PANTONE emulation 110
PANTONE swatch book 114
paper
advance 60
check the paper advance 182
cannot load 173
cut after printing 182
displaying information 58
download presets 57
economical use of 75
feed and cut 60
incorrect out of paper 181
jam due to cut strip 181
jam in printer 178
jam in scanner 196

ENWW Index 219

Index 219
loading error messages 174
maintenance 58
movement 58
not cut well 182
output problems in basket 181
paper not in driver 175
presets 57
print on loaded paper 69, 176
printed on wrong paper 176
retained by printer 182
roll loose on spindle 182
select type 69
size 68
sizes (max and min) 212
usage 142
view information 57
paper mismatch action 37
paper not in driver 175
paper suitability 37
paper types 166
physical specifications 213
ports 8
PostScript upgrade] 171
power
  on/off 12
  power specifications 214
  preferences, Windows driver 41
  presentation, print 127
  preview a print 71
  print by email 85
  print from
    Embedded Web Server 65
    HP Utility 65
    printer driver 66
    USB flash drive 64
  print from ePrint & Share 85
  print job
    nesting 75
  print preview 71
  print quality
    select 67
  printer does not print 193
  printer software 10
  Mac OS uninstall 25
  Windows uninstall 20
  printhead
    about 148
    align 190
    cannot insert 186
    clean; purge 187
    insert 152
    order 166
    remove 148
    replace, reseat 186
    specification 212
    status 148
    status messages 192
  printhead cleaner
    specification 212
  printhead drop detector
    clean 187
  printing 63
  printing resolutions 212
  Proactive Support 208
  product models 2
  product status 156
  product will not start 199
  project, print 120
  protect a roll 77
  Q
  quality, high 72
  QuarkXpress, unavailable driver features 194
  R
  rear view 7
  remote printing
    set preferences 30
    rendering intent 114
  rescale a print 70
  roll paper
    load 51
    spindle load 50
    unload 54
  roll protection 77
  roll switching options 37
  S
  safety precautions 2
  scale a print 70
  scan to email 91
  scanner
    calibration 160
    can't access network folder 195
  clean glass plate 156
  paper jam 196
  replace glass plate 158
  scan to file 81
  slow scan 195
  supported paper types 80
  usage 142
  secure disk erase 164
  security 39
  ePrint & Share 94
  sheet paper
    load 55
    unload 56
  sleep mode wait time 44
  slow printing 194
  smartphone 86
  software 10
  software update 163
  specifications
    acoustic 214
    ecological 214
    environmental 214
    functional 212
    graphic languages 213
    hard disk 213
    ink supplies 212
    margins 213
    mechanical accuracy 213
    memory 213
    paper size 212
    physical 213
    power 214
    printing resolutions 212
    spindle 171
    roll load 50
  statistics
    ink cartridge 145
    usage 141
    usage per job 142
  store the product 161
  support services
    HP Care Packs 208
    HP Customer Care 207
    HP Instant Support 208
    HP Proactive Support 208
    HP Start-up Kit 207
    HP Support 209
    Knowledge Center 207
    product installation 208
    warranty extensions 208
  T
  tablet computer 86
  telephone number 210
  two rolls 61
  U
  unattended printing 78
  unload paper
    roll 54
    sheet 56
  using this guide 3
W
warranty extensions  208
Web connection
  setup  28
Web Jetadmin  171
Web Services
  introduction  11
web services troubleshooting  201